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PREFACE

The Against The Clock series has been developed for those involved in the field of
graphic arts.
Welcome to the world of electronic design and prepress. Many of our readers are
already involved in the industry - in advertising and design companies, in
prepress and imaging firms, and in the world of commercial printing and reproduction. Others are just now preparing themselves for a career somewhere in the
profession.
This series of courses will provide you with the skills necessary to work in this fastpaced, exciting, and rapidly expanding business. Many people feel that they can
simply purchase a computer, the appropriate software, a laser printer, and a ream
of paper, and begin designing and producing high-quality printed materials. While
this might suffice for a barbecue announcement or a flyer advertising a local hair
salon, the real world of four-color printing and professional communications
requires a far more serious commitment.

The applications presented in the Against The Clock series stand out as the programs of choice in professional graphic arts environments.
We've used a modular design for the Against The Clock series, allowing you to mix
and match the drawing, imaging, and page layout applications that exactly suit
your specific needs.
Titles available in the Against The Clock series include:

Macintosh: Basic Operations
Windows: Basic Operations
Adobe Illustrator: An Introduction to Digital Illustration
Adobe Illustrator: Advanced Digitallllustration
Freehand: An Introduction to Digital Illustration
Freehand: Advanced Digital Illustration
Adobe PageMaker: An Introduction to Electronic Mechanicals
Adobe PageMaker: Advanced Electronic Mechanicals
Quark.XPress: An Introduction to Electronic Mechanicals
Quark.XPress: Advanced Electronic Mechanicals
Adobe Photoshop: An Introduction to Digital Images
Adobe Photoshop: Advanced Digital Images
File Preparation: The Responsible Electronic Page
Preflight: An Introduction to File Analysis and Repair
Trap Wise: Trapping
Press Wise: Imposition

VI

How TO UsE THIS WoRKBOOK

We've designed our courses to be "cross-platform." While many sites use
Macintosh computers, there is an increasing number of graphic arts service providers using Intel-based systems running Windows (or Windows NT). The books
in this series are applicable to either of these systems. This course applies only to
the Macintosh. For a similiar course on Windows, see Windows: Basic Operations,
from this same series.
All of the applications that we cover in the Against The Clock series are similar in
operation and appearance whether you're working on a Macintosh or a Windows
system.

ICOH~ ~HD VI~U~U

Pencil icon indicates a comment from an experienced operator.
Whenever you see the pencil icon, you'll find corresponding
sidebar text that augments or builds upon the subject being discussed at the time.

Bomb icon indicates a potential problem or difficulty. For instance, a certain technique might lead to pages that prove difficult to output. In other cases, there might be something that a
program cannot easily accomplish, so we might present a
workaround.

Pointing Finger indicates a hands-on activity- whether a short
exercise or a complete project. This will be the icon you'll see the
most throughout the course.

Key icon is used to point out that there is a keyboard equivalent
to a menu or dialog-box option. Key commands are often faster
than using the mouse to select a menu option. Experienced operators often mix the use of keyboard equivalents and menu/dialog box selections to arrive at their optimum speed.
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SuPP()RT MATERIALS

On the CD-ROM, you will find a complete set of Against The Clock (ATC) fonts,
as well as a collection of data files used to construct the various exercises.
The ATC fonts are solely for use while you are working with the Against The Clock
materials. These fonts will be used throughout both the exercises and projects and
are provided in both Macintosh and Windows format. For the purposes of this
course, Macintosh: Basic Operations, there are no fonts necessary to complete the
exercises.

The Instructor Kit consists of an Instructor's manual and an Instructor's CDROM. It includes various testing and presentation materials in addition to the files
that come standard with the student books.
Overhead Presentation Materials are provided and follow along with the
course. These presentations are prepared using Microsoft PowerPoint and
are provided in both "native'' PowerPoint format as well as Acrobat Portable Document Format (PDF).
•

A Test Bank of Questions is included within the instructor kit. These
questions may be modified, reorganized, and administered throughout the
delivery of the course.
A Final Review at the end.
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AB()lJT AGAINST THE CL()(:J( ANI) TI-lE AtJTHORS
I

Against The Clock (ATC) was founded in 1990 as a part of Lanman Systems
Group, one of the nation's leading systems integration and training firms. The
company specialized in developing custom training materials for such clients as
L.L. Bean, The New England journal of Medicine, Smithsonian, the National Education Association, Air & Space Magazine, Publishers Clearing House, The National
Wildlife Society, Home Shopping Network, and many others. The integration firm
was among the most highly respected in the graphic arts industry.
To a great degree, the success of Systems Group can be attributed to the thousands
of pages of course materials developed at the company's demanding client sites.
Throughout the rapid growth of Systems Group, founder and General Manager
Ellenn Behoriam developed the expertise necessary to manage technical experts,
content providers, writers, editors, illustrators, designers, layout artists, proofreaders, and the rest of the chain of professionals required to develop structured and
highly effective training materials.
Following the sale of the Lanman Companies to World Color, one of the nation's
largest commercial printers, Ellenn embarked on a three-year project to fully
redevelop a library of training materials engineered specifically for the professional graphic artist. The result of this effort is the ATC training library.
Ellenn lives in Tampa, Florida with her husband and her dogs, Boda and Chase.

Every one of the Against The Clock course books was developed by a group of
people working as part of a design and production team. In all cases, however,
there was a primary author who assumed the bulk of the responsibility for developing the exercises, writing the copy, and organizing the illustrations and other
visuals.
In the case of Macintosh: Basic Operations, that author was Gary Poyssick. Gary
works on many of the ATC projects in a wide range of roles.
Gary is the President of GASP Engineering, Inc. GASP, which stands for Graphic
Arts Service Provider, is a consulting firm that specializes in workflow
reengineering, the development of customer focused teams, and business acquisition for printing and prepress concerns. In addition to the consulting services that
the company provides, GASP Engineering authors the popular monthly newsletter
The GASP Report. Gary is the author of Workflow Reengineering, Adobe Press, and
co-author of Creative Techniques: Adobe Illustrator, and Creative Techniques: Adobe
Photoshop, both available from Hayden Books.
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GETTING STARTED

.U~V <OffiiMNDi
The Macintosh has a key marked with an Apple and an icon that looks like a dover
leaf. This is called the Command key. Whenever you see this icon, you will need to
hold this key down. The Command key is a modifier key; that is, it doesn't do
anything by itself, but changes the function of a key pressed while it's being held
down. A good example is holding Command while pressing the "S'' key: this Saves
your work. The same thing applies to the "P" key; hold down Command and press
it to Print your work.
Another special function key on the Macintosh is the Option key. It's also a modifier key, and you'll need to hold it down along with whatever other key is required
for a specific function.

T.JK <D~Offi .liND INJML mlJP <ONiiW~ONi
Before you begin using your Against The Clock course book, you will have to set
up your system so that you have access to the various files and tools you'll need to
complete your lessons.

This course comes complete with a collection of student files. These files are an
integral part of the learning experience, as they're used throughout the course to
help you work through the various exercises. Having these building blocks available to you throughout your practice and study sessions will ensure that you will
be able to experience the exercises with a minimum of time spent looking for the
various components required.
Navigate through the CD-ROM to locate the folder called "SF-Basic Mac Operations" and simply drag the icon onto your hard disk drive.
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What is a Macintosh?
So what exactly is a Macintosh computer? In the most fundamental ways, it's
almost exactly like any other computer in that it boasts several components
that are common to all platforms, or machine types.
There are many people for
whom the Macintosh is
their first computer; for

Monit or

ot hers, they're already
familiar with another
system -

perhaps

Windows.

Once upon a time, there
was a major difference
between the Mac and other
systems- especially
relative to how easy it was

to use. Today, most
computers have emulated
the Macintosh user

The components are:

interface and ease-of-use.
Still, the Mac is many

The Machine: the actual computer itself, which consists of boards,

people's favorite computer.

chips, memory, circuits, and other electronic components.

In particular, its popularity
in t he graphics industry

Storage: hard drives, diskettes, removable platters, optical disks, and

remains unchallenged.

other places where your data is stored, and where it remains when your
computer is turned off.

Input devices: items used to get information into the computer. These
can include such basic items as the keyboard and mouse, and range all
the way to complicated hardware such as expensive, high-end scanners
and digital cameras.

CHAPTER 1: WH AT IS A MACINTOSH?
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Output devices: components used to "show you the data." This can
range from a monitor (capable of displaying the contents of files,
folders, and the desktop environment where you actually work) all the
way to extremely high-resolution devices that can actually print image
plates for high-speed commercial printing.

Communication components: things that allow one computer to talk to
or communicate with another computer. Networks, where people in
workgroups share files, is one example of communications; the World
Wide Web and email are others.
If you're working with this course, it's very likely that you have at least some of
these components in front of you (or at least accessible). Let's look at these
components in a little more depth.

The Machine
One of t he biggest reasons

The first component to consider is the computer itself. There are two types of

for the Mac's success is

basic systems: desktop (also called tower if designed to stand on end) and

the fact that it's a "plug-

laptops, or portable machines. Laptops normally are small enough to fit in a

and-play" machine. If you

decent-sized briefcase, and offer a self-contained keyboard, pointing device,

want to add a printer, or a

and monitor. A well-configured laptop might even have a CD-ROM drive

monitor, or a keyboard, or

(more on those a little later), a floppy disk (ditto), and a modem for communi-

any device to the system,

cating with remote computers or networks.

you simply match up t he

THE CPU

small pictures on the
cables, plug them in, and

If you opened up your computer, you would find a great deal of complex

away you go.

electronics stored inside. Among the many chips and circuit boards you might
see is one large chip- essentially the "brains" of the entire thing. It's called the
CPU, which is short for Central Processing Unit. This CPU contains the basic
instructions that the system needs to perform tasks like using software tools,
storing data, and communicating with devices like monitors, printers, and
other system components.
Increasingly, manufacturers like Apple Computer are building computers that
have more than one processor. Rather than attempting to build bigger and
bigger devices (to meet increasing demands from more-and-more complicated
programs), they have decided that it's easier to use multiple processors. That
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way, the demands on the CPU can be divided up (by specialized operating
system software) and shared among the processors.
This doesn't mean that companies like Apple, IBM, Compaq, Intel, AMD, and
many others aren't working to make the basic processors themselves more
powerful- it's more a strategy that lets users like you select a system that's just
right for their unique needs. If you work on digital images, for example, which
are very computer-intensive, you might choose to buy a computer with two or
more processors. If you're going to be a copywriter, primarily utilizing word
processing programs (which inherently place less of a demand on the computer), a single-processor system might suffice quite well.
MEMORY

The amount of memory that's built into a given computer determines two
things:
How many things the computer can do at once (how many programs
can be loaded and ready-to-go when you need them), and

-

How fast certain functions execute.

Mo5t computers today are
equipped with at lea5t 8
megabyte5 of RAM, and

Memory can be thought of as a honeycomb. Each cell on the grid represents
one byte. A byte is enough to store one character.

often contain much more.

•.

In f act, you can't buy a new
computer with only 8
megabyte5 of RAM the5e
day5. The general rule of
thumb i5 to buy a5 much
memory a5 you can afford
in your budget. The more
RAM memory your computer ha5, the better it will
perform.

If you put together about 1,000 of these cells (actually 1024, but let's not get
too crazy here), it's called a kilobyte. A million of them is called a megabyte,
and a billion are referred to as a gigabyte.

You may have heard these terms before, especially when looking at promotional material for computers or hard drives. Memory contained in the computer is called RAM, or Random Access Memory.
C HAPTER 1: WHAT IS A MACINTOSH?
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RAM memory is only active and available when the computer is actually
turned on and operating. Things that were stored only in RAM (which is the
case while you're working on a new document, not yet saved ) are lost when the
system is powered down. When you want to store something permanently, you
save the contents of RAM to the system's hard drive (or some other storage
media). This transfer takes place whenever you issue a save command from
Many people remain
confused about the
difference between RAM

within an applicatio n, o r software tool. We'U be working with these concepts in
depth a little later on in the course. Here's a graphic that shows the difference:

and hard disk space. In one
way, they're very similar and that's that you should
budget for the biggest hard
drive you can afford. The

Random Access Memory - t he computer's internal memory
available for files and application progra ms in current use.
Contents of RAM are volatile and are erased when t he power is
turned off. The amount of RAM determines, in part, how fast
and how many applications you can run at the same time. RAM
capacity is rated in megabytes (MB). A megabyte is one million
cha racters such as letters or numbers.

price per megabyte is
pretty low these days, and
you can purchase gigabyte
(and greater) drives for a

few hundred dollars. No
Most computers include at least one Hard Disk mechanical
storage device. Files are "written" to t hese devices to store
them for future usc. Capacities, also rated in megabytes,
range from 10 to t housands. The larger t he capacit y, the more
applications and data files can be stored for ea sy retrieval.
Th ere a re many t ypes of drives; some are "fixed" inside the
system, some a re connected with cable. Others are in the form
of removable devices: platters, opticals, and even COs . COs a re
usually created by a special device and can never 11e changed.

matter how much drive
space you have, you'll

always need more. That's
why proper drive organization is important.

Storage

If you're new to computers, you have probably encountered someone who told
you horror stories about losing your data to a "crash." This usually happens, it
is said, whenever you're working on tl1e most critical project of your life, it's
due in the morning, and you have to work aU night long. Fret not.
Today's computers are quite able to keep your important (a nd not-so-important) information safe and secure ilirough all but ilie most traumatic events.
Computers offer several different types of storage systems where you can save
your information quickly and easily. Later in this chapter we'll discuss backup
and archiving metl1ods, which ensure that even if you do experience a system
P AGE
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failure, you will be able to restore your system to the way it was the last time
you created a backup.
THE HARD DRIVE

The most fundamental type of storage you'll encounter as a Macintosh operaYou probably have 5everal

tor is the internal hard disk. These mechanical devices (pictured below) provide
the basic storage space available to you.

different type5 of 5torage
on your computer. At a

Most computers today are configured with an internal hard disk- built into

minimum, you have a hard

the actual system or portable unit. The way they work is quite simple. A read-

drive and a floppY di5k.

write head modifies a magnetic field that's stored on the surface of the media

Perhap5 you al5o have a

itself (sometimes called the platter). The platter is formatted with concentric

CD-ROM built into your
5y5tem, and you might even

rings, called tracks, and pie-like slices called sectors. This segmenting strategy
allows the entire surface of the device to contain unique addresses, which

have other media, like the

programs and the Macintosh Operating System (we'll explain these terms later)

popular Zip or Jaz drive5

use when they store and retrieve your data, or when they launch (another word

from the Iomega Corpora-

for start up) a program.

tion. The5e removable di5k5
are increa5ingly popular in
the graphic art5 indu5try,
where moving large image
and page layout file5 i5 a
common procedure.

Hard disks do occasionally require maintenance, and have even been known to
fail now and then- even with today's very secure and stable systems. Another
disk-related problem that you might see happen from time to time is when a
file becomes corrupted, or impossible to read. There are specialized programs
that can be used to fix certain categories of problems. These applications are
called utility programs.
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External Storage
Certain computers not only have internal hard disks, but are also equipped
with external storage devices. These can take several forms:
FIXED
These are high-capacity

A fixed external hard drive is one that's contained in its own case, and usually

disks used to

has its own power supply. When you're considering the expansion of your

COpY

files for t ransfer

large

to a

service provider for output,

or to archive t hem for

system, you can choose to put another hard drive inside your computer
{internal), or choose to put the device outside your system (external). Depending on the configuration, some computers either don't have the space inside

future reference. The

within which to mount an additional drive, or aren't able to supply sufficient

st a ndard in the industry

power to the device.

has been the series
manufactured by Syquest,

Sometimes, adding an external fixed drive is just easier to do, since the opera-

but recently the Zip and

tor only needs to plug in the cables, supply power, and run a program that

Jaz d rives have become

comes with the external hard drive in order to use it immediately. Installing an

very popular. The basic Zip

internal hard drive normally requires you to take your computer into a service

holds 100 MB, and the Jaz

center where a trained technician will do the installation without voiding your

holds 1 or 2 GB, but there

warranty or destroying some vital component.

are continuous improvements and upgrades in
these product s.

REMOVABLE MEDIA

Removable media is just that: disks and storage systems that can be taken out
of your computer. There are many types of such media, including:

Floppy Disks

Floppies are normally 3.5 inches square, and fit into a slot
either within your computer or in an externally-connected
drive. They only offer about 1.5 megabytes of storage space,
and are often reserved for making copies of small files to
move to another machine, or as a limited backup media.

Removables

Removable platters were quite popular for a while as a
manner of both extending the amount of space available to
the user, as well as moving larger graphic files from one
system to another. An example is the designer or advertising
agency who sends their files for output at a service bureau.
While they're still in use at many sites, larger, faster, and
more reliable methods are beginning to reduce their importance as removable media.

P A GE
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Optical Disks

Optical disks are larger (usually 5.25 inches) media that are
mounted in a specialized read/write drive mechanism.
Optical disks normally hold between 600 m egabytes and 1.2
gigabytes of data- enough for most large projects and very
reliable as a backup media. The disks are relatively expensive
though, and they're normally used for projects, not daily
backups.

CO-ROMs

When most people think of COs they either think of music
COs or the kind that you get when you purchase new
software or interactive titles. CO-ROMs can also be written
to (usually only once, though), and are increasingly being
used to store important data. They can hold a lot of information (around 600 megabytes or so) and are very reliable.

Moe;t CD-ROMe; are meant

to be " read-only," which
meane; that your computer
can read dat a from the
drive, but can not put data

onto the die;k (write). Some
e;pecial CD-ROM drive5 are
ale;o able to write to a blank
CD, t hough. The thing to
remember about writing to

Getting Stuff In

CDe; ie; t hat once t hey're
writ ten to, the information
ie; permanent, and they
become read-only.

CD 5torage i5 gaining in
popularity at an amazing

"Input" is one of those computer buzzwords so popular at Star Trek conventions, on internet chat lines, and among the "geek elite." It's just a term that
refers to methods of getting information into your computer.
There are three primary methods of getting data or commands into your
computer:

pace, due to their e;tability,

A Mouse

the low price of a die;k
(about $10), and the

A Keyboard

relat ively low coe;t of a CDWriter device.

Scanners

The Mouse
In the old days, before there were mice (the mechanical, computer kind of
mice, not the squeaky, pointy-eared species), using computers was quite a bit
harder. To get the computer to do anything, you had to enter confusing strings
of (otl1erwise) meaningless code.
The mouse was invented in the late seventies, but didn't make its public debut
on a computer until Apple put one on an early model called the Lisa. This
C HAPT ER 1: WHAT IS A M ACINTOS H?
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computer was never really popular, and it wasn't until the introduction of the
Macintosh computer that mice began to make their impact on computers
everywhere.

Don't run your mouse on
anything but a mousepad

or a very clean surface.

The way a mouse works is quite simple. Moving the mouse around on a flat

Even then, they'll occasion-

surface (many people use a special piece of plastic called a mouse pad) controls

ally become gunked up and

an arrow that you can see on the monitor.

won't work properly. This is
because the roller ball and

On the top of the mouse is a button. By using the mouse to move the arrow

the tracking mechanism

around the screen, and the button to click on the items on the screen, you can

become clogged with this

make things happen. This is (trust us) a much easier and more natural way to

really weird, greasy stuff

get computers to do things for you.

that is very hard

to get off.

on a regular basis, and

If using the mouse to point at different regions of the screen seems a little
clumsy, just give it time. Before you know it you'll be speeding around like a

clean it really well with

regular expert. You'll learn how to adjust mouse operation later in the section

alcohol or soapy water.

about Control Panels.

You should remove the ball

Same thing with the small
rol lers inside; examine them
and make sure they're
clean. If they have accumulated lint, remove it gently
with a wooden toothpick.

" Despite your best precautions and rodent hygiene,
you can expect to replace
your mouse about once a
year -

or less, if you're

really a heavy-handed roller.

P AGElO
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Here's how the mouse works:

There's a ball inside the mouse. As you move the mouse, t he
ball rolls around on the surface of the t able or mouse pad.
It also moves three sensors, wh ich control the position of
the arrow pointer.
Th is illustration should help
you see how to clean your
THE KEYBOARD

mouse. Before you do,
though, be sure to check
the instructions that

came

The next way to get things into the computer is through the keyboard. The
keyboard is used for several different types of input:

with your system.

Typing information directly into various programs. You might find yourself
There are kits available

entering copy into a word processor or into a design. If you do have to enter

t hat have special balls that

lots of copy, then learning how to type is clearly important. Other types of

you put into your mouse,

information you might find yourself inputting into the system are numbers. If

moisten with fluid, a nd roll

you're working on financial documents a lot, then you will become familiar

around for a while. These

with the numeric keypad, which is usually found on the right side of the

devices help keep the rollers

keyboard.

clean.

Using the keyboard to control programs. Almost all programs offer what are
called keyboard commands or keyboard equivalents. All programs on the
Macintosh offer several ways to accomplish certain tasks. Saving a file, for
example, can be done using the mouse (which you'll learn later on in the
course), or by pressing a combination of keys from the keyboard.

CHAPTER 1: WHAT IS A MAC INTOSH?
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Using function keys. Function keys are positioned across the top of the keyboard, and are named F1, F2, and so on, usually through F12. These keys often
consolidate common keyboard combinations into one keystroke.

When you're first using your

system, it will be all you can
do to move the mouse,

There are other ways you might find yourself using the keyboard, depending
on the exact nature of the program you're using at the time. A drawing program, for example, might allow you to use the keyboard to "nudge" or move an
object a little bit at a time; a game might let you use the Arrow keys on the
keyboard to maneuver your warrior through the bowels of Hell.

watch the screen, and gasp
in amazement when the

system does something
cool. As t ime passes, and

There are also four special keys - called modifier keys - that you will use
almost every time you work on your computer. Here is a list of these special
modifier keys:

you become more comfortable with how the system
works, you should make a

concerted effort to begin
using command-key
equivalents, such as
Command-S to Save,
Command-P to Pr int, or
Command-Q to quit. As
great as the mouse is, it's

88

The Command Key is the most important special function key on the
Macintosh; in most programs it's used to save, print, and open files.

~

The Option Key is the second of t he specia l function keys on t he Mac.
If you see this symbol anywhere, it means to hold this key down.

~

If you've ever used a PC, you know al7out the Control Key. It's not used
as much on the Mac, 17ut newer programs are starting to use it more.

0

The Shift Key works just like it does on a typewriter, capitalizing the
letter it's used with; it's also used with the Command or Option keys.

There are four special function keys used by Macintosh programs.

not nearly as fast as using
the keyboard when there's a
choice between pressing a
key or two and rolling the

mouse from one side of
your monitor

P AGE12

to the other.

If, for example, you wanted to open a file, you might have to hold down the
"0" key while pressing the Command key. Pressing "0" by itself might not do
anything at all- or at the most put an errant "0" somewhere in your important report. Pressing "0" while holding down the Command key, however,
modifies the key, and makes it do something it wasn't originally designed to do.
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SCANNERS

Depending on the nature of the system you're working on, and the environment in which you're operating, you may or may not have a scanner connected
to your system. There are several different types of scanners, but they're all

Scanners are very popular
in the graphic arts. There
are two basic kinds:

used to get information into your system. There are two ways a scanner might
do that:
The first is to scan images. Images might be pictures, drawings, maps, or
anything else you might want to have in your computer.

Flatbeds (which have a

The second method is when a scanner is used for something called optical

glass, sort of like a COPY
machine, on which you put

character recognition (OCR). OCR is used to capture documents that have
already been typed or printed. In this case, specialized software reads the words

the thing you want to

on the page being scanned and converts them into word processing documents.

scan), and Drum Scanners.
Almost all high-quality

Getting Stuff Out

color scans that you see in
books and magazines are

The next geeky computer term you should know is output. In English, this

done on drum scanners.

means how the information stored in your computer is presented to you or an

They're usually much more

audience. There are basically two ways that you can look at what's on your

accurate and capture more

system. The first is to look at it on your monitor, and the second is to print it so

of the available color when

you can look at it in a physical form- something that's often referred to as hard

scanning a slide or print.

copy output.
THE MONITOR

Your monitor is the window into what's going on inside your Macintosh.
Almost all computers are equipped with color monitors these days, and if
you're going to be using your Macintosh to create graphics and other visual
items, then it is critical to have a color monitor.
The next issue to consider when thinking about your monitor is how big it is.
Since many Macintosh programs use a varied collection of tools that sort of

CHAPTER 1: WHAT IS A MACINTOSH?
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"float" around the screen in their own little palettes (you'll learn a lot more
about this later), the amount of space you have to arrange your work, the tools
you have available, and other tl1ings you might want (or need) to have available
to you at the time, becomes very important. The general rule of thumb is to
buy as good (and big) a monitor as you can possibly afford. If you're working
No matter what you might
hear about how accurate
today's monitors are at
displaying color, remember
that when you print a
project on a color printer,
or send your files away to a
printer or service provider
for high-resolution output
(such as film for printing
presses). you cannot t rust
that your monitor will be

on your system all day- as many of us are - it's much easier to sit there if
you're not looking at a tiny screen and spending a lot of time arranging things
on the monitor.
THE PRINTER

The printer your computer is connected to is a critical component in your
system. Without the ability to create hard-copy output, all the work that you
do on your system would be "stuck" on your hard d rive- and you wouldn't
be able to show it to anyone, use it for communicating with the outside world,
or making cool pizza flyers, worldwide best selling novels, or the latest recipe
from your social group.
There are several different types of printers:

accurate. If you are working
on projects that ultimately
will be used in the commer-

Laser Printers Laser printers are probably the most popular type of printers in use today - especially in the graphic arts. A laser

cial printing process, be

printer works much like a photocopier, using toner to image

sure to consult with your

the page.

printer for specific instructions.

Dot Matrix

Dot m atrix printers use a print head com prised of some
number of small pins that drive ink from a ribbon onto the
surface of the paper.

Ink jet

An ink jet printer sprays ink onto the paper from small
nozzles in the print head.

Dye Sub

Dye sublimatio n printers spray a special heat-sensitive
colorant onto the page and heat it, bonding it to the surface
of the paper.
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Talking to Other Computen;
The Macintosh has the ability to talk to other computers. These systems can be
in your office or workplace, or in another physical location. There are two ways
that your computer can share information with, or gather data from, other
computers: networking, or through the use of telecommunication devices.
The price of la€;er printer€;
ha€; fallen from almo€;t

NETWORKING

$5,0 00 ten year€; ago to a

Networking refers to a physical connection between two or more computers.
This is usually done by means of an actual wire or cable that's hidden in the
wall. There are several different types of connections, including regular telephone wire, special shielded wire called coaxial cable, fibre-optic cable, and
even infrared signals that require no wires at all.

few hundred dollaro today.
There are t wo primary
t ype€; of la€;er printer€;
t hat you €;hould think
about: printero equipped
with Po€;tScript, which i€; a

TELECOMMUNICATIONS

€;pecialized language that

Telecommunications refers to a wide variety of methods that take the data
from your computer and sends it- either over regular telephone lines or
through special digital networks- to computers in remote locations.

i€; widely u€;ed in t he graphic
art€;, or printers without
PostScript, which will not
always be able to reproduce
your work if you're involved
in commert;ial art.

Telecommunicating with another computer requires the use of special hardware, referred to as a modem. A modem translates what's on your computer
into an analog signal capable of being sent across telephone lines to the huge
networks maintained by companies like MCI, AT&T, Sprint, GTE, and others~
Software
,_

THE OPERATING SYSTEM

""'

There are several different types of computers in the marketplace today, the ~
two most prominent being Windows-based machines and the Macintosh,
which you're using if you purchased this book.

C HAPTER 1: WHAT IS A MACINTOSH?
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These two categories exist because each machine uses a different type of
processor (see CPU). One is built by Motorola (for the Macintosh) and the
other by Intel Corporation (for Windows-based systems).
The fact that the two computers use a different processor isn't the only thing
d ifferent about them; there's another difference that's even more important to
The Macintosh

comes

equipped with the ability to

you as the operator: they use differeJ1t Operating Systems- MAC OS for the
Macintosh; Windows for the PC.

communicate wit h other
computers via a network

The operating system on your computer is actually a collection of programs, or

(which we describe in

instructions, that provide the basic functionality that your computer needs to

some

detail later in the book). If
you wa nt

to connect to

do anything. This includes things like reading to (and writing from) hard
drives and removable media, displaying graphics, controlling the mouse,

networks outside your

getting input from the keyboard, and a host of other functions. The operating

building or in other parts of

system also gives you access to so-called high-level functio ns, such as copying

the world (like the

and moving files, creating and organizing folders, finding things, and connect-

Internet), you'll need

to

purchase a modem. ·

Modems allow you to
connect to other computers via regular telephone
lines. Many computers

come with modems already
installed is one.

perhaps yours

ing to other computers (both in your own location as well as around the world
through the Internet).
Without an operating system, your computer wouldn't even start up. When
you give it power, it would just sit there with a blank look on its face.
APPLICATIONS

Applications are the tools that you use to perform different functions. If you're
going to be working in the graphic arts industry (which is probably the case if
you're using the Against The Clock series of workbooks), you may find yourself using various application programs that provide page layout, drawing
tools, painting or image editing programs, word processors, or image capture
software. Any of these terms (applications, tools, programs, software) m ean the
same thing.
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Here's a list of commonly used applications and what they're used for in a
graphic arts environment:

The exact combination of
software programs that

Word Processing

you will end up using is a

~

Word processing programs allow you to enter
and edit text (often called copy). Today's word
processing programs are quite sophisticated,
and are often used to create lengthy, complex
documents.

ll

Digital illustration programs are very
important in the graphic arts. They are used
to create logos, technical illustrations, tables
(like this one), and many other common
elements.

II

Programs like Adobe's Photoshop are used to
manipulate images. They can correct flaws,
and correct the colors so that printed output
matches the original photo. They are also
used as
rograms.

MSWord 6

purely personal choice (or
company choice, in the case

of commercial usage). We

Illustration

don't recommend one

llluotrator 7 0

program over another.
although we naturally have
our own favorites (and no, we

Digital Image Editing

won't tell you what they are).

Photoshop

Page Layout

m

Paoel'bker 6.5

Page layout programs are used to produce
"digital mechanica ls," artboards that are
used in the printing of books, advertisements,
magazines, newspapers, and many of the
nllr:l'IT.II>nS We See eVe'Y day.

The four most common tasks in the Graphic Arts field are writing
copy, developing illustrations, editing or creating phot ographic
images, and constructing - or laying out - pages using a page layout
program.
This book covers MacOS
version 8.x. If you haven't
already upgraded to this
latest software, please do
so before proceeding. Some

features will not work
properly if you do not, and
many of the screens shown
here are unique to 058.
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To introduce you to how the Ma<;intosh works; to teach you tli<;_ basics~{,
you'll need to operate a ~1acinj:osh in a commercial or educatio{lal envimnment. Through an intensive series of hands-on activities, you will:
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• Hpw to use the Mouse to control your Macintosh.
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• Understand the concept of Windows (the Macintosh kind, not the . ~
Microsoft kind); hm_
v to open and close them, how to move them :- ~ , '~ ~~
around the desktop, and how to manage them.
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• Learn about the Macintosh Operating System, and the. Desktop- the
area within which you do your work.
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• Be able to use the po<verful Help system built into Macintosh Sy:stem : \ ),. ·. ~-~,
8.x, and know how to reference topics in several different\ways. ·
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• Learn how to .create-and manage folders, one of the core components of ,_. ·: ·
th.e Macintosh enviro11ment.
/
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e taunch, your fir~t applicatipn,1a simple word proce~sor that.COpleS', with

yourMacjntosh.
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• Use the SimpleText program to change the appearahc~ of t~xt elek~~~s, ·-' '' · '
~ ':
'
and to save your work.
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• Know how to find lost or misplaced files, folders, or applications.
• Learn to print files, windows, th_e content~ of folders, or just abbut
anything else you might like to tape onto your refrigerator:
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Using the Macintosh

In this section of the book, we're going to be exploring the use of your
Macintosh, starting with the basics (such as turning it on), and moving on to
core functions such as folder management; what the desktop is and how to
The Macintosh is known for

move around on the system; what files are, how to create them; and more.

its ease-of- use, but don't
let this fool you into

In this section of the course, you should be in front of your Macintosh, and

thinking that practice and

ready to practice some hands-on activities that will help you learn to use your

experience aren't impor-

system.

tant. The longer you use
the system, the better an
operator you'll be. Another
thing to remember is that

Turning Your Computer On

operating systems and
software applications are

In order for your computer to work, you will need to turn it on. While this

constantly being updated

sounds quite obvious, you would be surprised at how many support calls come

and modified. You should

into help centers because the computer hasn't been switched on. Another term

consider subscribing to a

for this is powered up.

few Macintosh magazines,
just to stay in touch.

Most Macintosh computers created since the eighties have had the power-on
switch on the keyboard. On newer models -

particularly the PowerPC models

-the power button is on the front of the cabinet. Here's an illustration that
shows where the power-on switches might be found on your computer.

Power Up l:>utton for
earlier Mac m odele

Power Up l:>utton on PowerPC
and other modele
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Turning On Your System
If it's not already on, press the power button and turn on your computer.
A chime should sound letting you know that the system is powered up.
After a brief wait an introduction screen should appear, and the desktop
This pointing finger icon is
something you'll see a lot

will appear.

The Desktop

during the course. Wherever
you see it, it means that
there's a hands-on exercise

When you first turn on your Macintosh the monitor fills up with a back-

- a task that you can

ground color or pattern. This background is called the Desktop. In some cases,

actually practice on your

it might be a picture, since you can change the image that's used for the surface

system.

of your desk. Later on, when we teach you how to control and change the
working environment, you'll learn how.
WHAT IS THE DESKTOP?

The desktop is the area on which you do all your work. Even when you're using
a program that completely covers the desktop, it's still there. There are several
aspects to the desktop you should notice. Take a look at this picture:

The Macintosh Deskto
Your hara arive appears on the aesktop as an icon, as ao
folaers, applications, ana certain other types of ol:>jects.
In the upper right hana corner is a program picker, which is
usea when you have more than one program running at once. The
aate ana time are also displayed. We'll talk al:>out l:>oth features
later in the course.

The Trash Can is where you throw away stuff you aon't need anymore. You
can u!le it to aio;card j uet about anythin<j. A<:> i!l the ca!le in the real worla,
you can also aig around in there in case you threw away something important
(not that you woula ever ao something like that). The only difference is that
this Trash Can doesn't contain any ola gum or cigarette l:>utts.

The Menu Bar is the most important aspect

of the desktop. It's from here that you control
your Macintosh.

The Macinto,;;h De,;;ktop is the 17ackground upon which all your work i,;; done: ir; is alway,;; actiVI:, even when you're
working in a program, o;;urfing the Internet, or li,;;tening to t he late,;;t ,;;ound,;; on your internal CD player.
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At the top of the screen is a white region with words like FILE, EDIT, VIEW,
and SPECIAL inside. This is called the Menu Bar.
In the upper right corner is a picture of your computer's hard disk drive. This
can be thought of as a file cabinet in which your work is stored. We talked
about hard drives a little earlier. The picture you see is called an icon.
I CONS

Common ly Used Icons on the Macintosh
Icon

l:l

I Type

I Description

Applications

Standard
Folder

These a re the most common icons
that you will see on your system.

~stem folder

Syetem
Folder

of t he Operating System.

Hard Diek
loon

Your own hard drive might have a
different name.

CD-ROM

COs cont aining data or music will

loon

appear on your d esktop.

Application
loon

Each program has a unique icon. This
is the Adobe Illustrator icon.

There are hundreds of
different icons t hat you'll
see on your system, and we

couldn't put them all in a
table. Each software
manufacturer makes t heir
own icons, a nd each
application saves its files
with icons that look
something like that of the

Mouoe.eps

program itself. You can even

II

collect icons and cha nge

t hem -

Or•"'l••.Ttr

later, when you

;a]

really start "hacking"

Adobe Serif AdobeSanMM

a round with your machine.

This folder contains the components

File loon
When you create a f ile, t he program
(Illustrator EPS) applies its own icon (EPS fi le shown).
File loon
(Photo5hop)

Font leone

Some programs show the fi le itself.
Here's a Photoshop document .
Most font s come in two parts, each
having its own icon. More on this later.

Icons play a critical role in t he operation of t he Macintosh - and
for t hat matter, almost any popular computer in the world. They
show you, at a glance, the exact nature of a particular file.

For now, we'll concentrate
on the basics.

As you can see from this table, the look of an icon can show you what the icon
represents. An icon that looks like a folder is just that: a container in which
other folders or files may be located. An application icon is usually a small
picture that (hopefully) is related to the type of tool the program provides; and
finally, each application has specific types of icons that it uses when you save a
file containing your work.
C HAPTER 2: Usi NG TH E MAc i NTOSH
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Using the Mouse
The most fundamental skill that you will learn is the use of your mouse.
W ithout this pointing device to access the various m enus, dialog boxes, and
functions available to you, you would need to learn literally hundreds upon
hundreds of complex keyboard commands. An experienced operato r makes
This might sound silly, but
make sure that t he cord is
coming out of the top of

use of both keyboard commands and the mouse; depending on the type of
work he or she does, they might lea n heavily towards one or the other.

the mouse, or else when you

Artists working o n digital images, architects, or anyone doing a lo t of d rawing

move the mouse up, t he

and painting all use the m ouse much more than they do the keyboa rd. They

arrow will move down. Vv'hen

might access various tools from the keyboard, and they often find themselves

we were in the business of

entering type or numbers into their designs, but the mouse is their primary

supporting publishing

connection to the Macintosh.

installations, a support call

be the problem. We just

Other people, such as copywriters, account supervisors, custo mer service
representatives, salespeople, accounting personnel, and data processing profes-

thought we would mention it.

sionals spend a lot of time at the keyboard. Their typing skills are usually

came in and this proved to

superior to those of someone who uses the mouse all the time, but their eyehand coordination- the time it takes them to get the arrow o nto the right
part of the screen to click a button, fo r example - might not be that great.
As a student, you should seek to become proficient with the mouse as soon as
possible. You'll get plenty of practice during this course.
CLICK I NG AND DRAGGING

The first thing to learn is how to dick o n something and drag it around. While
this might not sound important, you will come to learn that it's a critical skill.
Clicking and dragging is just that: you point at something, hold down the
mouse button (if you're working on a W indows system it's usually the Left
mouse button), and move it around. This works fo r folders, icons, moving
items from o ne folder to another, or from yo ur system onto a floppy disk or
removable hard drive. It feels a bit clumsy at first, but will become seco nd
nature as you gain experience.
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Clicking and Dragging
1. In the upper right corner of your desktop there's an icon that represents
the hard drive in your computer. In the lower right corner, there's a little
garbage (excuse us, Trash) can. We've shortened the distance between the
two for this visual:

Throughout the course
you'll be seeing these
graphics, which are called
"screen captures." Remem-

2.

Position the arrow directly over the Trash icon and press down- and
hold - the mouse button. The icon will become highlighted. Move it up

ber that our system is

the screen until it's directly below the hard drive icon. Let the button go -

probably set up a little

essentially dropping tl1e icon in the new location.

differently than yours, so
they might differ slightly.
Most of the time they'll be
close enough so that you'll
immediately recognize
what's going on during an

3. Now click and drag t he hard drive icon until it is to the left of the Trash

exercise or lesson.

Can icon:
It's important to keep the
hard drive icon positioned in
the upper right hand corner
of the desktop -

it's

common practice, and the
machine looks there first
when it's starting up. so if
it's there, the machine will
"boot" quicker.

DOUBLE-CLICKING

The next important thing to learn is the ability to click the mouse butto n twice
in rapid succession. It's called, appropriately, double-clicking. If you position
your mouse on an icon and double-dick your mouse, som ething will happen
- as we'll see in this next exercise.
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Double-Clicking an Icon
1. Position the arrow directly over the icon for your computer's hard drive.
In our example, the name of the hard drive is MacHD. It might be called
something else on your system, but it should be there.
2. Double-click the icon. It will open into a Window.

10

I!!)~

MacHO

-

3 items, 1.5GB available

I

.....

~

System Folder

1--

tl

Applications

ll

Documents

1--

.....

~

I

T• ~

Working with Windows

A Window is a fundamental component of the Macintosh Operating System.
Windows sit on top of the desktop, which is always functional and immediately
available. Windows serve two functions:
Don't be confused by the
word Windows -

we're not

Displaying the content of folders, hard drives, removable disks, and
CD-ROMs,or

talking about lntel-based
computers running

Letting you use different application programs. In most cases, pro-

Microsoft's operating

grams show you a window containing the document that you're
working on and provide different sets of tools that you use within the
window. Many programs will let you have more than one document

system. A window is a

open at a time.

Microsoft Windows. The
term Window predates

graphic that shows the

contents of a file or folder.
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We're going to start out with the first kind of window: the one that displays the
contents of a hard drive or folder.
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Working with a Window
1. Position the Arrow over the icon of your hard drive. It's the icon in the

upper right corner of your desktop. When the Arrow is over the top of the
icon, double-click the mouse button.
2. It will open into a Window. Some of the items inside might look different
on your system; you may have more or less folders, or you might have
folders and other icons representing files or applications. Here's what our
hard drive looked like when we double-clicked the icon and it opened into
a window:

Close Box

Title Bar

Auto Resize

Number of items
Tota l Available Space

Whenever you see an

Scroll Bars

Contents

illustrated window like this

one, where we've put titles
and arrows pointing

out

Manual Resize

,

specific features, look at it

Anatomy of a Window

and read the cal louts. We'll

often refer to these
illustrations in that area of

3. Move the Arrow over the lower right corner of the window, to the Manual

the text.

Resize handle. Holding down the mouse button, drag the corner inwards,
reducing the size of the window. When you let go, the window will remain
at the size you m ade it.

0
,--

~ · ="'="~""'

i

lj

~

I

I

MacHO -

Slj3tem Folder

I_- -·

tl

Appllcetiono

I

t

"~ ~ 1[18

3 item•, 1.5GB eve11eble

-

tl

j

.

I
I

Docume~

~

.
~

-1,.

4. Resize the window until some of the contents are hidden.
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Scroll bars are an important part of managing windows on your Macintosh,
because it's not uncommon to have more things in a folder or on a hard drive
than can be seen at one time. That's where scroll bars come into play. Here's
how they work:

Clicking and holding the Slider will let
you move the contents up and down at will.

Clicking on t he gray area will move the
content area the width (or height)
of the visible area, exposing the next
region of the window.

You

Once you've become familiar

I

If you click once on the arrows at
the top or bottom of the scroll bar,
the list will move up a bit at a time;
click and hold the arrow and the list

will ocroll

''""'""'"•IY

The Scroll Bar is an important component of all windows.
can hold the Slider itself, click or hold down the arrows, or click t he gray area.
Each method moves the window's contents in a slightly different manner.

with the basic components

of a window, such as scroll
bars, resizing handles, and
c lose boxes, you can rest
assured that all Macintosh

5. Once your window is too small to show all the contents, use the sliders to

expose items you can't see.

software will present
exact ly the same type of
window, and that they'll all
work the same way. That's
why once you've learned

one

program on the Macintosh,
you've gone far towards
learning t he basic opera-

3 items~ 1.5GB available

til

System Folder

tl

Applications

tion of any program.

The Scroll Bar becomes active as soon as you make
the window too small to show all the cont ents of t he window
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6. Next, move the Arrow over the top of the window (over the Title Bar),
click, and drag the window around. You can position the window anywhere on the desktop -

-

even with part of it hanging off the monitor!

7. Double-click the Title Bar. Watch what happens:

How you organize your work
area is a personal thing,
and often closely parallels
your habits on a real desk

(as opposed to an electronic, or "virtual" desk). If
you're sloppY. and your desk
is normally buried under

tons of paperwork, so too

8. You could double-click the Title Bar one more time to resize the window
back to where it was before you minimized it, but you can accomplish the
same thing by clicking in the Minimize button (the one in the very upper
right corner of the Title Bar). Do that now.

will be your Macintosh's
desktop. If you're a real
control head, and keep

9. Click the Auto-Resize button (the second one from the upper right corner

every single thing in its

of the Title Bar. The window will get just big enough to show all the

correct spot in the

contents:

universe, then your
Macintosh will be equally

_..,

1!1

l!lll

'' "'-·1" .......

well-situated. We're of the
buried-under-the-rubble
breed of operators.

10. You will notice that when you're working with a window (resizing it,
moving it, etc.), the Title Bar shows a series of black horizontal lines.
These lines indicate that this is the Active Window. Click anywhere on the
desktop outside the window, and see what happens:

~loc HO

'I•

~

S~,tstem
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Folder

"•.-f<

[)
Applleellons

lh:od#

t:l

Doc uments
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11. You will notice that the Title Bar of that window is now grey- the lines

indicating that it is active have disappeared. Click on the Title Bar again. It

will be reactivated. This is very important when you have several folders
opened at the same time. We will see this feature in action a little later on.
12. Close the window by clicking in the Close box (in the upper left corner of

the window).

Anatomy of a Window

Whether you're looking at the contents of a folder or disk drive, or working in
an application program that provides a window for you to work in, tl1e basic
features of a window can be fow1d almost universally within Macintosh
programs:
The Title Bar contains the name of the folder or hard drive.
The Close Box closes the window.

Auto-Resize expands the window to display all of the contents, or shrinks it to
where you previously sized it. If tl1e contents require more than the space
available on your monitor to display, the Window expands to fill tl1e entire
monitor.

Minimize shrinks the window down to its Title Bar, or, if the window has
already been minimized, it returns it to the size it was when it was shrunk.
The Scroll Bars allow you to move the inside of the window horizontally or
vertically so that you can see items not currently in the visible area.
The Resize Handle lets you click and drag the window to whatever size suits
your needs.
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Working with Menu Bars
Whether you're working on the desktop or you're in the middle of drawing a
masterpiece using an illustration tool, there will be menus available at the top
of the screen. Menus are the fundamental method of controlling things on
your Macintosh.
~ ~ Ale Edit View Special ~ Help

This is the standard Macintosh menu bar- the one that appears when you
first turn on your machine, and before you've started any additional programs.
Although all menus work the same way- you click on them and slide down

until you're at the choice you want to execute- menus change, depending on
what you're doing at the time. Menus on the Macintosh are called context
sensitive menus, since they change depending on the context within which
they're working. At this level (the desktop), menu choices reflect things like
opening and closing folders, making new folders, shutting down the computer,
or emptying the Trash (more on that later). The options available to you at this
point are related to working on your desktop.
If, on the other hand, you were working in an illustration program, the menus
would reflect drawing and viewing tools- more relative to d rawing than to
working with folders:
n'I!III TVP e

Filter VIew Window Help

••

Transform
Arrange
Group
1 n•ll.,llfl

li G

Lock
I filii. AI!
Htde Selection

IICL

~hl)'lfo

l

'•

I

IIU

·"

t'olllll

'
•H

Ran erlzePatll

MGsks
Compound Paths
Crop marks
Graphs

•

••
••

I
!-ll'llf'•ll''·t(oJIWflrr

'

'

Unite

~ Interse ct
~Exclude

t,t Minus Front
~ Minu s B<l<k

llJI DIVIde
fl1) outtlne
~ Tri m
llJit.terge
~ Crop
~ lf<lnl
~ SoiL
~ Trap_

Options
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While working in an image-editing program (one that lets you modify the way
scanned photographs appear and reproduce), the menus would show things
like brightness and contrast, and similar image-related functions.

Duplicate ...
Apply Image ..•
C<~lcu l ntlons ...

Curves ...

"

Image Size ...
Canvas Size ..•

111

·l

Re place Color...
1 to 1r.
Rot11te Canvas
Histogram ...

~

Invert
Equalize
Threshold ...
Posterize ...

3€ 1

Variations ••.

Throughout the course you'U be working with menus -

both from the

desktop as well as from inside of application programs.

Working with the Menu Bar
1. Move the Arrow to the first menu selection. It's called File. Click once on

the word. A menu will slide d own from the menu bar, and you'll see the
choices available to you:
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2. Slide over to the next menu -

the one called Edit. That menu will unfold

from the menu bar and you'll see more options. Don't worry about what
they do just yet- you'll have plenty of time later on to learn all the
commands:

You should notice that to
the right of the Help menu
selection, there is the
symbol for the Command
key and the Question mark.

This is called a Keyboanl

3. The neA't in line is the Uiew m enu, where you can change the way files

Equivalent. That means

look and behave o n your system. This is an other menu that we'll explore a

that there's an alternative

little later on in the co urse:

way to access that
particular command (in
this case accessing the
Help window).

Hold down the Command
key, and press the Question
Mark (which is on the lower
right side of the keyboard;

4.

Next, slide past the Special menu, and take a look at the Help m enu. Once

pressing Shift at the same

it appears, slide the Arrow pointer down until the word Help is high-

time isn't necessary). The

lighted. We will discuss the Help system in the following section .

Help window will appear
without having to go to the
menu bar.

Learning keyboard equivalents doesn't happen
overnight, but you should
try to remember them and
use them whenever possible
-

it will make you a much

more efficient and speedy
operator.
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The Help System

Buttons

This section will provide you
with some experience in
using the built-in Help

Discussions about
Help topics will
appea r here in t his
area.

system that Apple
provides with the
Macintosh. The exercises
are designed to familiarize

OK

you with how the system
works- not to go through

Scroll Bar

the hundreds of topics
available. You should make
extensive use of the help
system as you're learning.
Later, it will become just
another thing that you
don't use. We always install
help files when we purchase
new software. Some of the
systems are very comprehensive, while others hardly

The Help system built into the Macintosh is a powerful and effective aid that
will provide answers to your questions and instruct you to perform specific
functions. While a structured, hands-on course like the Against The Clock
series of instructional guides is the best way to start learning, a comprehensive
Help system is an indispensable tool as you move forward.
The buttons at the top of the window will let you use the Help system in one of
three ways. You activate a button by clicking on it once. It will become highlighted, letting you know that it's selected. The three buttons on the Help
window are:

provide any assist ance at
all. You will come to love
help systems if you're

Topics, which provides a list of important topics that new users are
particularly interested in.

anything like us- bad at
reading manuals. Help
systems are meant to be

Index, which provides an alphabetical listing of every subject covered in
the extensive Help files that came with your Macintosh, and

available at exactly the
time you need them.
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Look For, which lets you enter words or phrases and then performs a
search of all the available information. When it finds a relevant topic, it
displays it for you.
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Help Topics
1. Click on the first of the three buttons.

2. Put the mouse on the slider, click and hold it, then move it down. You will
see the list on the left move. When you're done, move it back to the top.
Click once on Learning the Basics, in the left window. The right side of
the window will display a list of basic topics:

I ~ Mac OS Help I L(g]JI I roo I I @ill
Topic.

~~~~~~~~···•113...

Help
v- About

~

the System Folder
Icons
menus

Customizing Your Computer

Printing

'<7

onts
~s
D·ROIVI Discs
olor

windows
How do I
use Mac OS Hl!:lp?
undo a mistak~ or cancel an actOO?
open an item?

~ch

and

Look For

2. Click a phrase, then click OK:

Appkation Programs
Monitors (s tandard setting•)
Organizing Yovr Fies

Some icons are buttons,

lnd~x

I. Click a topic area:

f;-

move an item?
resize a window?

~~~~~--------~

3. You will see that the list is broken into categories. The second category is

some aren't. Buttons

called How do I and is followed by a list. Double-dick the item named

need to be clicked only

resize a window:

once, while a regular icon
needs to be double-clicked.
0

It's usually not a problem if

,. . .
How do I resize a window?

you accidentally double-

You can resize a window by dragging the me box (in the
lower-right corner ) or cltcl:mg the zoom box
(up~r-ri~tht corner). The zoom box expands the
window to show its complete content or shrinks the

click a button. Your

window to its m ost recent smaller size.

computer won't blow up or
anything, so if in doubt,

Slu

click away.

dJ.L~

===-r

box

Read this information, then dick the right arrow.

4. ln the lower left corner of the window is a small up arrow that looks like
this: ~· Click on it and you'll return to the main Help window.
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INDEX

The second way you can use the Help system is through the built-in Index. The
Index provides the same information as the Topics button, but presents it in a
different order. This is the case with all three methods of accessing the Help
system.
Using the Help system, particularly when you're new to the Macintosh, is a
great way to find important information and, at the same time, it gives you a
chance to practice clicking, scrolling, and working with windows.
The Help system is, in fact, an application program that is built into the basic
Operating System.

Finding Information Alphabetically
1. If it's not already visible on screen, bring up the Help window, either by

using the mouse and selecting it from the menu bar, or by pressing the
Command, Shift, and "?" keys at the same time.
2. Click the middle button at the top right portion of the window; the one
that says Index:

~ ~~~~:~~ Help l l~~~ "-1~ 1

Many different applications
make use of split windows
like this one, where a list
appears in one side, and
the content in another.

Thi5 5pecial 5lider
\
WOrk5 jU5t like t he One
on an old telephone
~lid~ it
directory; you ~ v
to the appropriate letter
. .
.~t of
and 1t g1ve5 a 11 ~
all the command!> that
5tart with that letter.

·- ·

I. CIIok >t.,m O< d"i thooi!Ou·

a..c or rG
A, ..

H I HLMNo• q •

:;:;: ~":'..

"""

~

"'"''""""*'

_

._ ..

,----------,-:1
~

Thi5 scroll bar let5 you

.t.---

view entrie5 that are

"'

-

- -

1- currently out5ide the

~~¥"

-

visible window.

" ""'""'"""'

:!,";;"'"'""""""'

.

.

Some Web sites on the
Internet also make use of
th is t echnique.

3. Move the slider button (the one over the alphabetic categories) until it is
on top of the letter ''I.''
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[.- Mac ()S HelJi]

It§ I lllbit:ll IPill
Topics

Index

Look far

l.Cicka term or drag the s l i d e r : . - - - - - - - - - - - - - . - - .
ABCDEFGt{QikLMNOPQR!

-

100i\s

IDE
Info window
inltlallzingclsl<s
insertion poi'lt
Installation

Lot6 of eoftware applicatione; make ue;e of vieual

Internet
IP address
Key Clips
keybo11rd

metaphore; e;uch ae thie

~

~-----------------~
[___ OK·--~

one, which duplicatee; the
way an old-faehioned paper
booklet telephone directory

4. Click once on the first entry in the listing: the word icons. The content

ueed to work. It makee

window to the right will fill up with subjects related to icons and how they
work:

ueing eoftware more
friendly by making a
connection between

c::::::;:::;:::::•;;:::::::::::::•::;::;:;:;:::;::::::::::::::::::::::::::::::::::::'''''''':•:::::::::::••::::::;::::::::•:;:;::;;::::n::::::::e

e;omething familiar (the old

I- Mac (~~ Help lit§] I m=~ll

directory) and eomething

Topics

Index

11'¥1 I
Look far

completely different (like a

1. atck a term or drag the slider: 2. Cick a phrase, then click OK.:

digital help eyetem that'e;

ABCDEFGt{QI KLM NOPQR5

invieible until you call it up

IDE

ffe~p

vAbout
Icons

Info windOw
~··

initializing cls1<s
Insertion point
Installation

magically).

~

l'""

v.

Internet

OJoanizfnO your files
dragging options
v Definitions
desktop
icon
v How do I

IP address
Key Clips
~
~,;;;ke~yboar=.;...d_ _ _ _ ____._...
_.

sort Icons?
change system fonts?
chanoe the color of 11n Icon?

5. Double-click on the word icon, under the Definitions category, and you
will see a brief description of an icon:
c•:,::::•:::::,,••::::::::::::•::::::::::::::::•:::•:•:::::::::•::::::::::•::::::::::::::::•::•=::::::::as
Icon
An leon is a picture that represents a disk. program,

document, or tolder. You work With these items (far
example, open, copy, or move them) by manipulating
their icons.

G

Hard Oi3k

~
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ll••h~

~

SimpleText

0

Letter

rca

Scptem Folder

1([ t·i
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You might notice that next to each topic there is a small arrow. You can collapse
topic headings into a more manageable outline by clicking on the arrows:

I C1 Mac OS Help I I !~
Topics

I B IIaiJ I
Index

Look For

1. Click a t erm or drag the slider: Z. Click a phrase, t hen cllck OK:
IAB C DEFGt{i)nMNOPQR

~'!bout
Icons

OE

organizing yoor files
draqging Options
v Oef"tnitions

n fowindow
lrltlaizinQ asl<s
~tionpoint

instalation
hternet
Paddress
Key Caps
keyboard

~

~ktap
yHowdol

1' sort icons?

chonqe system fonts?
ch~the color of an icon?

OK

These small arrows, used

I
Click on these small arrows and you can
collapse the topics into an outline.

here to collapse and
expand the topics list, are
another very common
graphic element used
throughout t he Macintosh

elp

1> About
1> Definitions
v Howdol
sort Icons?

system. It's another visual

change systl!m fonts?
change the color of an icon?

tool that works the same

change the name of an Icon?
c~ the way files are represented?

way wherever it's used.
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1

Help
I> About
~

Definitions

I> How dol
I> Why

chan9e an Icon's picture?
assign a label to an item?
v Wh
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LooK FOR

Perhaps the most effective method of finding information from the Help
system is through the use of the Look For command.

Looking for Topics
1. Click on the lool< For button on the Help window.

2. Click on the small arrow on the left side of the window, enter the word
"Folders;' and click the Search button:

1. Click the arrow, then type the

term you want help on:

r;:;:
[I) !folders

3. Cltck a phra.e, then click OK:
r.:Hel...,..p--=-------..,....,

"' About

spring-open f olders
or~youf~

-

2. Oick Search:

~""
1 ""-""'
,e"""
!,-rc-h -_..,.]

"' Definitions

access priYieQes
Appicatlons folder

Doc1.m0nts fold~
fold~

Icon

Ara we mentioned, almorat

System Folder
wWldow

all programra come with

OK

raome raort of help rayratem
built in. Although they don't
all look exactly the raame,
they all work on the same
basic principle of topics
and indices.

3. Feel free to look around the Help system for a while to familiarize yourself
with how it works. When you're done, click the Close box (in the upper
left corner) and put the Help system away. You can always access it any
time you need it.
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Using Folders
You've already double-clicked an item when you opened the hard drive icon in
an earlier hands-on exercise. That's going to help you in this section, where
we're going to discuss the way folders work on the Macintosh -

and how you

can create, name, arrange, and throw one away when you don't need it anyIf you've used computers

more.

before the Macintosh,
you're old. Just kidding. If

WHAT ARE FOLDERS?

you have, you might be

You can tell a folder when you see one: it looks just like a folder would look on

familiar with t he term

your desk. Well, maybe it looks a little digital, but then again, this is the com-

subdirectory. A folder is a

puter world.

visual met aphor for a
subdirectory.

tl

Applications

CREATING FOLDERS

Learning how to create folders is one of the most important, fundamental skills
that you will call upon when setting up your system, getting ready for a project,
or backing up your important files; in short, you will be creating folders from
now till those proverbial cows finally show up at the old ho mestead.
Creating folders is really quite simple, as you'll see from the next exercise. It's
not making folders that's the hard part -
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it's keeping them organized.
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Creating a New Folder
1. If your hard drive icon isn't open (displaying a window with the drive's

name in the Title Bar), double-click it so that it is. Click once in it just to
make sure that it's active (the Title Bar has lines in it and isn't just plain
gray):
0

08

1\.iacHO
3Hemo. 1.5GB ovel1eble

~

Sy•lem Folder

tl

Application'

tl

Documenlo

rr-

I

2. Resize tl1e window so that you can see more of the contents:

0

E!l8

~loclll

l 1te mt, 1 5 G8 ..,.liable

~

S ~pl em ro lder

t:l

lop~l ietliOU

tt

Oocun.nts

.
3. Move your Arrow until it's in the menu bar at tl1e top of your desktop.
Click on the File menu, let it appear, and slide the pointer down until New
Folder is highlighted. Click tl1e mouse button.

Get Info
Label

Sharing •.
Make Alias
Put Away

Find ...
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4. As soon as you let go of the mouse button, a new folder will appear in the
window. The name of the folder is highlighted. Type in the words:
"My First Project Folder"

Throughout the exercises

Don't worry if you make a mistake, just use the Delete key on your keyboard to back up and retype it:

we say things like "name
t he folder Harry." You don't

""""'

0

_

_.:::

MacHO _

08

4 Hems, 1.5 GBevo1loble

have to use our names-

~

~

it will j ust make it easier,

Cl t:l
~

Sy•tem folde r

because t hat way the
screen captures will look
the same as your system.

Appllcetlon•

Documents

r,;

•

c

Click the Arrow anywhere in the window (not on an icon) to deselect the
folder.
RENAMING FoLDERS

It's important that you know how to change the name of a folder. There are
plenty of times when this is necessary: when you want to add a date to a
folder's name, when you want to correct a misspelling, or when you want to
change a name in order to better organize a collection of folders. Doing so is
simple:

Changing the Name of a Folder
1. Click once on the folder you just created. It will become highlighted:

....!....•
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2. Hit the Enter key on the right side of the numeric keyboard. If you don't
have a numeric keypad (or if you just want to do it a different way),
simply put the Arrow Pointer over the top of the name and wait a second
or two. A box will appear around the highlighted name of the folder,
indicating that you can now type a new name. Change the name of the
folder to Project Folder:

NESTING FoLDERS

Nesting folders refers to the process of putting folders inside of other folders.
We don't really know why it's called nesting, it just is. Some old computer geek
needed to come up with a meaningless term to confuse non-computerites, we
suppose.
For this exercise, we're going to use some of the files that came on the CDROM (supplied with the book).

Organizing Folders
1.

Double-click the Project Folder you just created. It will open up and
display its (now empty) contents window. Notice how it sits on top of the
folder inside of which it was created:

CHAPTER 2: USING THE MACINTOSH

PAGE 43

8. Drag the two folders over to the Project Folder. You will see them move.
Drop them onto the window by releasing the mouse button:
D

--

~WIIft:MI...,.rotMn

•

llill

,.._,I,IGI ..... tMtt

.

•

EJ

8etnH I'IC1.ollt

~'t '"' l

Qtuo'"'*'"'

8trrttt

s...

f'rtUt"rtrolll~r

1!11!1

Cl
c.,.r.,..

...... ,. "..'

Cl

..

~~-

tot·~·

•

.,

9. Drag the Banana Boat icon onto the top of the folder called Graphics.
Hold it there a moment, and the folder will open. Drop the file:

0

2113

Graphics

.

I item, 1.5GB avelleble

~
Benana Boot

•

(

-

10. Close the folder by clicking on the Close box. Next, take the Gardening

Panel icon and simply drag it onto the Graphics folder and drop it immediately. It will go into the folder without opening. Remember, if you wait a
moment, the destination folder will open by itself, if you simply drag
something onto a folder and drop it, the item will automatically move to
that folder. Open the Graphics folder and check it out:

0

~

_,_

--

~

Graphics

2113

2 ttems, 1.5GB aveileble

~

!!Ia

Be nona Boot

Gerdenll'lll Panel

4

..
'
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11. Put the Berries file and the Sample File #1 file into the folder that you
named Copy File s:

·-

D

. 1:!18

Copy Ales

.

21tems, 1.4GB avelloblo

I.
..L
•

1

.
.!/.~

12. Put the Rough Rider Ad file into the Rrtboards folder, and the Berries
Picture into the Graphics folder, along with the other two images you
dragged into it.
13. When you're done, the Worl<ing with Folders folder will be empty, and all
the files will have been organized into the three folders that you created:
l!lB

0

I

·~·

' J 't'):t

tl

c:...,, ....

I
I

14. When you've finished with this exercise, Close all the folders so that your
desktop is empty (or at least the exact way it was when we started the
exercise).
0

..,,_
J: IW..., I 4 •

..,.0.W.

IIIII

.

"~

~

I- '"'

EJ

-

,.......

0

li!!
.. ,..1

~

l!lll

•

.

------=--...." .........

0

. .•. ..

l!lB

·~

~

""j," ""t"

" " ""

~~··
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NAVIGATING THROUGH FoLDERS

What you just did in this last exercise was to create a Project Folder with three
sub-folders inside of it. When you're working on projects, especially complicated ones, your folder structure can become equally complex. Knowing where
you are at a given time, and being able to see- at a glance- which folder
There ie. no quee.tion in our
minds that the most
difficult concept for a
beginning student to grasp
is how to dig around
through folders to find
what they need. This is

happens to be inside of which o ther folder, is very important.
When you create a folder within a folder it is considered a nested folder.
Another word for nesting is the hierarchy of your files and folders. You can
think of hierarchy as a standard flow chart, with the desktop being at the top,
and all o ther things being either at the same level, or at some level below the
desktop.

particularly true when
you're inside of an applica-

Organizing Folders and Files on the Macintosh

tion, and need to navigate
d irectly to a specific folder

Things on the desktop include:

in order to find the right

Hard Drive
(MacH D)

file. Take special care to
study this issue until you're
quite comfortable with how
fo lders can reside inside of
each other.

DESKTOP

I

Any other file, folder, or item
that you put on the desktop
L-----------------~

Stuff on your Hard Drive includes:

I

The Trash Can

I

CD-ROMS
FLOPPIES
Other Media
(t hese appear
when they're
inserted)

I
System Folder
You created this folder and the folders
that are now inside of it during the last exercise.
Applications

Documents

You dragged these files into their respective folders from
the Worki'lg with Foldt:rs folder, which was inside of your Student Files folder

Folders are the backbone of file organization on your Macintosh. You should always try to
keep your work organized into sensible, easy-to-understand groups. You do this with
folders.
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Identifying a Folder's Hierarchy
1. If any folders are open on your desktop, close them.
2. Double-dick your hard drive icon.
3. Hold down the Option key and double-dick the Proj ect Folder. You will
note that the Hard Drive window automatically closed when the Proj ect
Folder opened. This automatic closing of one folder when you open one

of its subfolders is very important when you're going deeper and deeper
into nested folders. Otherwise you would have to either close each one
individually, or live with a very cluttered desktop.
4. Do the same thing with the Graphics folder. The Project Folder will close,
and the only thing left on your desktop will be the Graphics folder:

5. Hold down the Command key and click-hold on the folder's name in the
Title Bar at the top of the window. Something called a Pop-up Menu will
appear. (It's called a pop-up menu because that's what it does. You will see
many more of these during the balance of this course.)
·~

0

<·

..

3 l ~ Project Folder 1
OMacHO

~

~

BaMM Boat

Garden! 11CJ Panel

~

•

EJS
1-

Be rrie' Pi ctu re

.

1-
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6. Slide your Arrow down until the word MacHO (or whatever your hard
drive is named) is highlighted. Let go of the mouse button:

Banano Boot

7. Notice that when you selected your hard drive by Command-clicking the
Title Bar, its window automatically opened. You can use this technique at
any time either to open the "containing folder" or simply to look and see
where it is you're working at any given time.

8. When you're done, Close all the windows again.
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CHANGING VIEWS

Another very important aspect of managing and arranging your folders is how
the contents appear when you open them.
So far, we've been looki ng at icons, and while that's fine for some applications,
there are other times when a folder contains so many flies and folders that it's
simply impractical to move around using only little pictures of fiJes. There are
times when we need to look at Lists. Icons are pretty, but lists are very effective
under certain conditions.
For example, if we open our System Folder (which is a special folder we'll be
talking about a little later) into a large window, we see these icons:

0

818

System folder
311tenn, 1 4G8 .....iltblt

~
ruw»r

A>PitMttulttms

r:t

CCintrCII Ptneh

rents

hltMlOM

rat

Pnn!Monitor l\Jtyments

~

Cltns

Chllt~Gttd

A>>IIUUIO~v~por1

Cl

HOT Cxtn ... CCinflQ

~

~

~

Control Stnp l'bJuln

Conlrol P• neh (O!a.ebltlt)

a

DI'IYI:

uu...,

ql~pNto\0.1'

LtU'IChtr lttmJ

Prtftrtnc:u

'a

S<rtpb;)olrllt

Shl, t ~nlte~N

Shutd!N'Il ll tns(Diuflltldl

~

I"WTCP ()NQ

(xtensicM(DIM!ilrd)

£u»n ftlekr

~

Stnpt[C1W

tal

5C.tl0ntf \j

~

~

()

~

Scnptlnq.t«tuo""'

~

Sttrtuplterm

Qll

Shrlup ll tms ( DIUtlltcl)

Si,lltm U.ternl"'' (DtM~leod)

Svstn

l txt[ntodlf!l11

This isn't even a very radical example. Folders might contain hundreds of files
- a catalog which requires 400 or 500 individual sca ns to complete, for
example - and can be very tough to look at.
Fortunately, there are many different ways that you can arrange your fiJes in an
open window.
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Changing Views
1. Double-click your hard drive icon, then hold down the Option key and
double-click the Project Folder you created earlier.
2. Go to the menu bar and select Uiew:
Special Help
Icons
as Buttons
as List

'<~'as

Window
as Pop-up Window

'<~'as

aean Up
Arrange
.,
VIew Options ••

3. Slide down until the as list selection is highlighted. Let go of the mouse
button. The Project Folder will now display its contents as a list instead of
as ico ns:

o :-

..

· "' Project Folder ;;:

......

Do

Cl Artboordo
Cl Copy Fn..

~

(l Grophlco

~

-

.-..::::;;-~ ~ 013

31tenu, 1.4GB ove11oble
'

·'

;I oate Modified
Todoy, 10:27 AM

.

Todoy, 10:26AM
Today, 10:27 AM

.

~

CIJ I

X

-~

4. You'll notice that each folder's name is listed on the left side of the window, and the last time the folder was modified (or in this case created) will
be displayed in the next column.
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5. To the left of each folder's icon and name is a small arrow. Click the arrow
directly to the left of Rrtboards:

I!J ~,;;;;p~
_;;;; Project Folder ~

=

~ggj$

-j

eJ 13

4 ttems, 1.4GB evetleble

~
•

~

Dote Modified

-

Todoy, I 0:27AM

RoUilh Rider Ad

Vesterdoy, 2:42 PM

(1 Copy files
(1 Graphi cs

~

•

.I

(1 Artboercb

v

Todoy, I 0:26 AM
Todoy, I 0:27AM

?

• '··

Ill

6. Do the same thing to all three folders:

o ~""""2 ~ k

~ Project Folder

..

I

:,:,~.-

v

(1 Artboerds
•

v

v

L .. c-

•.

Dote Modified
Todoy, I 0:27AM

Rough Rider Ad

A

Ve,terday. 2:42 PM

(1 Copu Files

Todoy, I 0:26 ~M

B Berries

Yeoterdoy, 2:32 PM

~ Semple File .. ,

Mon, Nov 17,1997,12

(1 Grephlco

Todo y, I 0:27AM

liilil

Beneno Boot

•

Berr ies Pictu re

Vesterdoy, 2:13 PM

Ia Gordeni 11CJ Penel

Vesterdov, 2:18 PM

Vesterdoy, 2:20 PM

•

4 II

Whenever you close a folder;

013

9 items, 1.4GB ovetleble

.
~

7. The list view contains a lot of information about each file that doesn't
show in icon view. Enlarge the window to the right, until you can see all
the categories:

it remembers the view
options that you selected

-

before it was closed. This

.... .. =•RMtrM

ensures that you can keep

.. C1 c.nnltt
13 ,.....
""~. ...... .. ,
rj

.

some folders all open within

............

-·,

'lt.PIIt,I ,. ~ MIIt~l

Ta~,t0·2UH

Y..tnM~ ,Z G P N

TMev, tOl' AM
Ynttr4.., Z ,ZP11
MIIB, ..... I7, 1Hl, IZ $5 P11

'"'_
...
..,,..""'_

Ya'-n:lo1. ~PI1

liJC.NNIIII ......I

Yalt,..,, 2_11Pf1

?13 -

each other, others closed,

~~ f'n!Jtctfolc.r ~

,.,_,02:1411

YQ,., , 2.tSI't'l

..

"""' -~ -

l!l8

•n- ''"
"""

Pllo~bii.8PIC'tllt

''"'

St.....Tnt •llltio- ~

HI<

P!Milllt. . Pit' fl..

........

Sl.,ltTWit:J1--IIt

Plila4DMJo•PCt tih

...._..,_ftt"nh

and still others with
different view options.

8. Click on the arrows again to collapse the outlines until you only see the
three folders again.
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9. This time, instead of going to the menu bar and accessing the Uiew menu,
hold down the Control key (on the lower left of your keyboard) and click
inside of the window. Another pop-up menu will appear:

-

0 --

e=-==-:rt

Project Fol der ·. ·

-

218

=

3 items, 1.4GB ovoileble

When you get a chance, you
should check out View
Options. Access it by

d.:>:
1>
1>
1>

Jl

~ ;!,·.-::: .I.

Cl Artboards
Cl C.pv rnes
Cl Graphics

I

Date Modified

Help
New fol der
Close Window

• I 0:27AM

.

, I 0:26AM
, 10:27 AM

Get Info
Sharing ...

Control-clicking inside the

VIew
~
Sort List
~
VIew Options ...

window, and selecting it
from the pop-up menu:
4

.

r;~/

1!11

10. Slide down until the Uiew pop-up menu appears, and slide down that list
until you highlight the "a s Buttons" option:

This window lets you

set

the way icons behave within

a window. We normally keep
large icons, and don't
automatically arrange

11. When you make this selection, the folders inside the Project Folder will

them to an invisible grid.

appear as buttons -just like the ones we used to select how to use the

Try changing a folder's view

Help system (remember?).

to ae leone, and messing
around with these settings.

0

218

Project Folder
311ems, 1.4GB eveileble

~

Copv f11e•

~
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~
Graphic•

~

~

Artboard•

.r;-

:-;
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12. Try opening one of the folders. Now you don't have to double-click; a
button only needs to be clicked once:

If you've ever used a
Windows-based machine
(the Microsoft kind), you're
probably familiar with the
Minimize command. This
command reduces a window

to a small button at the
bottom of the Windows
desktop. That's basically

13. When you're done, Close all the windows again.

what Windows as Pop-ups

does to a Macintosh
window.

WINDows AS PoP-UP MENus

As we've already stated, there will be times when your monitor is so filled with

folders that you can't find the forest (an important file) for the trees (jillions of
folders opened and all over the desktop). There's a third way to view folders
and their contents: it's called a Pop-up View.
We've used pop-up menus already; that's how we accessed the View menu in
one of our exercises (by holding down the Control key and clicking in the
window). This is a different sort of pop-up, though. It takes the active window
and collapes it into a button that sits at the bottom of your monitor. You click
the button and the folder opens into a tabbed window. Click it again, and it
goes back to the bottom of the monitor and waits patiently until you need it.
That way it's dose at hand, but still out of the way of a busy desktop.
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Turning a Folder into a Pop-up
1. First, double-click your hard drive icon to open it, and double-click the
Project Folder to open it as well:

Ill

Project folder

2. Hold down the Control key, and click inside the window (Control-click).

A pop-up menu will appear. Slide your pointer down to Uiew, then down
to as Pop-up Window:
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3. The window will resize and assume its position in the lower left corner of
your monitor:

This might be a good time

to check out the Label
function. Select a folder
and Control-click:

4. A5 you can see, the Title Bar is no longer in the center of the window.
Indeed, the folder isn't even displaying a conventional window anymore.
The Title Bar is on a "tab" at the left side of the pop-up window. Click on

Slide down and choose
Label: You can then

it:

set a

color and a label from t he
pop-up. Later, when you
learn to use t he built-in
Find command, you can use
these labels as a search
method.

5. Click on it again. Double-dick the Graphics folder and turn it into a popup window by Control-clicking and sliding down to as Pop-up Window .

../ None
Essential
-Hot
In Progress
- Cool
-Personal
- ProJect I
-ProJect2

Now you'll have two "tabs" on the bottom of your monitor:

6. Experiment with your viewing options. You can, for example, have one of
the pop-up windows view as Icons, another view as List, and another view
as Buttons.
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Using the Trash Can
We know people who could best be described as a computer-age pack rat They
have every file, folder, icon, picture, game, saved game, email, and downloaded
file that ever hit their computer's hard disk. At some point they buy more hard
disks, hook them up, and continue building their electronic equivalent of
Idaho's The Worlds Largest Ball ofTwine and Other Useless Stuff museum.
In the real world though (the one you occupy, hopefully), there will be times

when you want to throw something away. It might be a file that's been superceded by another, it might be something you just don't need anymore, or it
might be something you hate -like the stupid game that you paid $60 for and
can't make it out of the very first room of the 12,000-room dungeon.
At times like this, it's fortunate that you have the Trash Can. The Trash can is
your friend. It lets you junk, trash, rip-up, discard, and otherwise get rid of
stuff you don't want anymore. It also lets you discard important stuff that you
need really, really badly (fret not, you can always dig around in there and find it
-at least until the garbage truck comes, so to speak).

Throwing Things Away
1. Open your Project Folder. Make sure the view is set to as Icons and as a
Window. Make three new folders inside. Call them funk, Misc.,

and Stupid

Games:

Cl

copy Files

Cl l:l Cl
J un~

Misc.

Stupid Games

2. Open the Graphics folder. Make sure the view is set to as Icons and as a
Window. Position it so that you can see the contents, and can also see the
three new folders you just made.
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3. Drag the Junl< folder to the Trash can. Just pick up the icon, hold down
the mouse button, and move it over top of the Trash can icon.

4. As soon as you drop the folder in the Trash, the icon changes, so that it
looks just like our garbage can does - filled up and overflowing with
junk, misc., and stupid games:

Want to try something
useless but cool? Controlcl ick on your desktop and
choose Change Desktop
Background:
Help

5. There's another way to throw something into the Trash: by using the
Control-click method. Position your Arrow pointer over the Misc. folder.
Control-click the mouse. Slide down until you highlight Moue to Trash.
Let go of the mouse button. The folder will fly away, landing directly into
the Trash can.

New rotder
VIew
Oeon Up
Arrange
VIew Options_
'

l

From this dialog box, you
can select a different
pattern for your desktop.

We get into this a little
later, so don't waste too
much time here. Just
Get Info
Label
•
ShartnoDIIpllcate
Make Alias

thought you might need a
break:

-D- - f l - ID

,_,

..

IJI .. I JII ,JO C

II

6. OH NO! That Misc. folder contained the latest revision of your next great
novel? The keys to the code of the ages? The latest Martha Stewart directions for making those cool Halloween death masks? Don't fret, little one.
Double-dick the Trash can icon:

a

I;

Tr1Sb1====l~

21toma

~
Junk

~

I

~

Cl
Misc.

f-

....

I•

~~......

7. That's right, you can simply drag either of these folders (or, by digging
into them, something inside one) back to the land of the living. Unless...
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8. Control-click the Trash can icon. Take a look at the pop-up menu that
appears:

Get Info
lllbel

9. Select Empty Trash. The can is empty. At this point, you would need
special utility programs made especially for situations where you did
throw away something critical. They can usually recover trashed files, at
least for a while after you threw them away and emptied the trash. They
are not included with the Macintosh, but have to be purchased from a
third party. Don't ask us why.
10. There's another way to empty the trash, and that's from the regular menu
There are several ways to

bar at the top of the desktop. Drag the Stupid Games folder to the Trash,

recover a file even

and empty the Trash from there. Good riddance to bad rubbish.

Trash Can has

aftert he

been

emptied. There are several
popular Utility programs

Eject

that can recover deleted

Sieep

files. The most popular one

ShutDown

is probably Norton Utilities,
which can be purchased at

:J€E
lrase Dlsi:.-

Restart

11. Create another new folder and call it anything you would like (not literally,
just figuratively). Drag it to the Trash can.

your local computer store.
The program comes with

12. Double-click the Trash can. It opens:

several other critical tools,
including virus protection,
and tools to speed up your
ha rd d rive -

or

recover the

~

litem

ll

Anljlhi llCJ Vou lt lce

contents if the whole thing
crashes and won't restart.

..

~-

13. You could choose to drag this item out of the Trash and back to a folder.
14. You can empty the Trash now.
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In general, you should be very careful before you empty the trash. It can easily
destroy something you didn't mean to discard, because once you choose
empty, it's pretty much over. You can, however, get the trash can to ask you just
one more time if you're sure you want it emptied.

Turning on the Trash Warning
1. Position the pointer over the Trash can. Control-click the icon, and slide

down until you highlight Get Info:

2. A dialog box will appear and provide you some information about the
icon:

-

o :;:;

Trash Info

~

When you start getting

Tr10h

Wllero: On the deskto p

comfortable with the

Cootonte: The Truh I$ empty.

system, you might be
tempted to turn off the

tt.dlfled: Mon. Nov 24, 1997, 10:23 AM

trash waming. We can tell

Oworo

kforo ••Pitt ..

you from per:;onal experience that even the most
jaded operator should leave
this message turned on.
It's one last chance to
check yourself before you

3. See the small box in the lower left corner, in front of the words Warn
before emptying? Click once inside of it. A check mark will appear in the
box, indicated that the option is active. This is a very common interface
item, and it's called a Checkbox. You will see them from time to time when
presented with a choice of something being turned on or off (as is the case
with this warning option):

trash something important
-like a t hree-hundred
page course book that's

!if Warn

before emptying

j ust gone through eighteen
edit cycles. (did we say
that?)
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4. Create two more junk and stupid folders, so you have something to throw
into the trash. Drag them there, and Control-click the icon and choose
Empty Trash. You'll see the warning message you just turned on:

The Tr11sh cont11lns Jltems, which use zero K
of disk SPliCe. Are you sure you w11nt to
remove these Items perm11nently?

This is called an Alert Box,
and you should always pay
at tent ion to them when-

When first learning how to use your system, it's probably not a bad idea to

ever t hey appear -

keep this warning active. Once you're an experienced user, you can turn it off,

they're

usually t rying to tell you

so that if you want to throw something away- no matter how critical it might

something important.

be- you can do it instantly, darn it.

Working with Files

So far, we've explored the Desktop, Menu Bars, and Folders. Now, it's time to
talk about data files. What is a file?
WHAT ARE FILES?

A file is something that's been created from within an application. It contains
data. That data might be words, pictures, sounds, combinations of item s,
tables, numbers -

in short, almost any information that might be important

to you. There are dozens and dozens of different types of files that you will
encounter as a Macintosh user -

particularly in the graphic arts, where file

types are especially important. For now, it's sufficient for you to know that files
contain data.
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Examining a File
1. Open the Project Folder, and then open the Copy Files folder:

E1

Ber ries

[3
Sample fllo •1

-

2. These files were created with a very simple application called SimpleText,
which came with your Macintosh (specifically, it's included with the

SimpleText lets you enter

operating system supplied with your Macintosh). Double-click the one
called Sample File#1. This action - double-clicking on a file - will cause
the application to Open with the document active:

COPY• do some simple
formatting. open certain
types of pictures. and
record sounds. Since it's
provided with your
computer, we're almost
positive it's installed on
your system -

and

therefore it's very likely

,. ~ File Edit Font Size Style

DE

+

ibiik

t

::

Sound

Help

:::----:---4 untltl ed

What is a File?
A file Is a colledlon of text, tables, pictures, sounds, v ideo, or other Information that you have either
CTeated yourself, or received from somewhere else. A flle appeus on your desktop as o.n Icon, or small
picture.
In some cases, jOU might buy information from other people, uls the cue when you purchase ge.mes,
cUp e.rt, sounds, or interactive products, such as educallonal CDs.
In this Ag&inst The Clock course, you will learn how to create files, copy them, throw them away, and
organize them In folders.

that you'll be able to
perform the exercises in
the book.
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3. You'll notice that the document itself is in a window - one that acts the
same way as a folder window. The only difference is that this window
contains data- not files and folders. You can size the window, move it
around the desktop, or close it just like a folder window.
4. When you're done looking at the file, dose it by selecting Close from the
File menu, clicking once in the Close box (at the upper left comer of the
window), or by pressing Command-W.
CREATING FILES

With few exceptions, all of your activities on your Macintosh will result in the
creation of files. Each application creates its own type of file, and under normal
circumstances, these files are directly connected to the application that you
used to create them. This is why double-clicking the file in the last exercise
started up the SirnpleText program (another word for starting up an application is Launching).
At the end of the last exercise, you opened a file, then dosed it. The application,
however, was still running, or active. You can tell this by looking at the menu bar:
r ~

File Edit Font S1zc

Style

Sound

Help

Creating Your First File
1. Choose New from the File menu:
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2. A new docwnent will appear. If you look in the Title Bar, you will see that
it's called Untitled. Enter the following copy (to make blank lines, just hit
the Enter or Return key a few times):
My First File
[type in your own name]
DearMa:
This is the first file I've created on my Macintosh.
The Kid

Although we tried to supply
you with a good collection

of hands-on activities,
don't be afraid to experi-

SAVING A FILE

ment. We do suggest that

At this point, you've entered some text into the file- but the file exists only in
RAM memory. It doesn't reside in a folder somewhere on your hard drive.

you make a copy of any files
you want to mess around
with, so that when you do
try to follow one of these
exercises, the machine acts
the way we say it should.

Saving files is obviously a very important function, and that's what we're going
to do at this point. We just thought it would help if we took a moment and
mentioned that when you save a file, you should always think about where
you're going to save it.

You can copy any file by
holding down the Option key
and dragging it to another
spot- either in the folder
or into another one.

Whenever you're working in an application, the Macintosh is keeping track of
what folder the program was "looking" into the last time you saved something.
If you haven't saved something recently, it's likely that the program will just
save the file in the same folder that the program is stored in.
That's usually the last place you want to save a file. You usually want to save
your files either inside of a folder, or directly on the desktop. Some people
choose to save stuff on the desktop while they're working, and drag the files
into the appropriate folder before they quit for the day. We think files should
always be saved into folders, but either method works.
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Saving a file
1. Choose Saue from the File menu:

r ~

0

-My

llllml Edit
New
Open_

aose

Font
XN

Style

SOUl

xo I
xw

My
[typ

SoveAs-

Dee

Page Setup_
XP
Print...
Print One Copy
Quit

Size
==;

XQ

Thi s Is the f irst file I've er ected on my

r

ITho ll'lt1

2. When you do, you will see something called the Save Dialog Box. Almost
every program you will ever use has one, and although some have features
that others don't (depending on the exact application), they all work
exactly the same way.

Thl& pop-up &hows you the content& of ...1.-t!~~~ioiiol..-r.~
the current folder
A llet of Item& In the current window

Shows you the current drive. If you
have more than one you can click here.
L.!!!!!!!IIIIH- Take& you to the De&ktop
WoL~I-f-Createe a New Folder
~.....==:~~~~..-r-

Cancel& the Save action

3. By clicking the pop-up menu, double-clicking the names of folders, or by
clicking a folder and using the Open button, you can explore your hard
drive (also called Navigating) until you find the folder where you want to
save your file. Alternatively, you can choose to click the Deslctop button
and save the file there.
4. Type the name of your file (My First File) in the region reserved for the
file's name. Click the Saue button and save the file inside the Copy Files
folder, which is inside of the Proj ect Folder that you created earlier.
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[Cl Copy Ales ~ I

J

BPrrot•\

;J \d rllplp rrle #I
[ Desktop

[ Cl

New

Save this document as:

A Stationary Document is
one that is specially locked

by the Macintosh. You can
tell

5. After you click the Saue button, the file will be written onto your hard
disk, safe from (almost) anything.

a stationary document

6. Once you've saved the file, choose Close from the File menu.

by its icon:

EJ

S.mple ftle • 1

7. Note the upper right corner of your desktop's menu bar:

A stationary file opens
automatically into an
untitled window, protecting
the original from change.
That way, when you open
one and make changes,
you're forced

8. See the little icon in the very corner? Click on it:

to save it

under a different name

Tue 8:02AM
Hide SimpleText
Hide Others
Show All

than the original.

-- - - -

IIQ Rnder
SlmpleText

SimpleText, as well as
certain other applications,
allows you the option of
saving a file as a Station-

9. This portion of the menu bar is called the Application Picker. It lets you
switch back and forth between programs when you have more than one
running at once.

ary document . Another way
is to change the
document 's attributes
under the Get Info

10. Try using the Hide Others option. It will temporarily hide the desktop.
Same thing when you're running the Finder (which is the Macintosh
operating system).

command, which we discuss
later in the course.

11. When you're done, choose SimpleText from the application picker, and
choose Quit from the File menu to exit the program.
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CHANGING THE NAME OF A FILE

There will be occasions when you'll need to change the name of one or more
files. You can do this directly from the desktop. It works the same way as
changing the name of a folder.

Changing the Name of a File
1. Open your Project Folder, then Open the Copy Files folder.

2. Highlight the file you just created:

31tomo, 1.5GB ove11eblo

Q~
El

.L

Semple file "'1

3. Put the Arrow cursor inside the name. Wait a moment, and a box will
appear around the name. Type a new name for the file: Sample File #2:

1'2'1
D

Berries

f3

Semple File "' I

4. Hit the Enter key or click anywhere else on the window or desktop. The
file will be renamed.
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COPYING FILES

There are numerous cases where you will need to make copies of files. A very
simple and basic example would be where you wanted to make a backup copy
of a file onto a floppy, or into another folder somewhere on your system.
You can make copies quite easily on the Macintosh. There are several ways to
accomplish this basic function.

Making a Copy ofa File
1. Click once on the file you just renamed (Sample File #2).

2. While the file is selected (highlighted), go to the File menu and choose
Duplicate:

3. The file will be duplicated and named Sample File #2 Copy.
0

CopyAies i"

y

._

~ 08

411omo, 1.5 GB avo11oblo

a

Berries

~

Semple File "'2 co py

EJ

Semple rn o "'1
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4. Drag the copy to the Trash (and empty it if you would like).
5. Click on the Sample File #2 file again. This time we're going to copy it to

the desktop. Hold down the Option key and drag the file outside the

foldertothe ~p.

ca(l'f

fu8_,.-'ffJOISK

\·.Ji r-J\..OV.

Ia~ I

,,

-s'f-

( ~l.'-''!'Y)
6. You will see a graphic appear. It's called a Progress Bar:

This graphic is called a
Progress Bar, and acts as
a t ime indicator for slower
processes. The faster your
comput er, the faster the

:;;-"'

~ Copyto"Copyflles" ~ 13

Items remaining to be copied:

292

~
I> Ttme rematntno:

bar moves. That's why
people always want t he

fastest, biggest, baddest
machine on t he block that they won't have to
look at t hese bars too
much.

so

You should notice that the visual we used here shows almost 300 files
being copied. We used a large folder to make this picture so that we would
have time to capture and discuss the function of the Progress Bar. With a
tiny file like the one you're working with, the bar appears and disappears
very quickly.
If you're copying a large file, or group of files, you can click the arrow to
the left of the Time remaining text (at the bottom of the bar) and the
window will expand to show you the time required to complete the
process:
Copy to "Copy Flies" us#'·· ·'2'1 8
Items remaining to be copied:

292

~==========~ ~

v Ttma remat ntno:
Cop vi no:

B~

Pert One

from: Desktop
To: topv flies
Bvt.. Copied: 2.6 MB of 30.4MB

7. Once you've dragged the file to the desktop, there will be two different
copies of the file; one inside the folder (the original document), and
another one on the desktop:
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Get Info
1. With the file highlighted, select Get Info from the File menu. An information window will open:

0

!!'6-·

B

, Sample

Ale 412 Info

=--

8

Semple file •2

Kl.,.: SimpleText text document
Size: 1 29K on disk ( 462 b~t..)
Wllero: MeeHD:Projecl folder:Cop~ fll ..:

Cnated: Mon, Nov 24, 1997, 1:24PM
Modified: Mon, Nov 24, 1997, 1:24PM
Yenloo: n/e

co.. mnta:

D Locted

-

If you check "Locked" in the

0

Stot1oaerg Pl<l

2. Notice the Comments box. You can enter info about the file or any comments you feel are pertinent, and they will be stored with the file.
3. When you're done looking at it, you can put it away by clicking in the

Info dialog, the file can't be

Close box in the upper left corner of the window.

thrown away, at least not
so easily. Try locking one of

the Sample Files, dragging
it to the trash, and then
emptying the trash. You'll
see a dialog box appear:
-

\.1'

Tlllelrbttu••otM.,_,uM, ..IH&Utallef
tMiteMSifllt(diN.._fDIMt'I)Anl

Mad, to llltltte lttttllllttmi,IIOtf 410Wit
UltOpaelttlly..,....le.,.•cMestOitltv
Trask.

As the message says, you
can choose to delete a

locked file. Make sure you
take that file out of the
Trash and don't delete it.
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Finding Stuff

"Now where did I put that file? I know that I had it on the desktop!"

Although the Macintosh
operating system has a

If you use a computer long enough, you're bound to say these words. And
worse. Nothing is more frustrating than losing a file. You know it's there
somewhere, but you just cannot find it. You click, double-click, look through
lists of files, and slowly get increasingly frustrated.

pretty solid "find" capabilit y built in (as you'll see in
this section), it's no
substit ute for really good
and structured organizat ion. We

Fortunately, the people who write computer operating systems know what a
problem this can be. They are constantly losing stuff themselves, and at some
point decided to build tools for finding troublesome, lost files.
The function is called finding.

mentioned
before

Getting Ready

that the
way

1. Open your Project Folder.

someone
keeps their desk in real life

2. Create a folder called "Folder Lessons":

will probably reflect how
they'll keep their computer
desktop. We just want

to

0 1£

say that wit h a computer,
it's even easier to lose

tl

Cop~

something than it is in the
real world -

-~-:::;~ 09

mea

ll

Graphics

ll

~

Art boards

.5..

unless of

course you have

Project Folder
4 ttema, 1.6GB available

a demon

dog like we do, who routinely
chews up important

t

1~

.
0-

documents. Unless you end
up with

a really faulty and

sick hard drive, this
probably won't happen on

3. Put the three folders that we've been using (Copy Files, Graphics, and
Art boards ) into it. You should have only one folder showing, the Folder
Lessons folder that you just created.

your Macintosh.
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4. Open the SF-Basic Macintosh Operations folder on the CD-ROM that
came with the book Drag the Finding Stuff folder into your Project
Folder:

0

1:!]8

Project Folder

.

Z lterN, 1.6GBevetleble

t:l

folder Le..ons

ll

ftndl119 Stuff

~

4

~

-0-

5. Open the folder, and Control-click the window, setting the view to as List.

Click the arrows to the left of the folder names to open them into the list
view:

0

· --

1:!]8

Anding Stutl
81tems, 1.6GB avotleble

r;~~<li
v
Bl9 files

Cl

J:

@ Brends 2 Article
v

Cl Her r1eon ProJact

I

Dete Modified
I 0:44AM

Tode~ ,
Toda~ .

@ Brends Text ftlo
~Moen Boss.Tif

Tode~,

Cl Llt1le ftles
IEJ Mean Boss.Tif

I

.

I 0:44 AM

Toda~ , I 0:43AM
Mon, Nov 10, 1997, 2:18AM
Tode~ , I 0:43AM

~ Brtnds Article

v

i~~;_~~:.tl

Tode~,

9:58AM
I 0:37AM

Tode~ ,

I 0:37AM

~

• Lil!!J

• '1-

6. As you can see, this set of folders contains several files with the same
names, some with different modification dates, and some with different
sizes. This is the typical kind of mess that occurs when you're working on
a dozen things at once.
7. Close the folder by pressing Command-W or by clicking in the Close box

in the upper hand corner of the window.
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FINDING BY NAME

By far the most common method you will use to find files is by searching for
their name. Usually you know what you called a file. You might not remember
exactly what you called it, but you know about what you called it. This is
normally enough to find what you're looking for.

Using the Find Tools
1. Close all the windows on your desktop.
2.

Press Comrnand-F, or use the Find function on the File menu:

Edit View Sper
New Folder
8SN
Open
880
Print
iliP
Move To rrash ~(g)
aose Window 8SW

Get Info
Lobel
Sharing_
Duplicate
Milke Alias
PutAway

-

Everyone ha5 their own
per5onal favorite way5 to

Kl
~

KD
8SM
iliY

Show Original X R
Poge Setup_
Print Window-

3. The Find File dialog window- the first of two parts of the Find toolswill appear:

5earch for 5tuff, but
without a doubt, the
ea5ie5t and (u5ually) mo5t

effective 15 by knowing
5o me part of the name of
the file.
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DE
And Items

'

:

:

4Flnd Ale

I on local disks

j1name

I More Choices I

1~

~I Whose

II contains
Find

I
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4. There is a blank box where you can enter your criteria. Type in the word
"Brands" and click the Find button. The second of the two tools will
appear. This one is called I tems Found:

I)

0 -

#

••

•••
D a..
D

Lut Modifltd

129K MS 'w'ord 6 doctmtnt

iOds ArtieIt
Br...ts Ttxt flit

1218

Items Found
Slzt Kind

!Y!n!.

129K

MSWord6doc~t

129K MS '!lord 6 docl.mont

11/ 2:1/ 97
11/10/97
11 /2:1/97

10 :44 AM ....

2 :19...,.,
10 :43...,.,

~
c

~

H1d i0

~
'"---

eg Projf-ct Foldtr
eil Findin9 Stuff
eil 9i<) filos

.
~

Foood 3 lttms

5. As you can see, the function has found three different files with the word
Brand somewhere inside it. The first item is highlighted, and in the
bottom portion of the window, you can see that it is inside the Big Files
folder, which is inside of the Finding Stuff folder, which is inside the
Project Fol der, which is on your hard disk. Simple, right? While this may
sound complex, seeing the hierarchy visually in the window makes it
pretty easy to understand. Click once on the second item in the list. Its
location will be displayed in the bottom portion of the window:
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This view is a very powerful
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tool, because you can
actually drag stuff from
her~ to the desktop, ma ke

aliases (a pointer file t hat
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eil f indin9 s tuff
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D Br.ands: Art icl•
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you'll learn about lat er),
a nd copy files. You can also
open t he folder in which a
specific file happens to be.
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6. The Brands Article, the one you were looking for, is inside the Harrison
Project folder. You can automatically open the folder

this item is in by

choosing Ope n Enclosing Folder from the File menu or by pressing
Command-£ (for Enclosing):

1291< MS\10f'd6-t

11 / 10/97

1291< 11SIIOf'd66ocl.mtnt

111~191

Don't forget that you might
see file names or stuff in

the background here in the
course that could be

different from what your
system shows. No two

0

Hamson Project

systems are set up exactly

alike. We tried to minimize

1:!18

31tems, 1.6GB available

~.

Mean Bon.TI f

this happening, but we're

-L

~

.

Brand> Text file

sure we didn't catch every
instance.

~

I

.
_1• -?.·

7. At this point, you could drag the file to where it should have been in the
first place (before you lost it). You don't have to move this file - we're
trying to visualize here.
8. Close all the windows. You can leave the Find windows open for the next
exercise.
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OTHER FIN D METHODS

There will be times when simply knowing the name (or part of a name) will
not be enough to find the specific file you're looking for. In these cases, there
are several other methods of finding files.
The first thing to notice is that when the Find command locates a list of files
that match your criteria, the view within the 1terns Found window gives you
some insight into the differences between items in the list.
Let's say, for example, that you had two pictures of your mean, whip-wielding
boss. One (the original) was black and white. For publishing in the company
newsletter, though, you wanted a color version. So you took your painting
program, colored the original, and saved it into a different folder.
You know that the colored file must be bigger, since it contains color data,
where as the original was only black and white. You know the name of the file
is Mean Boss.

More Finds
1. Press Command-F to access the Find command. If it's already o n your

desktop from the last exercise, type in the name Mean Boss and click the
Find button:

0

,;,•= · ·~~" ·:;,~·=

Find Ite ms

_

I on local disks

I' -n am
e
~ II contains
-- -- ' - '

I More Choices J
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2. When you click the Find button, you'll see that indeed, there are two
copies of the same file. But notice that the size of the file is displayed, as is
the last time the file was modified:
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Found 2 lltnu
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3. At this point you could see that the larger file - and the one that was
modified last- is the one in the Harr ison Project folder.
4. You can put the Find windows away. Either click in the Close box for each
file (upper left corner of the window) or press Command-Q to quit the
program.
USING OTHER SEARCH CRITERIA

The Find command that comes with your Macintosh is a relatively powerful
search command, providing several methods of locating information on your
system and connected disks.
You can expand your searches in many ways.

Expanding the Search Command
1. Press Command-F to access the Find command. When it appears, click on
the pop-up menu that currently says contains:
0

8

find file

~I whose

find Items [ on local disks

~I .; contaons

[ name
[ More Choices

I

I

!Mean Boss

starts with
ends with
Is
Is not
doesn't contain

fi nd

II
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2. As you can see, there are several different ways you can use the name
search. You might want an exact match, for example, or you might need to
exclude certain letters or numbers from your search. You could find things
that end with or begin with certain characters, or look for files that don't
contain certain text.
3. Click on the More Choices button. The window will begin to expand to
make room for the Size find option. You can see there's a pop-up menu
there that lets you look for a size smaller than or larger than a specified
SIZe:

-

¥¥¥!

I ~ I wllose

1 ~. :n:.::a:.:.:m=..e
1 _ _ _. . .;~:. . ~l ._c_o. .;. nt_,al-'ns;. . __ _~'-'JI~Kl l

here that we've never ue;ed

I ~INLJMI.bil
-=I ========
.~ J
II

l1s1ze .

in the ten yeare; we've been

Is greater than
Fewer Choices

More Choices

working on the e;ye;tem.

won't be the moe;t impor-

SiS!i:f¥ And nte ·

Find Items I on local disks

There are e;earch criteria

That'e; not to e;ay they

"•

· -.
II Find .I

4. Open all the Choices by continuing to click More Choices:

tant to you. though. Who
knowe; when you might
dee;perately need to find a
locked file, or an empty
folder.

*S#.oa

fJ

tzZF

Find File ~.

Find Items I on local disks

;.---;;---;?

i8

1~) wllose

I name
I size
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I ~ Ills

ll None
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I date created
I date modlfted
I version
I comments
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I ~I

I folder attribute
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~
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I
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5. Take note of two important search methods that you just uncovered.
These are the dat e created and dat e modified. Click on either of these
date-related pop-up menus and look at your choices:
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I
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size

Modified searches will
prove very important if
you're in the graphic arts
industry, when you're often
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Find
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I

faced with picking from two

or two thousand files with

6. As you can see, you have a broad range of date-related searches. Trust us

similar names. How many

when we say that this method - the "I know I did that work last Thursday

different ways can you

or Friday" search -will come in handy as you become more experienced
on your system.

name a file that has a
picture of a man on a
beach, or a dog in a car?

The second search criteria you should take note of is the comments selection.
Earlier, you learned how to "Get Info" for a file (click the file and press Com mand-! or Control-click the icon and select Get Inf o). In the Inf o dialog box is
a Comments field. You can use this search method to look through those
comments and display any files that contain (or don't contain) specific information.

PAGE80

CHAPTER 2: USING THE MACINTOSH

Customizing the Find Dialog Box
1. Click the Fewer Choices button until only two search criteria are showing
(name and size):
DC

-

':1 8

~ J whose

Find Items I on local disks
1'-'n-'a-'m.:;..e----'~..JI I contains
1

, ~ I Its less than

I size

I More Choices )I Fewer Choices J

n

And

2. Name is important, so we'll leave that as the first search method. The next
most important method is, let's say, date modified. Click the Size button
and use the pop-up list to put date modified next in the window:
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3. Click the More Choices button, then click the Size button (it's moved"
down the list) and replace it with comments and contain:

0 =

Find File
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I name
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II

~

Now, whenever you access the Find command, these three criteria will be the
first in the list. You can, naturally, customize the command to fit your needs.
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Formatting Text
When the Macintosh first came out, it was the first popular, mass-produced
computer that gave its users the ability to change typefaces. It was that functionality, more than any other - including icons, the mouse, and other
innovations -

that led to the desktop publishing revolution. The way the

Macintosh handled text (also called fonts) and graphics brought real computer
power to designers, publishers, artists, and other people in the graphics industry.
While this isn't a course on graphic design (there are over 20 such books in the
Prentice Hall!Against The Clock library), it is important that you know the
basics of formatting text elements in a document.
Almost all Macintosh programs allow you the opportunity to select text, and
apply characteristics to that text. For example, there's italics, which you've seen
throughout this book (and many others); there's also bold text, which is darker
than the text around it. And let's not forget outlli:me text, Sh adow text, superscript (Xl) and subscript (H20), underlined, strikcthtongh, and something
called SMALL CAPs.
How APPLICATIONS HANDLE TExT FoRMATTING

Almost all applications on the Macintosh allow you to change and manage
type styles -

some with more precision than others. Applications designed for

the graphic arts, for example, are more likely to provide you with tools to really
fine-tune the appearance of type- both on screen as well as in printed
This artwork was done in

output. With these tools you can do some really neat stuff with type.

Adobe Illustrator, one of
our absolute favorite
programs. Oops! We said we
wouldn't tell you what our

Something Fishy

favorites were, for fear of

Oh well. it's too late now.

Other programs, such as accounting or bookkeeping programs, statistical
analysis programs, and applications that are more concerned with the accuracy

"Jury, disregard t hat last

of data than they are with the appearance of type, may provide you with less

statement!"

control over type. If you're in the graphic arts industry, though, it's likely that
you will be working ·with page layout and illustration software that will let you

improperly endorsing them.

accomplish almost anything when working with type.
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Working with Text
1. Find the file called "Formatting Text." Double-click the document. This

will launch the SimpleText program that we used earlier.
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2. When you move the cursor into the area of the type, it will turn into a
small "I" beam. Use the I-beam to "paint" the first line: Moby Dick. It will
become highlighted (much the same way that the titles of folders or icons
become highlighted when you click on them):

·r

a

1:'1_

Ale Edit Font Slz8. Style Sound o:;;;
HI!;;:
Ip~-~
"" _...,_ fOMIIIotllng Text L
;;;;'1!!1 il

e novel

Herman Melvt lle

Filled with alegory end symbolism. th is classic story of gooa eno

evil unfolds emong the whaler communi ty In the 1600's. The
great white whale. Moby Olck, Is pursued by the obsessive end
cruel Ceptein Aheb. In a prior bettie with the levlethen, Aheb hed
lost e leg, and meny sey, his mind
Aboerd the Pequod, Ahob end his men chase the beast ecross the
world's oc eans, unttl they r1ne11y meet htm - - end their

In case you're wondering

combi ned destinies -- In • fin& I, brulOI betti e of will.

why this window is smaller
than t he one you're

determinotlon, ond obsession

1 A Book of t he Month Club Selec tion
'

probably looking at, it 's
because we resized it so
that t he screen capture
wouldn't be a million
jigabytes.
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3. Go to the Font menu. Click on it and move the mouse down the list until
the font name Palatino is selected. Click on it. (Your font menu will
probably look different than ours. We have hundreds of fonts on our
systems since we publish books):

Size Style Sound Help
Palatlno
Poplar
R Frutiger Roman
Shelley Allegro Script
Shelley Andante Script
Shelley Volante Script
Symbol
Tekton
Tekton 6old
Tekton 6oldObllque
Tekton Oblique
Zapf Otancery
ZapfDingbats

4. The words "Moby Dick" will now be in a different type face: Palatino:
r
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File Edit Font Size Style Sound Help

i"li!!'i =~~ Formatting Text "' ,

-=', ..,... ~ 8

a novel

Hennen Melville

5. With the text still selected, go to the Size menu, and select 24 points.
When you do, the title will become considerably larger than it was:
Points are a measurement
r ~ File Edit Font Size Style Sound Help
0 ~'=. c::¥'ftj Formatting Text ~g~::h¥\'it¥:-:i##©iii ~ 8

used for type size. A point
is exactly 1/72 of an inch.

Mob

l )ick

e novel
Hermon Melville

6. Now make the title bold using the Style menu. Bold type is slightly darker
than normal type, providing a means of making something stand out
from the rest of the text:
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File Edit Font Size Style Sound Help
Formatting Text

Filled w1th el egory ond aymbolttm, this clesslc story
of good end evil unfolds among the whol ar community
In the 1600 's . The greet white whal e, Hoby Dick, ts
pursued by the obse ssive ond cruel Coptotn Ahob. In e
prior bottle with the levl ethen, Aheb hed lost e leg.
end meny soy, his mind.
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7. Highlight the words "a novel." Using the menus, select 10 point, helvetica

and make the words italic:
,. .j File Edit Font Size Style Sound Help
El :. ~::; ._; . . :. ~:::;··,c~L~~-~-"'~ Formatting Text ::;.~";~
-~ ~-· E!IB

Moby Dick

I

anov11l

0i

II

8. Look at the changes that we've made to the document. One hint: we

changed all the text below the "a novel" to Times, and played around with
the sizes a bit. We also italicized some of the words within the text itself.

JMI®lb)Y

IP)~w!k

a novel

. Herman Melville
Filled with alegory and symbolism, this classic story of good and evil
unfolds among the whaler corrunwlity in the 1800's. The great white
whale, M?lty Dic.l; is pursued by the obsessive and cruel Captain Ahab.
In a prior battle with the leviathan, Ahab had lost a leg, and many say,
his mind.
Aboard the PeqtA?C( Ahab and his men chase the beast across the
world's oceans, until they finally meet him-- and their combined
destinies -- in a final, brutal battle of will, determination, and
obsession.
A Book of 1he Month Club Selection
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9. See if you can make your document look like this one. When you're done,
select Saue Rs from the File menu and give the document a name that
you'll remember:

I('l Working with Copy I ~ )
~ ~J FOI'Inlltl.lng l i"..Xt

e

t.lacll)

[

EJeCt

)

I Desktop I
I t:i New I

Seve this document es:

LlMy_:__fo_nn_e_ttl;_n~:!.___ _ __.l

~

El EJ
0

10. You can keep the document open if you want, or close it We suggest that
you put it in the Copy Files folder.
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Printine
As we've seen so far during the course, the Macintosh is quite adept at display-

Although the Macintosh is
certainly respected in the
internet, interactive, video,
and animation industries, it
is in the printing business

ing your work on the screen. When you begin to work with various commercial tools, either at school or at work, you will see programs doing amazing
things: creating the most complex artwork and page designs imaginable. You
can create almost any artistic vision or design using the system. What once
took airbrushes, cameras, paints, markers, razor blades, tape, and a myriad of
hand-skills can now be executed on a Macintosh without leaving your desk.
Although this can certainly be a bad thing, it also means that an artist can
apply their talent to a project with a minimum of distractions.

that the Macintosh has its
strongest hold and most
loyal supporters.

Displaying your work on a monitor, however, is only half the battle. The other
half is putting your work on paper. And that's where printing comes in.

How Application5 Print

With the possible exception of some game software, all commercial applications on the Macintosh can print what you see on the screen. The ability of the
computer to show you what you've "got" on screen is called WYSIWYG, or
"wizzy-wig" - "What You See Is What You Get."
Don't let us give you the
impression that the
Macintosh can in any way
replace talent. The
software tools used by
professional artists are
just that- tools. Being a

Printing stuff on a Macintosh is very easy. That's not to say you will not encounter problems- you will, we can assure you. Complex documents created
with sophisticated imaging, illustration, and page layout software will sometimes cause you sleepless nights when they absolutely refuse to cooperate at
printing time. But for the most part, printing is the same, and simple to
perform.

good designer takes a lot
more than good tools. It
takes talent, vision,
experience, training, and a
productive and supportive
working environment.

CHAPTER 2: USING THE MACINTOSH

PAGE87

THE SYSTEM

There are three different components that come into play whenever you want
to print your work on a Macintosh:

As people who do a lot of
printing, we wanted to say
that the entire issue of

The Application. The first thing that is usually involved in a printing
event is the application program that you used to create the file. We say
"usually" because you can print directly from the desktop (or finder).
This is a useful technique when you need a hard copy of a folder's
contents.

print drivers, PostScript
Printer Description (PPD)
files, and output in general
is an area that no one
understands fully. You will
have problems printing

The second component of the process is called a Printer Driver. A
printer driver describes a specific type of printer. To pick a printer
driver, we use a program called Chooser, which is under the Apple
Menu. You will see this program in a moment. Another word for a
printer driver is a PPD, or PostScript Printer Description file.

documents that should
print just fine -

no big

graphics, no complex
illustrations, no weird

content at all. Other times
documents that have all
kinds of screwy stuff in
them will print in moments.
If you really figure it all out,

The third component of the printing cycle is the actual printer to
which you send your work. There are many different types of printers
in the Macintosh world. The two most popular are dot matrix printers
and laser printers. If your work is destined for high-end commercial
printing, you will also learn about devices called Imagesetters or
Platesetters, which are a lot like laser printers but with the ability to
output very small dots. The smaller the dots, the higher the resolution
of the device is said to be.

call us and let us know.
Right now we're tl)'ing

to

THE CHOOSER

output this file, so we
gotta go.

Chooser is a specialized application located in the Apple Menu (the small
multi-colored apple in the upper left comer of your menu bar).

_eApple System .,;Qnler
e)AppleCDAudlo Player
Automllted Testes
Clllculotor

Cl

I

" Control Ponels
.AndAle

• Graphing calculator

IH Jlvsow PUzzle
fil Key Cops
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Early in the course, we told you that the System Folder contained special files
and applications used by the Operating System to run your Macintosh and to
provide services such as printing. Within the System Folder is a folder called
Extensions. When you (or the people at the store) first set up your Macintosh,
certain types of extensions (small files) that represent different printers are
placed into this extensions folder. These appear in the left side of the Chooser
window. You can remove these extensions if you want, and have less printer
icons appear in the Chooser window.
If you click on a specific printer icon (on the left side of the window), any such
printers connected to your system will appear on the right side. If several
printers are listed in this window, you should click on the name of the one that
will be used for the current print job.

Lists the devices available on your system
I

.~

.........

t!

CWSV2000

e!ll,

-""""
.L

t;l

...

come into

-.

~----

- -.-. -1:!,

C•W$>/1,.,

.,

eli
""'sv,..

The name
of the device
appears here
once you click
on it.

Ln•rV,...lOOIL$

Creates a PPD {driver)
for a new, unlisted
device

8

S~lit'rfrltK 1200

The icon that'!? called
AppleShare will

Select e PostScript Printer

•

A leTolt • Acti ve ~
PP

(j 1nect1ve

7.6.0

Allows you to tum Appletalk
(the built-In networking software)
on or off.

play later on when you leam
about networking. It'!? not a
printer- it repre5ent6 the
network that your

com-

puter (might be/i6)
connected to.
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AccEssiNG THE CHoosER

When you click on a printer icon in the left side of the Chooser (a), the
window they are in takes on a black outline.
The name of the device appears in the window on the right side (b.). When
you click on the name to select it, that window takes on the black outline (c.).

/
C.WfN ISIJl

Cob SW2500
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Color SVPro
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Select a PostScnpt Pnnter:
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.

types of printers are put
onto your machine. You
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software, many different
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When you first install your

a.

ApplaTalk

e Activa

Q lnectl\'e

7.6.0

can

c.

go into the Extensions
folder (inside of your
system folder) and find
these names. If you take
them out of there, they

~

nu.Yrlttt
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L• Hn'nttr 300/LS

tS

won't show up in the

St11lt.,....tt.,. 1200

Chooser window.
..

AppleTol k

e Actlvo
Q lnoclive

7.6.0

Settine Up Your Printer

If your printer does not correspond with any of the default icons that are
resident in the left side of the Choose r, check with the documentation that
comes with your printer to see if a Chooser Extension is available. In most
cases, a floppy disk comes with the printer that contains the extension. The
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extension is put into the System->EHtensions folder, then the computer is
restarted.
Your printer's icon should then be in the Chooser when it is accessed.
Because your printer is a newcomer, it needs to be setup. The button underIn this section, we t alk

neath the PostScript Printer selection window will say either Setup or Create.

about S pooling, or making

This button allows you to create a new printer driver for your printer.

something print while you're
doing something else. This
process is also called

Create- If the button says Create, it will read your printer's specifica-

tions and create a configuration to match its requirements.

Background printing, since
it occurs in the "back-

.

ground" while you're doing
something else.

I

~x-

o\j>pltS!Iiro

~

COlor SV I :lOO

~

Color S\tl Pro

~

l u or'tt'rtlor 300/lS

COlorS'tf~OO

1fn>9o'o'rtlor

_a

Q

...

Select a PostScript Printer.
.PiriOIIII
Nt

...

~
~

a

....

Stylt'o'r ltor 1200

~~ ~...

Setup -

1!1

~ Oiooser~

AppleTalk

I

~ Acl1ve
() Inactive

7.6.0

If the button says Setup, it will take you to a window with

several options for you to choose from to setup your printer.

Current Printer Description Ale (PPO) Selected:
"LoserWrlter II N1"'

k

Aiitii Sitiij

SelertPPD.:

...,-ntir Info

contlgure

Help

!C C.n.:erJ

I

I

Ruto Setup -

reads your printer's requirements and sets up a PPD.

Select PPD -

goes to the PostScript Printer Description (PPD) window

to allow you to manually select the appropriate PPD for your printer.

C HAPTER 2: USING THE MACINTOSH

PAGE91

Select a PostScript~ Printer Description file:

Ict Printer Descriptions I ~)

kt laserWrlter 4 / 600 PS

6 Snooty
...

D.taserWrlter Color 121600 PS
D.taserWriter Color 121600 p_
D. taserWrlter Color 121660 PS
taserWiiter II NT
D.taserWrlter II NTX
D.t11serWriter II NTX v50.5
D.taserWrlter II NTX v51.8
IDtuerWrlter II NTX-J v50.5

EJect
Oe.slclop

a

Generic

I

cancel

If

Select

I

Printer Model:
Apple l llserWrlter II NT v47.D

Printer Info- reads your printer and shows you the specifications.

~

Current Printer Description File (PPO) Selected:
• taserWrlter II NT"

Printer lnfonnatlon:

Printer Name: Personal LaserWriter NT
Zone: •
Product Name: Laser-Writer Personal NT
PostScript'H Level: 1
PostScript"' Version: 51.6
PostScrtpt•H Revisi on: 1
Update Info

I I!

OK

I

Each of the three ports on
your Macintosh has a
different icon. Look on the

Configure- sets up those printers which can be programmed to

receive configuring software that can customize its settings.

back of your machine, where
the cables are plugged in,
THE OUTPUT PoRTs

and take a look.

There are three ports in the back of your Macintosh computer that correspond
to the needs of your particular printer.
Printer port
Serial port
Modem port
The Printer port is the most commonly used port for printers. But some
printers, such as those of IBM configuration, require the Serial port for connection.
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If you have a Fax/Modem connected to your computer, it will need to be
connected to the Modem port.
Here are some examples of what options are available for some of the default
icons that come with the computer. The LaserWriter 300/LS asks for the Serial
port.

®

...

ColarSYiliOO

Conn11ct to·
8 <Sertol Port>
Cl6 <Sertol Port>

lit

ColorSYPro

The Color SW 1500 asks for the Printer or Modem port. Some color printers
require that AppleTalk be turned off to work on the Printer port. Be aware.

.L

...

Connect to·
lleiPrtnter Port
IIIIModem Port

~

ColorSYPro

The AppleShare icon is for networking and sharing with other connected
computers. The right side window, where printer names appear, is where the
names of Servers will appear to choose from. When you click the Server IP
Address button, a window to enter the Server's Address appears.
~

..

Selact 11 file server:
'

ColorSY lliOO

sa

Enter the Se~r~d~ss:

ColarSYPro

& ~:.;;~~~~~"~~';IPI~
.I Cdncet)·'i!~Olldtett II
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Using the Chooser

•

1. Go to the Rpple Menu in the m enu bar and scroll down to launch the
Chooser. Make sure that your printer is connected and online.

2. In the left side of the Chooser window, click on each of the icons to see
what appears in the right window.
3. Click on the items that are in the right window. Make no further selections, other than to click Cancel in the warning windows that appear. You
do not want AppleTalk to be altered unless you know that a printer needs
it turned off.
4. Click on the icon of your own printer that is on the left side of the
Chooser window.

5. When the name appears in the right side window, double-click on the
name. This will bring up the Setup dialog box.

current Printer Description File (PPO) Selected:
" LoserWrlter II NT"
Auto Setup

SelectPPO-

Help

Prlnte_r Info

Configure

Cancel

OK

I

6. Click on the Select PPD... button. You will be taken to the PostScript
Printer Description window. Scroll through the various PPDs to view
what is available. Click Cancel.
7. Click the Printer Info button. View the information about your printer.
Click OK.
8. Click the Configure button. You will probably see a warning of No
lnstallable Options. Click OK.
9. Back in the Setup window, click Cancel. In the Chooser window, click the
upper left button to close the Chooser.
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Desktop Printer Icons
In order for your Macintosh to print, you have to select a printer and ensure

that you have the proper driver. Whenever you use the Create or Setup button,
the Operating System sets up a special file on your desktop that's called (appropriately) a desktop printer icon.
On the system we've used to write this course, we have several printers. Here's a
picture of the desktop printer icons for our printers:
You can use the pop-up
menu to change from one
printer to another (Setae

Default Printer). While you
can aloo do this from the

Chooeer, it makes more
sense to have all your
printers on the desktop,

where you can access them
and change them with the

You will notice that one of the two icons (the one for our HP Laserjet 5) has a
dark outline around it. That's because it is the selected printer. Once you've
used the Chooser to setup one of your printers, you can then change printers
by Control-clicking the printer's desktop icon. You can also control print jobs
from here as well:

Control-click option.

Spooling
As you can see, you can access the Help menu from this pop-up menu. You can
also start and stop a Queue. A Queue is a list of jobs that are waiting to print.
In the old days of the Macintosh (and most other computers as well), when

you wanted to print something, you clicked the print button, answered a few
questions (like how many copies you wanted, which pages you wanted to print,
etc.), and then waited until the whole job printed. This could take days (well,
maybe not days, but it sure seemed like days when you were sitting there
watching the monitor do nothing).
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Today, a common process called Spooling is used by most computer operating
systems. Spooling refers to the fact that when you print a job, it's sent into a
special container (that's the Queue) and printed from there. In the meantime,
you get your computer back so that you can continue to work (which makes
your boss a happy camper).
To show you a queue, we sent a few chapters of this book to the printer. Once
we did, we double-clicked the LaserJet 5 icon on our desktop. Here's the dialog
box that appears:

This dialog box gives us total control over the jobs being printed. Here's how:
~ If we highlight any job, we can use this button to pause the job, or hold it
until later, when we have the time to print it. This is good in case we want to
send something to the printer, but not have it actually output.

If you pause, or hold a job, it moves back into the list at the bottom of the
dialog box, and shows that it's being held under the Print Time listing:

....

o·

- A5 08

Laser JetS

z tteJM:
Default Printer

JJ ' E]~I!J

I

·-··-··
Nome

@ 2.3-Prtnti i'IQ (print)

4 1111

PAGE96

I

Poges

I

I

eopt..

1

0

No rme1

1

0

Hol d

.

.

• q.
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When you hold one job, the next one moves in to take its place:

[] ~$5

.a . -- "e¥' J LaserJets mn;- ~?ii?'ZI E!J 8
2ttems
Default Pri nter

~~~]~~.:[]

II~

2.3-Pr tnti"'I\ Prlnt/
POQO: I of 1
UM:r: Ellenn Behortem PoiJ"ICic; document: 2.3- Pr1 nt11'19; Stet~.~$ :
preperl"'ldalo

I "- 1 c.ptoo

Ill. .
~

2.2- flndt "'I IO ronto (print)

1

0

.,

.

Hold

..

• '11.1

~

E) This icon lets us restart a job that was on hold. Simply click on the name of
the job being held, click the Go button, and it starts printing again.
~ This clock icon allows us to select a job and specify an exact time at which

we want the output to occur. This is extremely useful in a busy environment,
where certain jobs are better left to the evening so that they don't tie up the
printer during critical times:
liLa:

-## SetPrintnme I

Q Urvent
Q Normal

@> Atnme

!1 21 8197

@ l1t1AM 1$1
I Cancel I !I

OK

I

If we set the print time to Urgent, it will go next- no matter how many jobs
are in the queue. Normal keeps it where it is, and At Time let's us enter the time
at which we want the job to start printing. Pretty cool, if you ask us.
If you have a lot of jobs in the queue, you can also drag them around, moving
them up or down in the list as necessary.

[!] Lastly, we have the old trash can. You can take any job that's in the queue
and drag it to the trash, eliminating it from the queue. When it's trashed, it's
gone, and if you want to output it again later, you'll have to send it to the
printer from the original application.
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Printing a File
1. Open the file that you created in the Formatting section

,. ~lmJI Edlt Font Size Style Sound Help
New
88N yfonnattlng
(]~
Open_.
:180

lw.

Ia:£
aiXJ

ltl!lL
Pille

unto
v
Aha
say,~

aose
'l8W
Save
<l€S
Save As_.

(My formatting).

013
~

~

Page Setup ...
.·: · · m, 1hi3 cwsic stOry of good and evil
Print One Copy iffiunily in the ! BOO's. The great vhl~
Quit

..~- .

88Q

by the obsessive and cruel Captain
leviathen, Ahab h8d lost a leg, end many

Aboanl the Ptytl<fd, Ahab and his men chase the beast across the
vorld 's oceans, un111 they finally meet him -- and their combined
destinies - in a final, brutal battle of 1<'ill, de~nnlnation, and obsession.
A Boolc of tilt Molllk Clu Stlt<tioa

2. Go to the File menu and select Print:

Size Style Sound Help
fonnattlng

~

_HI 13

.Qi!imjliiimJ·~·m, 1hi3 cwsic stOry of good and evil
unity in the 1800's. The great vhi1e
V'Jl81l- - - - - - ' - ' - -l by the obsessive and cruel Captain
Aha
leviathen, Ahab had lost a leg, and many
say, Jrt,orrmiir.---.;;;.;:'-'
Aboo.nl the Avtl<fd, Ahab and his men chase the beast across the
vorld 's oceans, un111 they finally meet him -- and their combined
destinits -- inafinal, brutal battle of viii, de1ennlnation, and obsession.
A Book of t ilt Mollll Clu Stlt<tion
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3. The Print Dialog box will appear:
Printer: "LaserJet 5"
Copies:

I•!

Pages:

8.2. h

«J All

0 From:D To:

Paper Source
@l All

0 First from:

I

'

I

Auto Select

·II
.... Jl
I

D

Destination_
@)Printer
Ortte

II

Print

I

I Cancel I

I Options I
I Help )

4. Click the Print button, and the document will be sent to whichever printer
you've selected in Chooser or from the desktop icon, and shown at the top
of the dialog box.
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Controlling Your Environment
At this point, you're probably getting comfortable with the basics of running
your Macintosh. These basics include creating folders, managing your desktop,
creating files from within a simple application, changing fonts, and printing
your work.
As you become more and more familiar with the basic operations of your
Macintosh, you will increasingly find yourself wanting to customize your
working environment. That's what we're going to explore in this section of the
course.
Using Aliases
Customizing your working
environment is something
that's really a process, not
an event. You'll always be
fine-tuning your system.
When you start working

f

An Alias is a special file - one that occupies almost no space at all on your
hard drive. What it does is point to another file. The file to which the alias
points is called the original, and the alias acts just like that original in every way.
You can put an alias anywhere on your system, and when you double-click it, it
acts exactly as if you had found and double-clicked the original.

with application programs,
like Adobe Illustrator,
Microsoft Word, Photoshop.
QuarkXpress, PageMaker, or
others, you'll find that each

When you start working for real, you'll eventually end up with lots of files, and
many levels of nested folders. To access any program or file on your system will
require double-clicking your way through the maze of folders until you have
found the correct item- the one you need at the moment.

of them also allows you to
modify the way they look,
feel, and act. When
changing

a program's

environment. it's called
changing the Preferences of
the program.
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Here's an example:

3rd Click

Drawing Programs
folder

Throughout t he book we've
t alked about how impor t ant it is to minimize
keystrokes and mouse
clicks. Aliases are an
excellent way to make your

1st Click

Hard Drive Icon

5th (final) Click

system more productive
and faster to use.

Application Icon

2nd Click
Applications
fold er

•

Adobe lll uotrator

1111
8111111.
111111111111111

1111
4th Click

Adobe Illustrator

folder

Nesting items inside of folders is a great technique for organizing your folders,
data files, and applications, but can easily lead to an awful lot of doubleclicking to get where you need to go. In this case, you have to double-click five
different times to launch (another word for start) the Adobe illustrator program. That's a lot of clicking.
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I

'

In this next illustration, we've created an alias of Adobe Illustrator, and placed
it on the desktop. Check out the savings in clicking time:

1st Click
Illusrrmor alias

Alias points directly to the application,
no matter where you might have it located
for organizational reasons

Using an alias allows you to create custom pointers that act just like the original
item, whether it's a folder, a data file created by a program, or a program itself.
In this example, double-clicking the Adobe Illustrator alias on the desktop
immediately starts up the application -saving four double-clicks.

The alias keeps the same icon as the original, but italicizes the name text for
quick identification.

tl

Ne'W Folder
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Here are some rules and guidelines for using the alias concept

An alias can be duplicated many times, and each copy, regardless of
where it's placed, relates to the original.
An alias can be Trashed without hurting the original. And if the original is a folder, it will not hurt any of the contents.
An alias can be renamed. This does not affect its connection to the
original file.
An alias can be created (once the original is selected) either by going to
Flle->Malce Alias or by pressing Command-M.
If an original has been moved to another location that you can't recall,
it
be tracked and found by selecting the alias, then going to
File->Show Original or by pressing Comrnand-R. The last folder that the
original resides in will come to the desktop, showing the original.

am

Any item with an icon - the hard drive, the Trash, the System Folder,
control panels and extensions - can have an alias.
If the alias is of a folder, then you can put items into the original folder
simply by touching the items to its alias. In some cases, you might
prefer to hold the Option key to send duplicates of the items into the
folder.
DUPLICATING AN ALIAS

Once an alias is made, you do not have to trudge back to the original to make
more aliases for other access locations.
If you select an alias, then go to Flle->Ouplicate, a copy will appear.

L:l

New Folder

~•..~

~~~·· rolder alias CfiPY
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PUTTING ALIASES IN LOGICAL LOCATIONS

The best locations to put an alias are:
The Apple Menu
On the Desktop
In the Launcher
To make an item more accessible, duplicate the alias several times and put
them in these locations.
If the desktop is covered with folders, and you can't click an alias located there,
the Apple Menu will let you quickly select the alias duplicate placed there.
If you open the Recent Applications or the Recent Documents folders, you

will see aliases of the items that your computer keeps track of. The computer
instantly makes an alias of an application or document and places the alias in
the appropriate folder. This is a good example of how the Apple Menu uses
aliases put there.
Items that are dragged to the Launcher window on the desktop are turned into
aliases and placed automatically in the Launcher Items folder.

AccESSING THE ORIGINAL

There might come a time when you actually need the original on the desktop
to make some modifications. You do not have to go digging through folders to
locate it. You also might have forgotten just where the original resides.
Merely single-click on its alias, then go up to File->Show Original. The folder
that the original is in will open on the desktop.
IIJIIIII EdIt

VIew Speo
Newrolder
ICN
Open
ICO
Print
ICP
Move To Trash IC<l!l
Close Wi ndow

aw

Get Info
label
5hotinoDuplicate
Make Alias
Put Away

ICI

And-

• r

'

•

lCD
ICM
ICY

'

Page Setup_
Print Desktop_
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ERROR MESSAGES

If you have aliases lying about in various folders, and you choose to remove or
delete the original, you will see a warning message if you double-click on one
of the related aliases. The warning tells you it could not find the original.

••

The Gllas •HaW Folder alios." could not be
op,ened, because the oflglnalltemcoutd nof

·~s~tautict.

'

·

>

*OIC· I

The best thing to do in this case is Trash the defunct aliases.

Creating an Alias
1. Go to the Hard Drive and open its folder. Listed in the Hard Drive should

be an Apple EHtras folder. Open it.
2. You should see an AppleScript folder. Open this folder.
3. Inside this folder you should find the Automated Tasks folder. Open it.
4. Inside the Automated Tasks folder, press Command-N to create a new
folder. Rename this folder ((Hidden Tasks:'
5. Click on the About Automated Tasks document to select it. Press

Command-M to make an alias of it. Drag the alias into the Hidden Tasks
folder.
6. Select the Hidden Tasks folder. Go to File->Make Alias to make an alias.
'Edit. VIew
Newfolder

Open

s'lle•

· WN

Print

•o
31P

MoveTCJTrash a<BJ
oose Window 'lllW
GetrnfD

l.atlel
Sharing_
Duplicate

at

..

ao

Pat:Awoy

IIV

Rnd-

ar

ShowOtlglnal SCR
PGgeSetup_
PrlritDeskto -

Drag the alias out of the Automated Tasks folder and onto the desktop.
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7. Now close all the folders you opened in this exercise.
8. On the desktop, you will see the Hidden Tasks alias you placed there.
9. Double-click on the alias. The Hidden Tasks folder, which still resides deep
in the folders, will open on the desktop. Inside this folder will be the About
Automated Tasks document alias.
10. Double-click on this alias. The application, SimpleText, will launch in
order to open this text document.
11. You have succeeded in manipulating items without needing to dig deep in
folders to get their originals. Close the SimpleText document. Close the
Hidden Tasks folder.

12. Make an alias of the Hidden Tasks alias. Go to the Hard Drive and open its
System Folder. Drag the "Hidden Tasks alias alias" to the Apple Menu
Items folder. Close the System Folder.
13. Go up to the menu bar and pull down the Apple Menu (colored apple in
upper left comer). Scroll down to the "Hidden Tasks alias" and access it
14. The Hidden Task folder should appear once more. Keep this folder on
your desktop.
15. Go to the System->Control Panels folder and double-dick on the
Launcher icon. This will put the Launcher on the bottom of your screen at
the desktop.

16. From the Hidden Tasks folder, drag the About Automated Tasks alias to
the interior of the Launcher window. You have just put another alias into
the Launcher.
17. The About Automated Tasks icon in the Launcher has turned into a
button. Single-click on this button in the Launcher. Observe how the
document becomes launched and open.
18. Close the About Automated Tasks document. Close the Hidden Tasks
folder.
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Launcher
Launcher is a window that appears at the bottom of your desktop screen.

.."

·~<

Items that are placed in the Launcher Items folder (which is located in your
System Folder) tum into buttons that, when single-clicked, will launch/open
the corresponding folders, documents, or applications.
Even though the Launcher is a control panel, it does not have a dialog box to
make setting changes in. When you double-click on the Launcher icon in the
Control Panel folder, the Launcher appears at the bottom of your screen.
If you do not want to activate the Launcher control panel manually each time
you start your computer, you can set it to appear automatically by choosing
Show Launcher at system startup in the General Controls control panel.
Here are some rules and guidelines to using the Launcher.
Items placed in the Launcher Items folder can be either the actual
document, folder, or application, or can be an alias.
Items can be dragged, on the desktop, to the actual Launcher window
to be placed there. This will not affect the original, because Launcher
makes an alias of the document, leaving the original intact, in its
current location.
Items cannot be dragged back out to remove them from the Launcher
1tems folder. To remove any item, this folder must be opened on the
desktop, and undesired items dragged from it.
Launcher can be divided into category folders. These are helpful

when keeping items together to access them through the Launcher.
Launcher buttons can be sized (small, medium, large) by clicking on
the Launcher window while holding the Command key.
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PLACING/REMOVING ITEMS IN THE LAUNCHER

Placing items into the Launcher can be done two ways:
By placing the actual item (or alias) into the Launcher Items folder,
found in the System Folder.

By dragging, on the desktop, the item to the Launcher window, when it
is present on the desktop.
To remove items, though, requires that you go to the System Folder and open
the Launcher I terns folder. You will see the icons of the items and can drag any
out of the folder.

The buttons in the Launcher need only a simple, single click to operate. If you
do not like the size of the buttons, you may change the size by holding the
Command key and click-holding on the interior of the Launcher window. You
will see the pop-up menu to select from.

Soript Editor
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Basic Uses of the Launcher
l. Open the System Folder of your hard drive, and open the Control Panels

folder by double-clicking its icon. Double-click on the Launcher control
panel icon. What appears at the bottom of the screen?
2. Click on the desktop with your pointer arrow. Press Command-N to
create a new untitled folder, which will appear on the right side of your
screen.
3. Drag this folder into the Launcher window, at the bottom of your screen.
You have added a new selection. Click on this new Launcher button of the
untitled folder. Did you hear a click, as if you were flipping a switch?

What else happened?
4. Hold the Command key and click-hold on the interior of the Launcher
window. Select "Large Buttons" and observe how the icons appear in the
Launcher. Hold the Command key and click to bring up the same
submenu. Select Medium Buttons.
5. You now need to remove the untitled folder from the Launcher. Go back
to the System Folder and view it as List from the Uiew menu on your
screen's menu bar.

In the System Folder, scroll down to the Launcher Items folder, and
double-click on its icon to open it.

~

~

~

6l Extenolono
CJ finder

ca fonts
llf¥

~~~ MocTCP ONR

e

You will see the icon of the untitled folder. Drag this out of the Launcher
I terns folder and into the Trash can on the desktop.

6. With the Launcher Items folder still open on your desktop, drag the
actual untitled folder you created earlier to be inside the Launcher 1terns
folder. Stay selected in this folder, but able to see the Launcher window.
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untitled folde r Script Editor

SimpleText

7. You will see that the untitled folder is not present in the Launcher window. Now, click on the Launcher window on your desktop. Did the folder
suddenly appear?
8. Drag the untitled folder out of the Launcher I terns folder and to the
Trash.
9. Close the Launcher I terns folder, then close the System folder.
LAUNCHER CATEGORY FoLDERS

You can use the Launcher Items folder to keep items in categories, just as you
do with regular folders. These special folders will appear in the Launcher
desktop window as extra category buttons that you push to see the content
icons of that folder. The icons will become Launcher buttons.
Seen here, the three Category buttons are Applications (default), Clients, and
Games. When Category folders are used, the intial Launcher window defaults
to become the Applications button.
In this example, the Games category is selected, and we see the RppleCD button
present. If this button were pressed, the AppleCD Audio Player applications
would launch.
I!JI""'_ _ _ __

1~.;
.
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The restricting guideline to creating a Launcher Category folder is that you
must be in the Launcher Items folder on the desktop when you create the new
special folder. You cannot create a new folder on the desktop and drag it into
the Launcher Items folder.
These Category folders act the same way as stated in the rules and guidelines of
the Launcher, discussed earlier. The advantage to Category folders is that you
can have more buttons at your service, just a simple click away.

Creating and Managing Category Folders in the Launcher
1. At the desktop, go to the System Folder and double-click on the Launcher
I terns

folder icon to open the folder on the desktop.
tll

LeUIICIIer- :::::1 1!11!1
2l-,5605 111 MIA
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2. In the Launcher Items folder, press Command-N to create a new folder.

0

1!11!1

_ Leundler Items

-

3tlt,.,, 344.6 HSI'Mioble

t:l

unti lled folder

.
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3. Click on the name of the untitled folder and before the name, type a bullet

(•) by holding the Option key and pressing "8" on the keyboard. The name
of the folder should now be "•untitled folder."
tJ1 =~

-...., Launeller Items ...,. ·
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•
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4. If the Launcher is not currently on your desktop screen, go back to the
System folder->Control Panels folder and double-click on the Launcher

control panel icon.
5. With the new Category folder created, the Launcher should look like this.

Scr.,t Editor

SWnpltTtx1

6. Go back to the Launcher Items folder. Rename the "• untitled folder" to
"• Games:' Create another new folder and rename it "• Movies."
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7. Click on the Launcher. You will see the two new Category buttons.
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launcher
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Go back to the desktop where the Launcher Items folder should be
accessible. Go to the Hard Drive folder and open it. There should be a
folder called Applications. Double-click on its icon to open it. You will see
this.
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9. Click on the AppleCD Audio Player icon. Press Command-M to create an
alias of this application. Drag the alias over to the Launcher I terns folder
and touch it to the "• Games" folder, so that it will move to this location.
10. In the Applications folder, click on the Movie Player icon. Press Command-M to make an alias of this application. Drag the alias to the
Launcher I terns folder and touch it to the "• Clients" folder.

11. Now, click on the Launcher. When you click on the Games category
button, you should see this.

=

I~
.

-·

lounchor :......

II

II

-

I

ltCf\Auct.
Pl"'tt'

12. Click on all the Category buttons of the Launcher to see what buttons..
appear. You will also notice that each Category has its own color the
window changes to when its Category button is clicked.
What do you do if you would like these Category folders to be accessible
in the Launcher? You can't put a folder inside of itself. And to put its alias
inside another Category folder would really confuse the issue.
13. Do this. Go to the Launcher I terns folder. Click on the "• Games" name to
insert the cursor in the text. Put one space before the bullet. Click on the
"•Movies" name text and add one space before its bullet. Go back to the
Launcher and click on the Applications button. The two Category folders

will be present.
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14. Close all open folders that are on the desktop. Keep Launcher active if you
like it. Some users love it, others never keep it open. We're of the former
group.
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Control Fanele
Inside your System Folder is a special folder called Control Panels. Open your
System Folder, and you will see two folders with the name "Control Panels.,,
One of the two has the word Disabled in parentheses. This folder holds control
panels that have been turned off:
We could 5pend hundred5

I

of page5 talking about

Control Panel5. What we're
going to try to do· in thi5

~ ~ControlPonels

~ ~ Control Ponels (Disabled)

'II

Wed,Dec3,1997,Z:091
Fri, Nov 14, 1997, 1Z:o(_;;l

Double-click the Control Panels folder and look at its contents:
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tion that came with them.

This collection of software tools, supplied with your Macintosh and installed
when the system was first set up, provide you with extensive controls over how
your system functions. Some are fun, others are critical to the operation of
your system. All will prove important at one time or another. In this section of
the course, we,re going to explore these controls.
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APPEARANCE

The Appearance Control Panel allows you to set some of the colors you see in
the folders and text you see on the desktop.
For customizing colore you see on the Deektop

The second choice offers you Options to change the way folder and dialog box
windows work, and to change the System typeface fonts, and the platinum,
metallic look of the windows.
CoLLAPSING WINDows

When you have quite a number of folder windows on your desktop, it can get
very confusing to the eye. When a window collapses, it is also known as the
windowshade effect. The folder window collapses up into the title bar, keeping
the folder on the Desktop, but does not obscure other folders you need.
JJ!!~MIIIIecsl'ahl

II

II

•. tt .....I
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I

• Cl tol.,r 2

1
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I

1
I
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I
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t

I

I
I
I

------ .. --.. --------·
I

Collapsing a window can be done two different ways: by double-clicking on the title
bar of the window; or, by single-clicking on the top right button of the window.
Double-click in
the window header

Technique 1

PAGE

n8

Single-click
this button

Technique 2
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The double-clicking can be toggled in the Appearance dialog box through the
Options button. Also, you can control whether you hear a zipping noise when

the window collapses.

For cu5tomizing De5ktop window5

~~~!!!!t!~~a~~~~_,. Givee you the

Wlndowehade effect of
a collapsing window

Toggles hearing a
zipping eound when
wlndowe colla pee
Lete you choose the
typeface for all menus,
windows, dialog boxes
Toggles the metallic
look of window borders

Managing the Appearance Control Panel
1.

Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Appearances
control panel icon. The Color option will be what you see active.

=~
-

•

2. Scroll through the Recent Colors to see the tints available. Select Lime as

the chosen color.
3. Click-hold on the Highlight Color menu button. This affects the highlighting color you see when you use the cursor to highlight text on the desktop,
such as a folder name. Select Yellow as the highlighting color.
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0Purple
OGreen
OTurquolse
-Red
OPinlc
OBiue
CJGray
•Biaclc&Whlte
, 1:!1 Other.-

4.

Click on the Options button under Color in the left column.

CDHapslltiWimlows

=,.,.........,.,----;n

&IDoUIIIe-cuctctltle 1Mr111 clllepse

6iif Aay SD!IIId wllen COAIIIISIIII Windows

ir:!l
Iii System-wt.de platinum appearance
Applfn tile plotlnom o)........-1o an oppltcottora.
Cho--tfleolaNrvoumter~.

5.

Double-click on the window title bar where you see the Appearance
name. Observe how the window collapses. Did you hear a zipping sound
as the window collapsed?

6.

In the Collapsing Windows section, toggle both options Off. Now doubleclick again on the title bar. What change took place? Did the window
collapse?

7. Click on the upper right button of the window. Did the window collapse?
Click on the button again.
8.

In the Collapsing Windows section, toggle both options back On. Now
double-click again on the title bar.

9. Altering the System Font and the Platinum Appearance requires the
computer to be restarted, so we will not address this now.
10. Go back to the Options section of this control panel and set the Highlight
Color back to Blue.
11. Close the Appearance control panel by clicking the upper left button of

the window.

PAGE 120

CHAPTER 3: CONTROLLING YOUR ENVIRONMENT

APPLE MENU OPTIONS

The Apple Menu, (the upper left colored apple icon of the screen's menu bar),
is an instant access to other utilities, folders, aliases, and applications.
When an item in the Apple Menu has more selections to offer, such as folders,
the submenus of these items are indicated by the small black triangle. The
Submenus option must be On to do this. If Submenus is Off, you will be able to
access only the items listed in the Apple Menu.

[-=-On~

~

----------------~

~Remember recently

Documents:

~

Applications:

~

Seruers:

~

used items

Using Apple Options
1.

Open the System folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-dick on the Apple Menu
Options control panel icon.

2. Go to the menu bar across the top of the screen. The extreme top left icon
is the colored Apple Computers apple. Click-hold on this icon and you
will see a menu of choices. This menu is the Apple Menu.
Some of the selections are folders. To recognize these, you will see a small
black triangle pointing to the right. If you move the Arrow to an item with a
triangle, the submenu will pop out, showing further selections in that folder.
eApple System Proftler
(8AppleCDAudlo. Player
t:i Automated Tasks ._

E1 CGiculcator

-·

~Chooser
~ Control Panels
.Find File

• Graphing calculator
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About Automated Tasks .
Add Alias to Apple Menu
Share a Folder
Share a Folder (rio Guest)

.

~ CGitUiator

Start Rle.Sharing
Stop Rle Sharing
I
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3. Make no choices in the Apple Menu. Let go of the menu and you will be
back in the Apple Menu Options control panel. In the Submenus section,
click on the Off button option.
4. Go back to the Apple Menu and observe if any of the items have
submenus. Release the menu without making any selections.
Ai}AI!Pit Systam Proftler
faAppltCDAIIdlo Pl.,yer
CJAutometedTests
E1 Celcllletor

~Oiooser

Ill Control Pentis
~find Ole

•r.rapftlna calculator
I!! Jigs- Pilule
!a~ !CeV Ceps

r;:] Note Pad
~· Recent Applications
\)Recent Documents
a~~ecent Servers

Ill Scrapbook
•

SlmpleSound

~SUckles

5. Go to the Apple Menu Options control panel, click the Submenus On
button to make the submenus active again.
6. Close the control panel by clicking the upper left button of the window.

APPLETALK

AppleTalk is a control panel in which you choose the output port to which you
need to send your information. You can select from Ethernet, Modem Port, or
the most common, Printer Port. Most devices you buy will inform you which
port needs to be used.

Ethernet
Modem Port
• Printer Port
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COLORSYNC™ SYSTEM PROFILE

One of the most common problems that occurs when doing color printing
from the computer is that the colors you see on the screen are not always the
colors you get on the printed paper.

No matter how tempted

you might be, don't trust
your monitor to show you
exactly the colors you'll get

To try to synchronize the two, the ColorSync™ System lets you choose the
Profile of the monitor you are using. In the control panel, you can click on Set
Profile. This will bring you to a new list of monitors from which you can

choose the monitor that best suits your own.

when you output your file to

someone else's printer, or
to film that will be used to
generate commercial
printing plates. Consult the

Select New System Pronle:
I ~ ColorSync.. Proftles f #
2

LllE •

bid

ColorSynC"'systemPraftle ~l3

2 .1.2

I set Prollle- I

Appl. 13" ROB St¥\dvd

technical staff at your
printer before doing any

I

~~ 2"
~Apple 13" RG8 Standard

[!)Apple 16" RG8 Page-White
~Apple 16" RG8 Standard
[!)Apple 21" RG8 Page-White
~Apple 21" RG8 Standard
...
I[!).._Ap....:....::...pl-=-e_Mu...;,ltl;..:cp....:le-'-Sc'-"a-'-n,;_;14_--l.,;,J•

6 snooty

I f,lect j
It Oesktoe I
I eoncel"j
I Sele I

Apple 12" RG8 Standard

important work on your

system.
CONTROL STRIP

When your computer has started, on the desktop, in the lower left comer, you

will see a small button. This is the Control Strip. If you drag the button to the
right, you will see icons that give you instant control over certain functions, or
will tell you the current state of others, such as monitor colors and display
resolution.
When you click-hold on any one icon, you will see a pop-up menu telling you
the current information, and giving you other choices to make.

AppleTalk
......__

Click to close

File Sharing

Printer

CD Music Color
Size
player 1 display display 1

Sound

Click to shrink
or expand

Monitor Settings

AppleTalk lets you make it active or inactive.
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CD Music Player lets you play, eject, or make settings to a CD you
might be playing.
File Sharing lets you see and change the current status.
Color Display lets you choose if you want gray or color for your monitor, and just how much resolution.
Size Display shows you the current settings of your monitor.
Printer tells you which printer the computer defaults to.
Sound gives you a volume slider to adjust how loud you want your
warning alerts and other sounds.
The Control Strip control panel allows you to choose if you want the strip to
show, and gives you the option to assign a hot key to toggle this manually.
The font and size of the Control Strip's pop-up menu's typeface can be set
here, as well.
Collln11SIJ1p

8

Sh!>.l/tbdc
[ 0 ShowControiStr1p

'I 0 .... '""'"''Strip
f) Hot lceyto show/hid I!

I

Denne hot kev-
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r-(Vr«~t hetkf\l
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I
!

c.omtnt/'ld • eontro1• •

r ' ut5ett11'19'

I font I O.arto•l

' "'"' ~
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Managing the Control Strip
1. Open the System Folder of your hard drive, and open the Control Panels

folder by double-clicking its icon. Double-dick on the Control Strip
control panel icon.
2. If the Control Strip is not stretched out at the bottom of the screen, to see

all options, click on its button. Click-hold on any item to see its window.

liPIIW$¥1@dlmlgS!IBUI
3. In the Control Strip control panel, click on Hide Control Strip to toggle it

Off. Observe the actual Color Strip as you click. Click on Show Control
Strip. Did the Control Strip appear again?
4. In the control panel, click-hold on the Font option button to set the font

for Helvetica Regular. Click-hold on the Size button to set the size for 14.
5. Click on any of the items in the Control Strip to show their windows.

Observe how the type size and font has changed. In the control panel, set
the Font back to Geneva, and the Size back to 10.
6. Close the control panel by clicking the upper left button of the window.

,,
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DATE &TIME

In the upper right corner of your screen's menu bar, you will see the time. If
you click on the numbers, you will see the current date set in your computer.
8:18AM

IC!

IC!

11121197

c- Time control

You can adjust your date and time to be correct in the Date

panel. You can also turn the menu bar clock on/off, and set your Time Zone.
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CLOCK OPTIONS

The Clocl< Options affect the menu bar appearance of date/time. You can also
set the clock to chime at various intervals, plus set the font and size of the
date/time that appears with it on the screen.
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Managing the Date & Time

1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Date &- Time
control panel icon.
2. In the Current Date section, click in the white part of the box where the
date is shown. The first item in the date will highlight. If you click directly
any of the numbers, they will highlight.
lfl/27197

1$1

Next to the date box are two arrows, Up/Down. Click on the Up arrow
one time. You will observe the month date go numerically higher one
digit. With the month still highlighted, type in the number of your current
month. You can use either the arrow buttons or the keyboard to modify
the numbers.
3. In the Current Time section, click directly on the minutes. Type in a
different number of minutes. With this still highlighted, use the Up/Down
arrows to bring the minutes back to the number it should be.

1..=~:52AM

m

4. Go up to the menu bar and click on the time in the upper right corner.
Observe how it is set, in sequence, as Month/Day/Year. Go to the Current
Date section, click the Date Formats ... button. In the next window, under
Short Date, click the submenu Month/Day/ Year. Choose the option
Day/Month/ Year. Underneath this, set the Separator to be a "-" (hyphen).

Click leading zero for day and leading zero for month, then click OK at the
bottom of the window. You will be back at the main Date &- Time window.
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Go up to the menu bar again and click on the time. Observe how your
changes affected the appearance of the date.
Go back to the Date Formats... and set the date formats back to Month/
Day/Year, with a separator of a slash (/). Leave the leading zeros, unless
you do not want the date to show this way. Click OK.
5.

In the Date &- Time control panel window, click on the Time Formats...
button.

6. In the Fonnat section, click in the AM box and highlight AM. Change it to
lower case "am." Highlight the PM and change it to "pm!'
7. Click in the Separator box and it will highlight. Change the separator to a
bullet (•) by pressing Option-8.
8. You will see all these changes at the bottom of this window, under Sample.
The samples change as you make modifications in the window.
9. In the Clock section, click on 24 hour, and watch the samples as you do.
Now click back on 12 hour.
10. So that none of these changes take effect, click on Cancel.
11. Back in the Date &-Time window, click on Clock Options. You will be at the
Clock Options window.

.~ J Clock Options
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Display the time with seconds
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Use custom clock color:
(r""""sele-ct-C--,
ol-or-..•-'j

0 I no clum~

1
:

(9 I no ch/m~
<D 1 nochlm~

0 I no ell/me

I

;

I

;

I

I; I

Font Se~
ttl~ng~o:::::::;:===:::::;:7::;-,
Font: Charcoal
I~

I

I

Size:~
boood on SuperCioct 1. bV steve Chr1ate,...n

P AGE 128

cancel

I

C H APTER 3: CoNT ROLLING You R E NVIRONMENT

12. The lower left corner of the window has a Sample section to show some of
the visual changes. Experiment with some of the many settings and
observe how they appear in the Sample section. When you are through,
click Cancel.
13. Back in the control panel window, close the panel by clicking the button in
the upper left corner of the window.

DESKTOP PICTURES

The image of the desktop is a pattern of the logo you see at startup. You can
customize the desktop by using the Desl<top Pictures control panel.
In the left column of the panel, you will see two options:

Pattern
Picture
When you click on Pattern, you will see this window. You can use it to scroll
through the many choices of images, then press Set Desl<top to apply the
image.

Chooee "Pattern" to apply patterne to the Deektop

Patterne
appear

here

U5e 5lider
to ecroll
through the
5ample5

There are many attractive patterns to choose from. Here are four samples.
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The Picture option changes the panel to let you select an actual photographic
scene and apply it to the desktop.

Choose "Picture" t o apply photo to your Desktop
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en
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Set the screen
etyle or poeition
of the picture
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.!clleiDSCnen

•nucnoo

Use thie to go
select the picture
for Apple Extrae
Click here to
apply the picture
to the screen

When you want to choose a picture, the Select Picture button is clicked to
allow you to go to the Apple EHtras folder on your hard drive. From Apple
Extras, the pictures are located in the Sample Desl<top Pictures folder.

Using Desktop Pictures
1. Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Desl<top Pictures
control panel icon.
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2. You will see the Mac OS color pattern in the viewing window.
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Launcher will not activate
at startup unless you click
"Show Launcher at system

3. Under the image is the viewing scrollbar. Use this to scroll through the

startup" in the General

selections offered. When you come to an image you like, click on the Set

Controla control panel.

Desktop button in the bottom right of the window.

4. Observe how the desktop of your screen becomes filled with this pattern.
5. Scroll through other images in the viewing window and Set Desktop to
experiment.
6. Click on the Picture option, underneath Pattern. Click on the Select
Picture button in the bottom right corner. Use the next window to go to

the Apple EHtras folder on your hard drive. Open the folder Sample
Desktop Pictures.

f ~Apple Extras~ ;

Preview

~ AppleScnpt"'

I

C1 flreWire
C1 Mac OS Info Center
C1 Monitors Extras Folder
C1 Open Transport/PPI'
cr s..~~~e Duttip l'ldlfts

I

~~·te

i

(l Sound Control Panel
(if Show Preview

.

a Snooty

I

EJect

I

I oes&e I
I

.I

cane~ )

Sllen

I

7. From the choices, select Beach on Ko Samui. Click Open.
8. You will be back at the Desktop Pictures control panel. Click-hold on the
Position Automatically button. You will see other choices. Experiment

with selecting the various position choices, then click Set Desktop.

CHAPTER 3: CoNTROLLING YouR ENVIRONMENT

PAGE 131

./

Po~1Uon

Automatically

Set Desktop

9. Use your own judgment to select either a Pattern or Picture to be the
background image of the desktop. Set Desktop, then close the control
panel by clicking the upper left button of the window.

ExTENSIONS MANAGER

The Extensions Manager is like a light switch. It toggles the listed utilities on/
off. This is a utility that operates on both Extensions and Control Panels that
reside in their respective folders. It is simple to turn utilities on/off. The small
box to the left of each name is the object to click to toggle it on/off.
Extensions Manager has the ability to save the settings in Sets that you can
name and access later. This is handy when you are working on jobs that require
certain utilities to be on/off. It is timesaving to select the Set, rather than
scrolling and finding all the necessary items.
At the bottom left of the EKtensions Manager window, there is an option to
Show Item Information about the item selected in the window. It tells general
information about creation date, file size, last time modified, then goes on to
tell what functions it performs.
There are also three option buttons that will Restart your computer, Reuert
back to when EKtensions Manager was last opened, and Duplicate a Set that
you want to customize.
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..

Extensions that are On/Off can be
saved into Sets that can be accessed later
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GENERAL CoNTROL S

General Controls allows the customizing of certain features you see on

the

desktop, as well as permitting folder protection.
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Show Oesl<top when in bacl<ground- eliminates from view all the

distracting folders and icons on the desktop when you're in an application, and not at Finder level.
Show Launcher at system startup- is the only way to get the

Launcher to appear on the desktop at startup. You cannot put a Launcher
alias in the Startup Items of the System Folder. It doesn't work.
-When the cursor is in a text block, it
blinks. This is where you set the blinking speed for slow, medium, or
fast.
Insertion Point Blinl<ing
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Menu Blinking- Some applications have menus that blink and you

can set the number of times it blinks, or turn the blinking off.
Warn me if comput er was shut down improperly- if your com-

puter locks up and you have to do an emergency abort, when you start
up again, you will see a warning window telling you the computer was
shut down improperly. If you prefer not having this warning, you turn
it off here.
prevents the accidental Trashing of the

Protect System Folder -

System Folder and its contents, with a warning.
Protect Applications Folder- prevents the accidental Trashing of the

Applications folder and its contents, with a warning.
Documents -

when you are opening or saving a document, you have

three choices of where the computer does its placement.

Using General Controls
1. Open the System Folder of your hard drive, and open the Control Panels

folder by double-clicking its icon. Double-click on the General Controls
control panel icon. You will see the General Controls window.
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Click on the Show Desk top when in back ground button to tum it Off.

3. Click-hold on the Apple Menu icon (colored apple at the top left of your
screen), and scroll to highlight the Calculat or to activate it.
4.

When the Calculator appears, what happens to the desktop? Do you see
any icons in the background? The desktop filled with icons has been
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turned off because it is in the background behind the Calculator, which is
the current application choice.
5. Go to the Applications Menu (the colored icon in the top right comer of
your screen). Pull this menu down and select Finder. Now, what has
happened to the desktop? The desktop (Finder) is now the current selection, so it is not in the background.
6. Go back to the Applications Menu and choose Calculator. Observe how
the desktop icons disappear. Close the Calculator by clicking its top left
button.
7. Go back to the Applications Menu and select Finder. You will see the
General Controls window again. Click on the Show Deslctop when in
baclcground button to turn it back On.

8. Close the control panel by clicking the upper left button of the window.
KEYBOARD

The Keyboard control panel has two sections in which to make desired
choices. The Keyboard Layouts pertains to people who do international work,
and need the keyboard to reflect the language they are typing in. If you have no
use for another language to type in, it is best to leave this section alone.
Key Repeat is an option to customize how the keyboard keys react to your

typing speed. The default settings are the best for the average user. If you want
speed and delay between keystrokes to change, you should experiment with the
settings.
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f..t
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Off
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LAUNCHER

The Launcher control panel is a valuable accessory. Its only function is to make
the actual Launcher window appear at the bottom of your screen.
This is done by going to the Control Panels folder in the system Folder. If the
Launcher control panel icon is double-clicked, the Launcher will appear.

Launcher .

- ..

~s

~ ~

Seript Edit..-

Stnp»Ttxt

• g.

ti

It is a very useful item for accessing your applications, documents, and folders.
More about the Launcher is discussed elsewhere in the book.
MAc OS EAsY OPEN

Often you will be given a floppy disk from other computer users (especially
from PC to Mac) that contain files you do not have the application for. Mac OS
Ea sy Open analyzes the incoming file and gives you a listing of equivalent
applications that could open the file, especially if it is only a text file.
You can make your own selections to the options for quicker accessing of
incoming documents.

AutotmUc document tr-V<St.Uon:

~ On

Q Off

- Tnnsl.tlon Chote.s: Dia'lo9 box

0

Al'WMJS Show db'log box

(if Tr.,..sl~t• 'TEXT' doo\.r'ntflts

!if lnc\.!Oe appl~Uons on Sf't'¥tr'S
li1J "''' •"' "m" •""""
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MAP
The Map control panel gives you a visual look at the globe and can tell you
specific information of latitude, longitude, time zones, etc., for a desired
location. It is an added attraction to see the points specified blink on the globe
in the control panel.

v 7.5. 1

~IM_i_am_i____-===--==~1 ~~inal
Latitude
~o ~6 · ~N
Longitude

o

Time Zone

h 0

mi 0

12 •

11 : 15 AM

10 E

miD+

{[E

MEMORY

If you know the latitude and
longitude of your location,
you can add it to the map.
It's very cool to know where
you are at all times, and

The Memory control panel pertains to RAM (Random Access Memory) in
your computer. RAM memory is one of the most needed, and at the same
time, misunderstood aspects of a computer. RAM memory and Hard Drive
storage memory are two very different elements of computer operation.
We will not go deeply into RAM memory, but we will offer these notes.

checking the map will show
you where you are relative

Disk Cache is an extra RAM memory pocket that the computer uses to store

to Madagascar, India, and

other very important

items temporarily while it is operating. Depending on how much RAM your
computer is equipped with, you do not need a tremendous amount of cache.

places.

From 512K to 2000K is more than enough. You should certainly contact the
company you bought the computer from to know a more exact amount you
can set the cache for.
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Virtual Memory is a makeshift way of utilizing a segment of your hard disk's
permanent memory as RAM. Some applications do not run well under
Virtual Memory, and if you do not have the available memory on your hard
disk, it is not a good idea to have Virtual Memory on. Again, consult the
company who sold you the computer to know more about its requirements.

~t

-.

~ .;:;:o

g

!2S61< I~

Dhlcc.ot..
Alw.ttJSCin

Cac:1w Slz:t

"'"""'l'llmonj

! cttal'lllllrM

StltctKrciDt:Ac :

fJ
I

~tnfWilt on dtfk:

e o.
<i)Ofr

Avo~fWilttM'It-t\"'""*" :

I!EJ~

Ptf'e«~tof.av..tlab.. ~

RN1Dhlc

~

!rtl

602t1
C1

touu for a AAHtftdc :

<Q

Go.

f) Off

~

100!1

RN1 Dtlk81zo

[E::J

0!1

I(VHOifau!!!J

v7.5.8

Ram Disk is a rarely used option that utilizes an external disk for extra RAM
memory. It is best just to ignore this option, unless you are a power user.

MODEM

If you have a modem, the Modem control panel should be set to Modem
Port. The Setup requires that you choose the modem, or equivalent, from
the Modem submenu of names and styles. If you desire sound, such as
ringing as the modem attempts to connect, leave Sound on. The default
Dialing is set for Tone, unless your modem software requires a different

setting.
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MoNITORS & SouND

The Monitors II sound control panel has three sections: Monitor, Sound, and
Rlerts.

The Color Depth is the only option you should change, and only if you need to.
The depth can be changed from Grays to Colors. In Colors, you can choose
If you want really good

from 256levels to Thousands. Some monitors will offer millions. The more

sound, add a couple of

colors a monitor displays, the slower it refreshes (another word for redrawing).

reg ular speakers to your

This may not be true if your system is equipped with a specialized graphics

Macintosh. It cranks with

display card.

good speakers!
Monitors a Sound

[]

SoUND

The Sound section lets you customize the output and input of sounds it creates
or uses.

0

Monitors & Sound
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Sound out Leuel- controls the volume of computer sounds other

than the Alert sounds. This could be Speech effects, or sounds that
games make.
Sound out Balance- controls the balance of the sounds, if this is

available on your computer.
Computer Speaker Uolume- adjusts the volume on external speak-

ers, if you have them hooked up to your computer.
Computer Speaker Balance- adjusts the balance of the external

speakers.
Sound Output- defaults to Built-in.
Sound Input -lets you select the source of sound input. It can come

either from an external microphone, or from an internal CD.

ALERTS

The warning alert sound you hear can be changed to others listed in the Alert
Sound list. When you click on each one, you will hear its soutl.dto deteltrnine if
you like it or not. The volume of the alert sounds can be adjusted with the
System Alert Uolume slider.

~
w
_Alert sound _ _ __,

L,
So5umi
'a'ild EeD

-~~c:~ [ ·~~.!
_
""

I
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Managing the Alert Sounds
1. Open the System Folder of your hard drive, and open the Control Panels

folder by double-clicking its icon. Double-click on the Monitors &- sounds
control panel icon. Select the Alerts option.
2. There are several options in the Alert Sound list. Click on each one of
these sounds. As you dick, you will hear the sound.

3. With any one of the sounds selected, move the System Alert Uolume
slider back and forth to adjust the sound volume.
4. Choose the Alert Sound you like, and set the volume.

5. Close the Monitors &- Sound control panel.

MousE
The Mouse control panel adjusts the speed that the arrow pointer/cursor
travels across the screen as you move the mouse. This is Mouse Tracking. The
Double-Ciicl< Speed buttons control the speed that you need to double-click
the mouse button to activate clicked items. It defaults to the medium speed.
~Tnckin9

[1]
0
V•riJ Slo"'
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j
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QQeOOQ
Slow

F'ast
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Managing the Mouse Controls
1. Open the System Folder of your hard drive, and open the Control Panels

folder by double-clicking its icon. Double-click on the Mouse control
panel icon.
2. Click the Uery Slow option. Do not press the mouse button. Merely move

the pointer arrow around the screen. Is this painfully slow? Most artists
with electronic drawing tablets use this for their pen cursor.
3. Click the button above Slow. Now move the pointer arrow around the
screen. Still too slow?
4. Click the button above Fast, then move the pointer arrow around.

5. The default speed is the third button from Slow, which would be about
medium. Set the Mouse Tracking at this speed, or at whichever speed you
feel comfortable with.
6. Gose the Mouse control panel by clicking the upper left button of the
dialog box.

NUMBERS

If you are working on text items that require special character formats, decimals, dollar($) symbols, then the Numbers control panel gives you these
necessary characters.

o-

~-eJ

t.C.mbers
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~ hllmber rormet f U.S.
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PC ExCHANGE

If you're on your Macintosh computer, and someone hands you a PC formatted floppy disk with information on it, what do you do? Answer: just insert the
disk into your floppy drive. The control panel PC EHchange, which is on by
default, acknowledges the PC disk and reads it as if it were a Macintosh disk.
We don't know about you,
but we have a hard t ime if
we change the numbers
setting so that t here
aren't decimals in the right
place, and commas don't

You can customize PC Exchange to assign Macintosh applications to open the
PC files. Press Rdd when you want add more formats to the PC Exchange list.
You will see a new window that says "Assign an application to a DOS suffix:"
You then type in the DOS suffix and go to a folder that contains the appropriate application that can open the type of file assigned. OK is then clicked to add
this to the list.

appear when the numbers

.... ____ _
_------·-____ _

are in t he t housands. We're

,..........

bad with numbers, anyway.

PC EHchange has On/Off buttons, as well as Change to modify an item, Hemoue

to delete it, and Options to make further customizing choices.

ppp

The PPP Control panel is used to connect with commercial internet providers,
or with other networks within your organization. For information about
setting up the PPP control panel, be sure to contact your internet service
provider, or commercial on-line service, such as AOL or Compuserve. Here's a
picture of the control panel:
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From the PPP control panel, you enter your User Name, a password, and the
telephone number that you use to access your specific service. You can have
multiple settings stored on your system, which allows you to use different
providers for different services. You can also access an Options dialog box by
clicking the Options button:

·-

Options
/

······ ·~

Rodioling \ / &o.octfoo \ / Protocol_j.
Rtdi1l:

I Rtdial nuin numbtr only

:)

Rt<ll•t l• l limos .
Tim+bttwttnr"ttrits :

D

St<:onds:.

Cancel

I

OK

n

This dialog allows you to set the number of times the system tries to redial the
number (in case it's busy or not answering).
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The Connection dialog (accessed by clicking on the Connection tab at the top
of the Options dialog) gives you a place to set up the actual connection to your
service provider. The "Connect Automatically" option logs on to your service
provider anytime you launch a program like Netscape Navigator, Microsoft
Internet Explorer, or an email program. It will also let you automatically log off
in case you forget that you're on the internet and leave your house or something:

I
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1
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Cancel

I

OK

Jl

The Protocol tab is an area where you might need to talk to your service
provider before selecting the proper settings:
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OK
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QuicKTIME ™ SETTINGS

The QuickTimeT... Settings control panel offers the choice of playing or starting
your CDs automatically. You can click on the appropriate buttons to toggle the
AutoPlay either On or Off.
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SPEECH

Some applications such as SimpleText have speech features. They will speak the
selected text in various voices that you can choose. Also, the rate that the voice
speaks can be adjusted.
The Options pop-up menu lets you choose from either a voice that speaks
selected text, or the Talking Alerts.
=·······~'ll:::..~·r~~~:··~·"'"~i·~-~··w~et11B, ,.~.fiitiia ···· :: -~-~
r~e.;ee~·"e~;;;;;eg:=-;w~.
~ ~a.-=1
: d i , . . i t e ; ; . , .1,.._,.
.......

Voa:Ht!fu

. '

<lfl

liB

Rat.:~

-

F-

Ul

TALKING ALERTS

The Talking Alerts are vocal sounds or words that warn you of certain mishaps. The Speak the phrase submenu has various alert phrases that are often
quite humorous, such as "Rats,, or "Yeow!,
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Experimenting with Speech
I.

Open the System Folder of your hard drive, and open the Control Panels
folder by double-clicking its icon. Double-click on the Speech control
panel icon.

2. The Options will be set to Uoice. If you click-hold on the Voice menu,
under Options, you will see a list of the voices to choose from .
._,

............
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·-..

.c.......
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...........to•l
,....,..1ft
"'""
OooMMtv•
~rt
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Experiment with the voices by choosing one, then click on the speaker
icon to the immediate right of the Voice menu.
Yoieo: '-'1F'-"rtd;:...__ __.I.....
;J

@)

3. Set the Options menu for Talk:ing Rlerts.

4. Click on Speak: the phrase. In the menu to the right of this option, you
will see a list of alerts to choose from.
• A\frt!

It's not'"¥ f.aultl

BIHU
PMJ .IItttnt~l

Dhdurl

RttJ.
Y.owl
AtttnUonl

00."'111

......,
Shoot!

Exeuurnol

"""~ U.list

~fr"omt.htlitl

Edttpt.,..ap i:rt

5. Set the Wait before speak:ing to 0 (zero) for immediate results. Experiment
by selecting an alert, then clicking the speaker icon to the right of this
option. You will hear the alert. When finished, Oose the control panel.
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STARTUP DISK

The Startup Disk control panel shows you the various external or CD drives
that you can startup from, if your computer has them connected.
Be aware that these drives must have functional System Folders with all the
necessary files in order for a new startup to take place from them.
It is suggested that you do not modify this unless you are sure that you need to
startup from a drive other than your main hard drive.

Stltot 1 St.-tup Olsk:

II

Extwnal

TEXT

The TeHt control panel is only for those who are dealing in international
languages, such as these shown here.
If you are typing a document in a language other than English, you can choose
the language from the Behauior submenu.
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The Apple Menu
The Apple Menu, represented by the colored apple located in the extreme
upper left corner of your screen, is a quick and easy means to access documents, folders, applications and utilities that could be scattered throughout
your system. The convenience of the Apple Menu is that it is available most of
the time, no matter what application or document you are in.
When Macintosh OS 8 is installed, it creates several standard items that would
prove useful. They will be discussed after a look at the Apple Menu and how to
use it to your advantage.

· ·.. I!A~Jple Syst.em Pronler
· @!APple(]) Audio Piayer ·
(1·AIItD~atecl Tutcs

Bcalculator

~~Uos(!r
ltl'comrol Pinels

.

. • flndflle
c ·• Graphing caiculator
JlosiW Puzzle
liJICeycaps

te

CNotePad

II ~cent~pllcat;tons
.:&Jlecent 00
.. cu.m_.ents

· Ia Recent Servers

*

·

0!) 5CflpbO,Ok

I·

Slmplesound
~SUclcles

How do you get items into the Apple Menu, or take them out? The controlling
folder is known as Apple Menu Items, located in the System Folder. If you
open the System Folder, and Uiew it "As List:' alphabetically, the Apple Menu
I terns folder will be at the top of the name list.
So as not to disturb, or lose, certain valuable documents or appliations, it is
best to create an alias of the item and place it into the Apple Menu I terns
folder.

--.
~

System Folder
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Managing the Apple Menu
1.

At the desktop, go up to the colored apple in the upper left corner of your
screen. Click-hold on the apple. You will see the objects that reside in the
Apple Menu I terns folder.

2. Several of the items have triangles pointing to the right. These are folders
that contain more items. Drag the mouse down to highlight any of these
items and you will see the contents.
3. Do not select anything in the Apple Menu. Go to the System Folder and
open it. Use the desktop menu Uiew->As List to see the items alphabetically. You will see the folder Apple Menu I terns.
4.

Keep the System Folder open on the desktop. Go to the Trash icon in the
lower right of your screen. Single-click on the Trash icon to select it.

5. With the Trash icon selected, go up to File->Malce Alias in the menu bar.
The alias "Trash alias" will appear.
6. Drag this alias to touch the Apple Menu Items folder icon in the System
Folder.

7. Now go up to the actual Apple Menu in the upper left corner and clickhold on the apple. Scroll down the menu to see if the Trash alias is present.
8. Make no selections from the Apple Menu. Go back to the System Folder
and single-click on the Apple Menu I terns folder to select it. Press
Command-M (keyboard shortcut) to Malee Alias of the Apple Menu
I terns folder. The alias will appear just below the original. Drag this alias
out of the System Folder and onto your desktop.
9.

Close the System Folder.

10. Still on the desktop, double-click on the Apple Menu Items alias. The
folder from the System Folder will appear. Drag the Jigsaw Puzzle item
out of the folder, onto your desktop.
11.
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Close the Apple Menu Items folder.
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12. Access the Apple Menu at the top of your screen. Scroll through the menu
and look for Jigsaw Puzzle. It will not be present, because you removed
it. Make no selections, and go back to the desktop. Locate the Jigsaw
Puzzle you dragged to the desktop.
13. Drag the Jigsaw Puzzle over to touch the Apple Menu Items alias. This
will place the puzzle back into the Apple Menu. To make sure, go back and
access the Apple Menu at the top of your screen.
14. Scroll down the menu and see if the Jigsaw Puzzle is back.
15. On your desktop, place the Apple Menu Items alias in a convenient
location, so that you can access its folder more readily.
16. For dean-up purposes, double-click on the Apple Menu Items alias to
open its folder. Drag the Trash alias you placed there earlier to touch the
actual Trash icon. You want to Trash it. You cannot place items in the
Trash through the Apple Menu.
APPLE SYSTEM PROFILER

The Rpple System Pro filer is a profile or data analysis of your computer and
its specifications. It tells you code and processor numbers, amount of RAM
memory, and other pertinent data. Use this only if you are interested in the
inner workings of your computer.

System Overview

C1

Customer Cere Code: 6 169 0565 440 1 049 1
Machine: M8cOS comp8llble
Machine ID: 514
Finder:
System:
Processor:
Actlue Enabler:
DpenDoc:
Memory Installed:
Ulrtuel Memory:
Total Memory:
Disk Cache:

Y6.0
Y6.0 US
PowerPC 603eY et 160 MHZ
n/e
v 1.2. 1
32 MB
Is on
43 M6
Is on, 256K

Startup Deulce: Unknown
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APPLE

CD AUDIO PLAYER

The Apple CD Audio Player is a great means of playing musical CDs on your
computer. It is very convenient to use if you want background music of your
choice while you work. The playing of a CD does not affect or interrupt any
other operations you might be involved in. It is purely in the background.
To Play, Stop or Eject a CD is accomplished just by the simple clicking of the
buttons shown. Other data, such as elapsed time, is shown as the selection
plays.
Normal- The Normal button is the standard sequence listed on the
CD. The selections will play in this order.
Shuffle - The Shuffle button will randomly shuffle and select items on
the CD to play. The list will show below the buttons. Each time you
press the button, it will reshuffle the selections.
Program - Program allows you to drag the selections to the sequence
you want to hear. When Program is clicked, the list divides into a Tracks
side, and a Playlist side. You merely drag the tracks you prefer over to
the Playlist. Then, when you press the Play button, you will hear only
the chosen tracks.

Apple CD Audio Player

• Normal
• Shuffle

Volume
slider

Playing time
of each
selection
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AUTOMATED TASKS

are preprogrammed scripts that can perform several operations, saving you the time of having to do it manually. If you want more
information, choose '~bout Automated Tasks, from the submenu.
Automated Tasks

If you get into the Scripting act of programming, you can make your own tasks
and place them here for future use.

CALCULATOR

The Calculator is a small, pop-up program that allows you to click its keys the
same as you would press the keys of an actual hand-held calculator. Remember
that the"*, symbol is the symbol for multiply. The"/, symbol is to divide.

FIND FILE

Reviewing what you've learned, items can be moved, renamed, accidentally
Trashed, or lost in many different ways. You will probably rely on Find File
quite a bit when this happens.

CHAPTER 3: CONTROLLING YouR ENVIRONMENT

PAGE153

The specifications you can search by are extensive. Find by name, size, date
created, locked, etc. You can specify that the string of text starts with, ends with,
contains, doesn't contain certain criteria. The size, kind, label, etc., can be
searched for, and the number of file size "is less/greater than:'
~ name

size
ldnd
label
date created
date modified
version
comments
lack attribute
folder attJ1bute
ftletype
creator

-'DR all

diSks
an local disks
on mounted servers

on the desktop
In the Ander selecUon

\.f CDntallll

starts with
ends with
IS
Is nat
doesn't contain

"'size
ldnd
label
date created
date modified
version
comments
lock attJ1bute
folder attribute
nletype
creator

Using Find File
1. Go to the Apple Menu and scroll down to Find File and launch it.
2. The Find File dialog box will appear on your desktop. You will need to set
specifications and click And to see how Find File operates.
3. Here is a setting to find items that the name contains the word "panel."
Make these setting in Find File, then press Find.
i"l :

find file

I

And Items on all disks

n~·me ' .

I ~re Choices I

(!~

II contains

r~l--

jrt II panel

~I

~~ncr-·

Those items found that fit this criteria will appear in a separate window
underneath the first Find File window.
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4. Go back to the top Find File window and make these settings, then press
Find. It will find items that the name starts with "control:'

5. Go back to the top Find File window and make these settings, then press
Find. It will find items that the kind is an alias.

6. Go back to the top Find File window and make these settings, then press
Find. It will find items that the date modified is the current date you set
with the up/down arrow buttons.

7.

Go back to the top Find File window and click on the More Choices
button. You will see the size and is less than option. Make these settings,
then press Find. It will find items that the kind is with an eHtension, and its
size is less than 25.
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8. Go back to the top Find File window and make these settings, then press
Find. It will find all items (nothing specified) that the size is less than 5.

~

Fln4Rie ..,~

fJ

I

Find Items on all disks
,.;;

l name

I; Jl contAIIns
!; )I rslessthan

,..

I size

.

lt~) Whose
ll'lll-

I~

ltiol

l~:~l

j ;J 5

~

I More Ololces Jl

Fewer Ololces

J

~~Find "I
--"

9. The exercise is finished. You have seen how Find File operates, and how
you choose the settings. Close both of the Find File windows.
GRAPHING CALCULATOR

Since we're not math heads, the best thing we can tell you about this fairly
weird and incredible calculator is to tell you to go through the self-running
demo that comes with it. Good thing, too.

&ql!ll!l

Gr•phlnO Calculator •

sin (x)
Nov cnphln( y a. a fUllCtlon of >.

•

I

2

I~

~
2

~
~
~
8

-2

1-1 ..1
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]IGSAW PUZZLE

The Jigsaw Puzzle is a map of the world, shown here (left). To begin the puzzle,
you must go up to the menu bar and pull down its Option menu and select Start
New Puzzle. You will be given the choice of selecting the sizes of the puzzle
pieces. The puzzle will split up so that you can move the pieces around to put the
picture back together. You can also paste your own picture to customize.
Choose siz e or pieces:

G Smoll
eMedlum

Gl L•rv•

KEY CAPS

There are many characters in the fonts that you might need, such as accents,
the apple icon, or international symbols. Key Caps shows the different characters available from fonts you choose from the menu bar at the time Key Caps
1s on your screen.

........

c .

1!1

II
1!1 liiliiEillliiDliWI Ciiiliii!Wfil
- 1 21 4S "• If l l l •
.... t
ii I e
'o ••·• ~ lohll k l lf:

• '• r v •

.

• I

\

•

I

~~ ~ ·
f I I •
4 •• •

tfb L..!..· ~ . ..

To see the various characters, the keyboard of Key Caps can be clicked. The
corresponding symbol will appear in the Key Caps window above its keyboard. If you hold the Shift or the Option key, you will see what characters go
with the key you press. You can also hold the Shift and Option keys together
and get more characters.
Key Caps is simply a guide

to show the hidden characters of various fonts.
Then, when you are using the font, if you hold Shift or Option, or both, you
get the character designated in Key Caps.
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NoTEPAD

The Note Pad is a convenient electronic note pad to keep notes, phone numbers, addresses, etc., that you need quick access to. There are several note pages
that come standard with MAC OS 8. You flip through these pages by clicking
the left corner flap. To back up through the pages, you click the area next to the
flap, as show here. To create an additional page, you go to the File menu and
pick New Note.
!_!1!!11

Peoole to coll · ··Werntn Peec:e

Helen Hlghwoter

Click here
togo to
next page.

N

Click here
to go back IE:::::!!!!!!!!!!!!!!!!!!!!!!!!!!!!=!.!:l
a page.
RECENT APPLICATIONS

The computer system keeps track of when applications are launched. When
they do, the system makes an alias of the application and puts it into this folder
that appears in the Apple Menu. This is another handy use of aliases, because
you can instantly launch an application that was used previously again.

1 Recent Documents
Ia Recent Servers
(! Scrapbook
~ CIMftloCnuftlt

Adobe lllustratore 7.0
~

AdobePage~ker6S

Adobe Photoshop
ApplemAudlo Player
Slm__!!eTut

REcENT DocuMENTS

The same way the system keeps track of applications that are launched, it
makes an alias of documents opened and puts it into this folder. If you want to
go back to a document that was used earlier, and don't want to dig through the
folders to find it, you can access it here.

~Recent Servers

(! Scrapbook
• SlmpleSound
b. Cl-..,l•Tovf'
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Against The Oock
Baggy Gltar Stories
Behooving 1 Behorlam
catching Tarpon on 1 fly Rod
Poysslck's Oriental Cookbook

CHAPTER 3: CONTROLLING YOUR ENVIRONMENT

SCRAPBOOK

The Scrapbool< is a storage file in which to keep text and images. To put text/
images into the Scrapbook:, the item must be in the Clipboard, Copied from a
different source. Scrapbook: is then accessed and the item pasted.
The Scrapbool< shows the pasted image, and gives other information. To see all
the items stored, you use the scrollbar to view them, one by one.

Image ehow5 here
I(

Telle how many
iteme areln
the 5c:rapbook
Graphic: format
File elze

~t:;=~~=~~~~=~~&J
Tell5 elze of Image and the
percentage it ie 5hown at

To remove an item from the Scrapbool<, you can use either Cut or Clear from
the Edit menu when Scrapbook: is active.

The Scrapbook can hold three file formats:
Text

u.... s..,..,.._ ... ~ ......,plnl-."""-

1

..... --,..---~·

.....,......._ _...oM_...
•looor•-c-..,....a.,.....-

................

,_,...,_,"""' ......

---

t.~.-.........,_-

Graphics

Sound
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Using the Scrapbook
1. At the desktop, go to the Apple Menu, and scroll down to the Scrapbook:.

Highlight it and release the mouse button to launch it. You will see the
Scrapbook: window.

Item : 2 of 10
Type: ploturo

Dimensions: 159 by 189 ptxtls
(shown • I 93'lli!)

Stu : 13K

2. Scroll through the selections to see the objects that are stored there. Stop
when you reach the Party Hat image.
3. Press Command-Shift-3 which will take a snapshot of the desktop while
the Scrapbook: is open.
4. Go to your Hard Drive folder and look for a file called "Picture 1."

Double-click on the file's icon.

1•,

This will launch SimpleText, the resident word processor of the Apple
computer, which can also show snapshots taken of the desktop.
5. You will see the desktop, with the Scrapbook, as captured when you took

the snapshot. With the cursor in the SimpleText document, drag a border
surrounding the image of the Scrapbook. Copy the marqueed image.
Press Command-V to Paste the image into the Scrapbook.

PAGE160
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6. Use the Applications Menu to go to SimpleText. Press Command-N to
create a new document, which will have the cursor in it. Type the words:
"Now is the time for all good people to come to the aid of their party."

7. Highlight this text with the cursor, and press Command-C to Copy the
text to the Clipboard.
8. Use the Apple Menu to go back to the Scrapbook. Press Command-V to
Paste the copied text into the Scrapbook.

Scnplloot
Now 1s the ttme for ell good people to come to the old

of their porty.

9. Scroll to the beginning of the Scrapbook to find the text item.

Ute the Scnfbook •• • plare to keep pictum, text, movies,

~d sound1 that you

w&ntlo attHt quic:kly.

• Build t gnphltt Ubncy

• Store your favorite tound• and moviet
• Keep aletterhet.d design to pute into your memos
• Stora • dt.trfbutlon lilt or o ther trequenUy wed tezt
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Press Command-C to Copy this text to the Clipboard. Use the Applications Menu to go to the SimpleText document where you typed "Now is
the time . .." Click the cursor inside the document after the phrase you
typed. Press Command-V to Paste the Scrapbook text into the document.

@11!!1

U.., tho Scnpbook as a place to keep pictures, text, movies. and sounds
that you Yfant to attest qulcltly.
• Build agraphia llbro.ry
• Stono your favorl to sounds and mov ies
• Keep a letterhead design to pute into your memos
• Stono a distribution lilt or other frequently used text
See your user's guide for mono information.

10. In the Scrapbook, scroll to the left until you come to the Sound item. Press
the Play Sound button you see in the viewing box.
11. Close the Scrapbool< window.

[]

<J~)
D ·- .

r-=.....

_

,.

_

.D

, , , .: SCIIoftd

ltu : 4IC
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SIMPLESOUND

Your computer comes with six standard Alert Sounds. SimpleSound is a utility
that allows you to record your own Alert Sounds. But, you must have a special
microphone that plugs into your particular model of computer. Read the
documentation that came with your computer to find out the type of microphone you need. One microphone does not fit all models.
II

Alert Suunds
Droplet
Indigo

~

Quack
I Slm'Die.DeiD..
Sosuml
WlldEep

1-;-

I

Rtoord Stop
0

PtWit

Pit~

JtoOndl

Maximum eeaonc:le
of recording time

llemove

~

I

SIIYI!

I

The eeconc:le appear
here ae you record

STICKlES

When Post-it Notes™ came out, people went bonkers with sticky notes that
could be stuck anywhere, for people to read.
All kidding aside, they are extremely handy, and now, in this computer age,
even the computer must have its own version. The version is called Stickies.
They are small notes, very similar to the Note Pad, that can be located on your
screen as if stuck there with an adhesive backing.

WElCOME TO STICKlES!

Business
Meeting at
9:00a.m.
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Stlokios lots you "Wr ltt notts (ltko
thtH) one! stlolc thorn to y...sorotn. You o.n uu Stlokits to jot
quick not.. , to "Wrlto romtndors,
or to storo froquont),j UHd tox t .
Yoor notos .,.. vlstblo 'Whontvor
tht Stlolclos program Is ~ttvo.
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Stickies have a few more features than the Note Pad. They can have their type
fonts and size changed, they can be be saved, imported and exported, and can
appear on your desktop at Startup, to act as a reminder of an appointment or

..

something you need to remember.

1[

New NOte
Oose

SdciCies Preferences ~:""=::'
Font:

I Chorcoal 1 :1

liifSeve All on deactivate

Size:

C!:ffi

0 Zoom-box colloP>O• vi""'""
Iii Launch at s~ptem startup

St~ie:

liif Plein

!if Confi r m vt""""'·cl03i"'l

0 Bold
0 ltellc
0 Underll ne

liif ...In the boclc9round

I Cancel) (:£:]

lcancell

Outline
0 Shoclov
0 Condenoed
0 u tended

m

88W

•s

SoveAII

0

.N

lmpor.fText...
Export Text...
Page Setup_
PrlntNof2_ •P
Print All NotesQuit

...

•Q

Using and Managing Stickies
1. Go to the Apple Menu and scroll down to the bottom of the menu to
access Stickies.
2. You will see several of the default Stickies, advertising what Stickies are all
about. Close each one of these, and when warned about closing them, do
not save them. You want to start a fresh with a new Stickie.
3. With the other Stickies gone, and still in the Stickie application, go to the
File menu and select New Note.
4. An empty Stickie will appear on the desktop. Click the cursor inside this
Stickie note, and type "Love is a many-splintered thing:'

~...,..,._,.

~'"io'i'

Lo.ve is a 'many splint: red thing l.
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5. Highlight the text and go up to the menu bar to pull down the Note menu.
You want to access the TeHt Style selection.

6. Set the Font for Helvetica Bold, and the Size to 18. Click OK.

1 ·.:.·;·~··'

.,:·· ·

cj

•

t'¥7-.~--~:....

f~B~<·. :::~~c'-'""~$1
Stille:

Iii Plein
[J Bold
E) Italic
[)Underline

1m Outll ne
liJ Sfledov
1iJ Condensed
8 Extended

l'tonce~;l RF::tte·.-~-1

7. Deselect the text, but click on the Stickie itsel£ Go to the menu bar and
pulldown the Color menu.

This will change the color of your Stickie. Set it to any other color that
appeals to you.
8. Leave this Stickie intact, and go back to the File menu to create a New
Note. An empty Stickie will appear. Go to New Note three more times and

create three more empty Stickies.
9. Select each empty Stickie and go to the Color menu to color them all

different colors.
10. Click on each of these empty Stickies and type whatever text you desire in

them. Highlight the text in each and use the Note->TeHt Style to set the
font and size to different settings.
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11. Go to the Edit->Preferences dialog box and click on the Launch at system
startup button
12. Do not Save your Stickies. This does not matter, until you try to dose each

Stickie. With the Stickies spread around your screen, go to the desktop and
do a Speciai->Restart.
13. When you computer starts again, and you come back to the desktop, you
will see your Stickies. This is one way of having reminders appear for the
next time you use the computer.
14. Close each Stickie, without saving.
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Talking with Other Computers

The Macinto:;h wa:; the
fir:;t popular computer to
have networking built in at
the factory. Today':;
computer:; often come
equipped with Ethernet,
which i:; the name of a very
popular networking
hardware and :;oftware
combination. The original
networking :;cheme built
into the Macinto:;h wa:;

called AppleTalk. It i:; :;till

The ability to communicate directly with someone else's computer is called
networking. Networking is a special function that uses a combination of
hardware and software. The hardware is built into your Macintosh, and the
/ s6ltware is installed when you first set up your computer.
NETWORKS

The first issue concerning networking is a built-in ability to let other people see
your system. This is called File Sharing. You can let people see absolutely
anything that happens to be on your hard drive(s), or you can let people see
only what you want them to. In most cases (since we all have our little secrets),
you will be limiting access to certain folders or drives. This way your secret
stuff remains secret, and your public stuff is readily accessible to other people
you might be working with.
A computer network is like a long line with different items "hanging" off it.
These items can be computers, printers, specialized modems, and other types
of devices.

built into the Mac, but

moe;t people in commercial
environment:; u:;e Ethernet
a:; their networking
method.

Many networks are built around something called a Server. A server is a computer that isn't used by individual operators running regular applications.
Servers are meant to be resources available to anyone working on the network,
and can provide centralized storage, or be used to run special programs, like
automation software, databases full of images, common text, and similar items.
Designer

Illust rator

Copywriter

Server
Scanning and Image Retouching

Printer

Networks allow people worki11g together;, a group to sltare files,
programs, a11d eve11 ce11tralized resources, suc/1 as pri11ters or servers.
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Using your Macintosh on a network is quite easy -like most other functions
on the machine, it's just a matter of pointing and clicking. As a matter of fact,
you really don't need a complex network and expensive file servers to network
two or more Macintosh computers. All you need is the appropriate cabling
(talk to your computer dealer for more information about setting up a mininetwork) and you can get started. Any two Macs can talk to each other right
In some of the screen

out of the box with an $8 cable.

images we use in the book,
there's a small icon in the

SETTING UP AUTHORIZED USERS AND GROUPS

menu bar.

There are two types of people that can access your machine, once you turn file
sharing on (which we'll get to in a minute). The first type is called a guest and

It's highly likely that you

the second is an authorized user. Guests are anonymous users- anyone that's

don't have this icon visible

connected to the network in your offices or building can access the system.

in your menu bar, because

Authorized users are people who need a password -

it's a commercially available

-

that only you can change

to access the system.

program called Stuffit.

There are times when you might let anyone on the network access certain stuff.

Written by a company

pictures, text, logos, and the like. Another instance where guest access might be
OK is when you're setting up a server that contains stuff that everyone in the

called Aladdin Software,
it's a very popular utility
program that allows you

to

compress files. Compression is important when you
have to move files around a

company needs.
Most of the time, though, you will set up each user as they need to access your
system. This way, you can deny them access simply by turning off their access
privileges.

lot over modems and the
internet, or if you just want

to save some space. In this
case, you can stuff a file
before you put it away.

PAGE 168

CHAPTER 3: CoNTROLLING YouR ENVIRON MENT

Setting Up Users
1. Go to your control panels, and select Users &> Groups. The Users &>
Gr oups dialog box will appear:

o ~

..... li

I

•

c::=~

1:!18

Users &Groups

....

Kind

-

d/ Guest

Queot user

wnor

[1]
I Ql ....., Uoer

I

IIP-G"UP

I

Ifijl

I

Opon

~ou,•1ue:te I

fV Oel•te
For security purposes, if
you're going to allow people

- ·-

access to your computer;
you shouldn't let them
change their own pass-

~

2. All Macintoshes that use file sharing or work on a network need to have
an owner. You can type in your name as the owner of this system.

words. All environments
operate slightly differently
concerning network
security, but in most larger

3. Click the New User button. Add a user named John down t h e hall. Assign
him an appropriate password. (You can always check the little box and let
him change it if he wants):

companies, only certain
network managers can
change passwords, set up
sharing, or allow access to
specific machines and
devices on the network.

0

. J John down the hall t
Show: !Identity

~I

~8

-

.._, IJohn clcrwn the hell
""-•••=!ouru3

I

I

Jia ~llw uoer to che1190 posNOrd

Security can be a major
issue, but it 's not within
the scope of this work. We

do suggest, though, that

you check with management before setting up a
network (if you're working in

a company environment).
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4. Before you put away this dialog box, click the Show pop-up menu at the
top of the window. Select Sharing from the list:
Show:

f4Gtffili1""j
Sharing

5. This dialog allows you to turn sharing on or off for this specific user. This
lets you have some users with access privileges, and others without:
B

D

I

~-tlfOf.-t iiUU~

I

g

Io~,__,.,......,....M...... u.., ..

~

I

6. Another check box at the bottom of the window would let John down the
hall actually launch applications from your system. This is rarely a good
idea, though, so we suggest you leave it alone for now.
7. Put away this dialog, and double-click Guest. Check the Sharing setup and
make sure that guests can access your computer:

0

-. Guest

I

Show: Sharing

~

8

I

FtleSherllliJ - - - - - - - -

lif Allw guests to connect to t hb oomputer

Progrtm Linking _ _ _ _ _ __

~0

All..., guests to Hnt to progrtms on this computer

8. Put away the dialogs when you're done.
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FILE SHARING

Now that you've set up users and guests, you can provide them with access to
specific areas of your system. To do this, you have to turn file sharing on, so
that it's active in memory. You do this by accessing the File Sharing control
panel.

Turning on File Sharing
1. Select File Sharing from the Control Panels menu. The File Sharing
dialog box will appear. It has two tabs: one for turning sharing on or off,
and another that you can use to monitor activity on your system.

~ Networ1c Identity
I I
Ol.lner Nome:

T

'" '" -.-,------

!•-

Ol.lner PaoNord:
Computer Nome: ~IAr~
c~ce:::;:ntre:::;l=::::._-----,

,.....
'-..1

Ale Shllrinu off

I Startj

Status _ _ _ _ _ _ _ _ _ __

IClick Start to turn on ftlut.rl~~q, This all...,. ott.r
I users t o - st.red folders.

~ Progr11m Unklnu off

-....;::;

Status _ __ _ _ _ _ _ __

~

_

Start to turn on PI"'OIram 11 nk:lng. This all...,. ott.r
Ir cllck
users to II nk to shared prOijra ms.

2. You can see the Owner's name, their password (which you cannot see
since it's blocked out), the name of the computer (which you can change),
and several buttons. Click the Start button. You will see a brief message
that says that file sharing is starting up, and then the icon will change:
ir'c;. File Sh11rlng on

1'-..1

~

Status
_
r elict Stop to turn off me ot.rl ng. Thts prevents other
users from accessing st. red folders .

I

3. Put away the dialog boxes when you're done- they don't have to be
visible for File Sharing to work.
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Sharing a Folder
1. Highlight the Project Folder that you created early on in the course. As

you probably remember, there are several folders -

most containing files

-within this folder.
2. Go to the File menu and select Sharing:

It might seem

to be a super

idea to buy one version of
an expensive program and
allow two or two thousand
users to access it simply by clicking that little

New folder
Open
Print
Move To Tr11sh X <iii
Close Window XW

Get Info
L11bel

ll

Duplicate
M11ke Alias
PutAway

;ji!V

Find-

ICF

Application•

.!.

~R

"Program Sharing" button.
It's not that easy though.
First, and most importantly, t he people who write
programs know about the
button, and their stuff

3. The dialog box that appears provides you with the ability to set all sorts of
access privileges for this folder:

won't work on more than
one machine at a time even though you might
think it will.

Secondly, letting someone
run an application from

ProJect Folder

tl. w..
0
r-0

r•:

Moi:HD:

can't move, rene me, or delete thfa Item
Shere th1o Item end ilo conton13 - - - - - - - - ,
Name

your computer means that
they will be using your CPU
(central processing unit) to
do the work of two ma-

il!!

IIYDer:

(Wally Cleaver

Uaer/Gr. . p: (<Hone>

Even10no

m

Prfvfl190

I; I ~
I : I F@J

F@J

Cop~ the.. prfvflegoo to all enclosed folclaro ~

chines. This translates to
your system running verrrry
slowly -

if at all. Only

certain types of programs
lend themselves to this

4. First of all, check the Can't moue, rename, or delete this item box. This
means that no one can accidentally (or otherwise) delete, rename, hide, or
lose this folder.

t ype of use (we haven't
found any yet).

PAGE 172

CHAPTER 3: CoNTROLLING YouR ENVIRONMENT

5. Next, click Share this item and its contents. That will activate the Owner
and User/ Group sections of the dialog. It's here where you can get fancy.
First, you can change the Owner of this specific folder (the one that gets to
change stufflike passwords and access privileges):

fii!ISh.orethbttemondlls..,ntonts - - - - - - ,'

You can access any system

ln1ooe

<Any U..r>
Ov~~er:

on the network simply by

Johndovnthe hall
User/Group:

going to the Chooaer and

_H

<Nona>

Everyone

I @)
I -- @)
F !I)

selecting AppleTalk. All the
Copy these prtvtleoes to an enclosed folders ~

available machines on the
network will show in the

. .. .

window:

~

D
·-·-•c:::J

-

6. For example, if you dick on the button to the right (the one that's called
Privileges), you can change the way a specific user can interface with this
folder:
0"''-·•-.w"''"'.. '"•

I

· 6JSIIu1tJC•t'-""''-CMI!I,.C.

...,. . . ~ ::.u:. .••

At this point, all you have

to do is double-click, and
sign on as a guest, or as a

-

Ow•r.l...=. Stntl ll
·t l

fY~!I.!!!!PI

lwr~••,:l.-.....,u••t

7. Or, let everyone (except you and old dufus) be able to put stuff into this
folder -like a public drop box- but not read from it:

registered user (which will
require a password). Once

l:l.

you do, the folder or hard

Where:

MacHO:

drive will appear on your
desktop -

just like any

D Can't move, rename, or delete thto ttem

other.

- !ii!l Shore thte Item end Its contents

---------,

m

PrtvilOQe
Ovner: I Herriet Stowe I ~ I ~
Nome

User/G~oup: ( Johndovntho hall I ~) ~ ill
Everyone

1.1 ll)

You can tell that a folder or
Copy these pr!vilooes to ell enclosed folders ~

drive is being shared,
because their icons change

to show that they're
connected to the network:

8. Lastly, the Copy button lets you set all the folders inside the Project Folder
to the same privileges as this one. You also have the option of setting them
all individually. When you're done, put the dialog box away.

1ltl

Project Folder
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I

Alley
A job printed using four colors of ink on one side of the sheet,
and one color of ink on the other.

The white space, or margin, between columns on a page.

Alpha Channel
An 8-bit channel of data that provides additional graphic
information, such as colors or masking. Alpha channels are
found in some illustration or graphics programs, and are used
in video production.

A job printed with four colors of ink on both sides of the
sheet. A full four-color project. See process colors, subtractive

color.

Acetate
A plastic material used to block or expose specific portions of
a layout through "windows" cut from the material by a
stripper. The resultant "masks" are used to generate film
separations for generating printing plates.

ANSI
The American National Standards Institute. ANSI establishes
and publishes industry standards in many fields including
data transmission and graphics.

Anti-aliasing

Achromatic
By definition, having no color; therefore, completely black or
white or some shade of gray.

A graphics software feature that eliminates or softens the
jaggedness oflow-resolution curved edges.

Apple Computer, Inc.

Acrobat
This program by Adobe Systems, Inc. converts any document
from any Macintosh or Windows application to PDF format,
which retains the page layout, graphics, color, and typography
of the original document. It is widely used for distributing
documents online because it is independent of computer
hardware. The only software needed is a copy of Acrobat
Reader, which can be downloaded free.

A computer manufacturer based in Cupertino, California.
Apple was responsible for the development of the Macintosh
computer and the first Postscript-equipped laser printer,
which ushered in the "desktop publishing" revolution.

Archival storage
The process of storing data in a totally secure and safe manner.
Archiving differs from backup in that it's meant to be used to
restore entire systems or networks, rather than providing
quick and easy access to specific files or folders.

Adaptive Palette
A sampling of colors taken directly from an image, and used in
a special compression process usually used to prepare images
for the world wide web.

Additive Color Process
The additive color process is the process of mixing red, green,
and blue light to achieve a wide range of colors, as on a color
television screen. See Subtractive Color.

Adjacent Color
The eye will respond to a strong adjacent color in such a way
as to affect the perception of the particular color in question.
That is, a color having different adjacent colors may look
different than it does in isolation. Also referred to as
metamarism.

Adobe Systems Incorporated
A major software developer responsible for the creation of the
PostScript page description language (see PostScript), used in
almost all graphic arts environments. PostScript resides in a
printer or Raster Image Processor (see Raster Image Processor)
and is used to convert graphics from the screen to highresolution output. Adobe also develops the highly popular
Photoshop, Illustrator, PageMaker, and Premiere graphics and
video applications, in addition to a range of others.

Airbrush
A tool driven by compressed air that applies a very fine spray
of color to artwork to produce various effects. Its effects are
simulated in digital illustration and imaging programs.

Algorithm
A specific sequence of mathematical steps to process data. A
portion of a computer program that calculates a specific
result.

Art
Illustrations and photographs in general; that is, all matter
other than text that appears in a mechanical.

Artifact
By definition, something that is artificial, or not meant to be
there. An artifact can be a blemish or dust spot on a piece of
film, or unsightly pixels in a digital image.

Ascender
Parts of a lower-case letter that exceed the height of the letter
"x~ The letters b, d, f, h, k, I, and t have ascenders.

ASCII
The American Standard Code for Information Interchange,
which defines each character, symbol, or special code as a
number from 0 to 255 (8 bits in binary). An ASCII text ftle can
be read by any computer, and is the basic mode of data
transmission on the Internet.

ATM (Adobe Type Manager)
A utility program which causes fonts to appear smooth on
screen at any point size. It's also used to manage font libraries.

Author's Alterations (A/As)
Changes made to the copy by the author after typesetting, and
thus chargeable to the author.

Backing Up
The process of making copies of current work or work-inprogress as a safety measure against file corruption, drive or
system failure, or accidental deletion. Backing up work-inprogress differs from creating an archive (see Archiving) for
long-term storage or system restoration.
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Hllchlant- Cap Line
Backslant
A name for characters that slant the opposite way from italic
characters.

Banding
A visible stair-stepping of shades in a gradient.

Banner
A large headline or title extending across the full page width,
or across a double-page spread.

Baseline
The implied reference line on which the bases of capital letters
sit

Bezier Curves
Curves that are defined mathematically (vectors), in contrast
to those drawn as a collection of dots or pixels (raster). The
advantage of these curves is that they can be scaled without
the "jaggies" inherent in enlarging bitmapped fonts or
graphics.

Binding
In general, the various methods used to secure signatures or
leaves in a book. Examples include saddle-stitching (the use of
staples in a folded spine), and perfect-bound (multiple sets of
folded pages sewn or glued into a flat spine).

Bit (Binary Digit)
The smallest unit of information in a computer, representing
one of two conditions, ON or OFF; HIGH or LOW, etc. Eight
bits comprise one byte. One byte can represent any text
character.

Bitmap
A rectangular array of dots that, taken together, form an
image. Bitmap ftle formats include: .BMP, .DIB, .GIF, .PCX
and .TIFF (see Raster Graphics).

Bitmapped
An image formed by a grid of dots or pixels whose curved
edges have discrete steps because of the approximation of the
curve by a finite number of pixels.

Black
The absence of color; an ink that absorbs all wavelengths of
light.

Blanket
The blanket, a fabric coated with natural or synthetic rubber
wrapped around the cylinder of an offset press, transfers the
inked image from the plate to the paper.

Bleed
Page data that extends beyond the trim marks on a page.
Illustrations that spread to the edge of the paper without
margins are referred to as "bled off."

Blind Emboss
A raised impression in paper made by a die, but without being
inked. It is visible only by its relief characteristic.

Blow up
An enlargement, usually of a graphic element such as a
photograph.
GLOSSARY 2

Body Copy
The text portion of the copy on a page, as distinguished from
headlines.

Boldface
A heavier, blacker version of a typeface.

Bond
A sized (coated) writing paper used for business or personal
stationery that normally has significant rag (cotton) content.

Border
A continuous line that extends around text; or a rectangular,
oval, or irregularly-shaped visual in an ad.

Bounding Box
The imaginary rectangle that encloses all sides of a graphic,
necessary for a page layout specification.

Brightness
1. A measure of the amount of light reflected from a surface. 2.
A paper property, defined as the percentage reflection of 457nanometer (nm ) radiation. 3. The intensity of a light source. 4.
The overall percentage of lightness in an image.

Bug
See Logo

Bullet
A marker preceding text, usually a solid dot, used to add
emphasis; generally indicates that the text is part of a list.

Burn
I. To expose an image onto a plate. 2. To make copies of ROM
chips or CD-ROMs. 3. To darken a specific portion of an
image through photographic exposure.

Byte
A unit of measure equal to eight bits (decimal256) of digital
information, sufficient to represent one text character. It is the
standard unit measure of ftle size. (See also Megabyte, Kilobyte,
and Gigabyte).

Calibration Bars
A strip of reference blocks of color o r tonal values used to
check the registration, quality, density, and ink coverage
during a print run.

Calibration
Making adjustments to a color monitor and other hardware
and software to make the monitor represent as closely as
possible the colors of the fmal printed piece.

Callout
A descriptive label referenced to a visual element, such as
several words connected to the element by an arrow.

Camera Ready
A completely finished mechanical, ready to be photographed
to produce a negative from which a printing plate will be
made.

Cap Line
The theoretical line to which the tops of capital letters are
aligned.

Caps and Small Caps
A style of typesetting in which capital letters are used in the
normal way, while the type that would normally be in lower
case has been changed to capital letters of a smaller point size.
A true small-caps typeface does not contain any lower-case
letters.

Caps
An abbreviation for capital letters.

Caption
The line o r lines of text that identify a picture o r illustration,
usually placed beneath it or otherwise in close proximity.

CD-ROM
A device used to store approximately 600MB of data. Files are
permanently stored on the device and can be copied to a disk
but not altered directly. ROM stands for Read-Only Memory.
Equipment is now available o n the consumer market for
copying computer files to blank CD- ROMs.

Character Count
The number of characters (letters, figures, signs or spaces) in a
selected block of copy. Once used to calculate the amount of text
that would fit on a given line or region when physically setting
type.

Choke
See Trapping

Chooser
A part of the Macintosh operating system that permits
selection of a printer or other peripheral device. Chooser is
also used to access resources on a network.

Chroma
The degree of saturation of a surface color in the Munsell
color space model.

Chromaticity Diagram
A graphical representation of two of the three dimensions of
color. Intended for plotting light sources rather than surface
colors. Often called the CIE diagram.

Cicero/Didot Point
The cicero is a unit of ho rizontal distance slightly larger than
the pica, used widely in continental Europe. A cicero equals
0. 178 inches, or 12 Didot points.

CIE (Commission Internationale de l'Edairage)
An international group that developed a universal set of color
definition standards in 1931.

CIEDiagram
See Chromnticity Diagram

Clip Art
Collections of predrawn and digitized images stored o n disk
that can be pasted into word processi ng and DTP documents.

Clipboard
The portion of computer memory that holds data that has
been cut or copied. The next item cut o r copied replaces the
data already in the clipboard.

Cloning
Duplication of pixels from o ne part of an image to another.

CMS
See Color Management System

CMYK (Cyan, Magenta, Yellow, Black)
The process colors (subtractive primaries) used in color
printing. The letter K stands for " Key," although it is commonly used to refer to the Black ink that is added to the three
colors when necessary. When printing black text as part of a
four-color process, only the black ink is used. A normal fourcolor separation will have a plate for each of the four colors.
When combined on the printed piece, the half-to ne dots of
each color give the impression of the desired color to the eye.

Coated
Print ing papers having a surface coating (of clay or other
material) to provide a smoother, more even finish with greater
opacity.

Cold type
Type produced by photographic or digital methods, as
opposed to the use of molten metal as in the old Linotype
machine.

Collate
To gather separate sections o r leaves of a publication together
in the correct order for binding.

Color Balance
The combination of yellow, magenta, and cyan needed to
produce a neutral gray. Determined through a gray balance
analysis.

Color Bars
See Color Control Strip

Color Cast
The modification of a hue by the addition of a trace of
another hue, such as yellowish green, pinkish blue, etc.
Normally, an unwanted effect that can be corrected.

Color Chart
A printed chart of various combinations of CMYK colors used
as an aid for the selection of"legal" colors during the design
phase of a project.

Color Control Strip
A printed strip of various reference colors used to control

printing quality. This strip is normally placed outside the
" trim" area of a project, as a guide and visual aid for the
pressman.

Color Conversion
Changing the color "m ode" of an image. Converting an image
fro m RGB to C MYK for purposes of preparing the image for
conventional printing.

Color Correction
The process of removing casts or unwanted tints in a scanned
image, in an effort to improve the appearance of the scan or to
correct obvious deficiencies, such as green skies or yellowish
skin tones.

GLOSSARY
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Color Gamut
The range of colors that can be formed by all possible
combinations of the colorants of a given reproduction system
(printing press) on a given type of paper.

Color Key
An overlay color proof of acetate sheets, one for each of the
four primary printing inks. The method was developed by 3M
Corporation and remains a copyrighted term.

Color Management System
A process or utility that attempts to manage color of input and
output devices in such a way that the monitor will match the
output of any CMS-managed printer.

Color Model
A system for describing color, such as RGB, HLS, CIELAB, or
CMYK.

Color Picker
A function within a graphics application that assists in
selecting a color.

Color Proof

Comp
Comprehensive artwork used to present the general color and
layout of a page.

Compose
To set copy into type, or lay out a page.

Compression
A digital technique used to reduce the size of a file by
analyzing occurrences of similar data. Compressed files
occupy less physical space, and their use improves digital
transmission speeds. Compression can sometimes result in a
loss of image quality and/or resolution.

Condensed Type
A typeface in which the width of the letters has been reduced.
Condensed type can be a specific font, or the result of
applying a percentage of normal width by a formatting
command.

Continuous Tone

A printed or simulated printed image of the color separations
intended to produce a close visual simulation of the final
reproduction for approval purposes.

Color Scanner
See Scanner

Color Separation
The process of splitting an image or PostScript into cyan,
magenta, yellow, and black components for offset printing.

Color Sequence
The color order of printing the cyan, magenta, yellow, and
black inks on a printing press. Sometimes called rotation or
color rotation.

Color Space
Because a color must be represented by three basic characteristics depending on the color model, the color space is a threedimensional coordinate system in which any color can be
represented as a point.

Color Temperature
The temperature, in degrees Kelvin, to which a blackbody
would have to be heated to produce a certain color radiation.
(A "blackbody" is an ideal body or surface that completely
absorbs or radiates energy.) The graphic arts viewing standard
is 5,000 K. The degree symbol is not used in the Kelvin scale.
The higher the color temperature, the bluer the light.

Color Transparency
A positive color photographic image on a d ear film base that
must be viewed by transmitted light. It is preferred for original
photographic art because it has higher resolution than a color
print. Transparency sizes range from 35mm color slides up to
8x10in. (203x254mm).

Colorimeter
An optical measuring instrument designed to measure and
quantify color. They are often used to match digital image
values to those of cloth and other physical samples.
GLOSSARY
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An image such as an original photograph in which the subject
has continuous shades of color or gray tones through the use
of an emulsion process. Continuous tone images must be
screened to create halftone images in order to be printed.

Contrast
The relationship between the dark and light areas of an image.

Copy
Any material furnished for reproduction such as text or
illustrations. As a verb, the computer command to copy data
to the clipboard in preparation for pasting it to another
location.

Copyfitting
Fitting a certain body of text to a given area by changing the
font size, leading, justification, or some other parameter.

Copyright
Ownership of a work by the originator, such as an author,
publisher, artist, or photographer. The right of copyright
permits the originator of material to prevent its use without
express permission or acknowledgement of the originator.
Copyright may be sold, transferred, or given up contractually.

CoreiDraw
A popular drawing program originally designed for the
Windows environment, but now available as a Macintosh
program. Corel is known to create files that can cause printing
and/or output problems in many environments.

Creep
An unwanted movement of the blanket of an offset printing
press that causes registration problems.

Cromalin
A single-sheet color proofing system introduced by DuPont in
1971 and still quite popular in the industry. It uses a series of
overlaid colorants and varnish to simulate the results of a
press run.

C.'rop

Crop Marks
Printed lines used for final trimming of a printed page.

Cropping
The elimination of parts of a photograph or other original
that are not required to be printed.

Dash
A short horizontal rule of varying lengths used to indicate a
pause or clause in a sentence; see En-dash and Em-dash.

DCS (Desktop Color Separation)
An EPS file format that creates one file for each of the four
primary printing inks, and a fifth file that contains a thumbnail of the image. DCS files are used for building pages with
layout programs; when the file is output, the small placement
image is discarded, and the four high-resolution files are
automatically substituted. This reduces the need to move
large, high-resolution files around a network.

Default
A specification for a mode of computer operation that
operates if no other is selected. For example, the default font
size might be 12 point, or a default color for an object might
be white with a black border.

Densitometer
An electronic instrument used to measure optical density.
Reflective (for paper) and transmissive (for film) versions are

available.

Density
The ability of a material to absorb light. In film, it refers to the
opacity of a specific area of the image. A maximum density of
4.0 refers to solid black. Improper density in film images can
result in washed-out or overly-dark reproduction.

Descender
The part of a lower-case letter that extends below the baseline
(lower edge of the x-height) of the letter. The letters y, p, g,
and j contain descenders.

Desktop
1. The area on a monitor screen on which the icons appear,
before an application is launched. 2. A reference to the size of
computer equipment (system unit, monitor, printer) that can
fit on a normal desk; thus, desktop publishing.

Desktop Publishing (DTP)
Use of a personal computer, software applications, and a highquality printer to produce fully composed printed documents.
DTP is, in reality, an incorrect term these days. In the early
days of Macintosh and PostScript technology, the term
Desktop Publishing inferred that the materials produced from
these systems was somehow inferior (as opposed to professional publishing). Now, the overwhelming majority of all
printed materials - regardless of the quality- are produced on
these systems, up to and including nationally famous
magazines, catalogs, posters, and newspapers.

Dialog Box
A window in a computer application that- in most casespresents an opportunity for the user to enter information
relative to the process that they're executing. A dialog box
might ask, for example, how many copies of a document you
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want to print, or what size a circle should be, or what color.
Dialog boxes are an integral part of today's graphic user
interfaces- both on the Macintosh and on Windows-based
systems.

Digital Camera
A camera which produces images directly into an electronic
file format for transfer to a computer.

Digital
The use of a series of discrete electronic pulses to represent
data. In digital imaging systems, 256 steps (8 bits, or 1 byte)
are normally used to characterize the gray scale or the
properties of one color. For text, see ASCII.

Digital Proofs
Digital proofs are representations of what a specific mechanical will look like when output and reproduced on a specific
type of printing press. The difference with a digital proof is
that it is created without the use of conventional film
processes and output directly from computer files.

Dingbat
A font character that displays a picture instead of a letter,
number or punctuation mark. There are entire font families of
pictographic dingbats; the most commonly used dingbat font
is Zapf Dingbats. There are dingbats for everything from the
little airplanes used to represent airports on a map, to
telephones, swashes, fish, stars, balloons- just about anything.

Direct-to-plate
Producing printing plates directly from computer output
without going through the film process.

Disk
A computer data storage device, either "floppy:• "hard:' or a
high-capacity removable disk, that stores data magnetically.

Disk Operating System (DOS)
Software for computer systems that supervises and controls
the running of programs. The operating system is loaded into
memory from disk by a small program which permanently
resides in the firmware within the computer. The major
operating systems in use today are Windows95 and
WindowsNT from Microsoft, the Macintosh OS from Apple
Computer, and a wide range of UNIX systems, such as those
from Silicon Graphics, SUN Microsystems, and other vendors.

Dithering
A technique used in images wherein a color is represented
using dots of two different colors displayed or printed very
dose together. Dithering is often used to compress digital
images, in special screening algorithms (see Stochastic
Screening) and to produce higher quality output on low-end
color printers.

Document
The general term for a computer file containing text and/or
graphics.

Dongle
A security device that usually plugs into your keyboard or
printer port, that allows copy-protected software to run on
your system. Such protected software will only run on systems
with the dongle present. This prevents a single copy of
·
software from running on any but one machine at a time.
GLOSSARY
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Dot Gain

Dye Transfer

The growth of a halftone dot that occurs whenever ink soaks
into paper. This growth can vary from being very small (on a
high-speed press with fast-drying ink and very non-porous
paper) to quite dramatic, as is the case in newspaper printing,
where a dot can expand 30% from its size on the film to the
size at which it dries. Failure to compensate for this gain in the
generation of digital images can result in very poor results on
press. Generally speaking, the finer the screen (and therefore,
the smaller the dot) the mo re noticable dot gain will be.

Double-page Spread
A design that spans the two pages visible to the reader at any
open spot in a magazine, periodical, or book.

Double-Click
Two clicks of a mouse button in rapid succession that are
interpreted as the command to open an application, ftle, or
folder.

Downloadable Fonts
Typefaces that can be stored on d isk and then downloaded to
the printer when required for printing.

DPI (Dots Per Inch)
The measurement of resolution for page printers, phototypesetting machines and graphics screens. Currently graphics
screens use resolutions of 60 to I 00 dpi, standard desktop
laser printers work at 600 dpi, and imagesetters operate at
more than 1,500 dpi.

Electrostatic
The method by which dry toner is transferred to paper in a
copier or laser printer, and liquid toners are bonded to paper
on some large-format color plotters.

Element
The smallest unit of a graphic, or a component of a page
layout or design. Any object, text block, or graphic might be
referred to as an element of the design.

Elliptical Dot Screen
A halftone screen having an elliptical dot structure.

Em Dash
A dash- often used in place of parentheses or commas to
break a sentence- that is usually equal to the point size. For
example, in 10 point type, an em dash would be 10 points
wide. Formerly the width of a capital M in a particular fo nt;
this definition is still used by some type foundries.

Em Space
A space usually equal to the current point size; in 10 point
type, an em space should be I 0 points wide. Formerly the
width of a capital M in a given font; this definition is still used
by some type found ries. Hot lead typesetters often used th is
space as the standard distance for a paragraph indent.

Embedding

Dragging
The process of moving an object on the screen by clicking on
it with the mouse, moving the cursor to another location, then
releasing the button.

I. Placing control codes in the body of a document. 2.
Including a complete copy of a text file or image within a
desktop publishing document, with or without a link (see

Linking).

Drop Cap
A large initial cap, usually set down into the block or body of
normal text. Excellent examples of ornate drop caps (called
illuminated initials) can often be seen in manuscripts
illustrated by hand in the Middle Ages.

Drop Shadow
A duplicate of a graphic element or type placed behind and
slightly offset from it, giving the effect of a shadow.

Drum Scanner
A color scanner on which the original is wrapped around a
rotary scanning drum. See Scanner.

DTP
See Desktop Publishing

Duotone
The separation of a black-and-white photograph into black
and a second color having different tonal values and screen
angles. Duotones are used to enhance photographic reproduction in two-, three-, or sometimes four-color work. Often the
second, third, and fourth colors are not standard CMYK inks.

Emulsion
The coating of light-sensitive material (silver halide) on a
piece of film.

En Dash
A dash- often used in hyphenated word pairs- that is usually
half the width of an em dash.

En Space
A space that is usually equal to half the width of an em space.

EPS (Encapsulated PostScript)
A file format used to transfer PostScript data within compatible applications. An EPS file normally contains a small
thumbnai l that's used to display the image when it's placed
into position within a mechanical or used by another
program. EPS files can contain text, vector artwork, and
images.

Ethernet
A set of software protocols wi~ely used in network communications.

Excel

Dye
A soluble coloring material, normally used as the colorant in
color photographs.

GLOSSARY

A photographic color print using special coated papers to
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A spreadsheet application produced by Microsoft; available
separately or as part of Microsoft Office.

E\·ccpt ion I Jict ionu ryException dictionary
A file, used within a spell-checking or hyphenation process,
that provides exceptions to standard spelling or justification
rules.

Expanded Type
Also called extended, a widened version of a typeface design.
Type may be extended artificially within a DTP application, or
designed as such by the typeface designer. See also Condensed

Type.

Export
To save a file generated in one application in a format that is
readable in another application.

Extension
A modular software program that extends or expands the
functions of a larger program. A folder of Extensions is found
in the Macintosh System Folder.

Fill
To add a tone or color to the area inside a closed object in a
graphic illustration program.

Film
Non-paper output of an imagesetter or phototypesetter.

Filter
In image editing applications, a small program that creates a
special effect or performs some other function within an
image.

Flat
A group of individual camera-ready pages mounted in the
proper order and ready for photographing to produce a
signature plate.

Flat Color
Color that lacks contrast or tonal variation.

Flatbed Scanner
A scanner on which the original is mounted on a flat scanning
glass. See Scanner.

Flexography
A rotary letterpress process printing from rubber or flexible
plates and using fast drying inks. Mainly used for packaging.

Floating Accent
A separate accent mark that can be placed under or over
another character. Complex accented characters such as in
foreign languages are usually available in a font as a single
character.

Flop
To make a mirror image of visuals such as photographs or clip
art.

Flush Left
Copy aligned along the left margin.

Flush Right
Copy aligned along the right margin.

Folder
1. The digital equivalent of a paper file

folder, used to organize
files in the Macintosh and Wmdows operating systems. The

c; IF

icon of a folder looks like a paper file folder. Double-clicking it
opens it to reveal the files stored inside. 2. A mechanical device
which folds preprinted pages into various formats, such as a
tri-fold brochure.

Font
A font is the complete collection of all the characters (numbers, uppercase and lowercase letters and, in some cases, small
caps and symbols) of a given typeface in a specific style; for
example, Helvetica Bold.

Force Justify
A type alignment command which causes the space between
letters and words in a line of type to expand to fit within a
line. Often used in headlines, and sometimes used to force the
last line of a justified paragraph, which is normally set flush
left, to justify.

Four-color Process
See Process Colors

FPO
"For Position Only": a low-resolution graphic or simple box to
designate the location of a graphic in the final file.

Frame
In desktop publishing, an area or block into which text or
graphics can be placed.

FreeHand
A popular vector-based illustration program available from
Macromedia.

Full Measure
A line set to the entire line length.

Galley Proof
Proofs, usually of type, taken before the type is made up into
pages. Before desktop publishing, galley proofs were handassembled into pages.

Gamma Correction
1. Adjusting the contrast of the midtones in an image. 2.
Calibrating a monitor so that midtones are correctly displayed
on screen.

Gamma
A measure of the contrast, or range of tonal variation, of the
midtones in a photographic image

Gamut
See Color Gamut

GASP
Acronym for Graphic Arts Service Provider, a firm that
provides a range of services somewhere on the continuum
from design to fulfillment.

GCR (Gray component replacement)
A technique for adding detail by reducing the amount of cyan,
magenta, and yellow in chromatic or colored areas, replacing
them with black.

GIF - Graphics Interface File
A CompuServe graphics file format that is used widely for
graphic elements in Web pages.
GLOSSARY
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Hairline Rule

G (Gigabyte)
30

One billion ( 1,073,74 1,824) bytes (2

)

or 1,048,576 kilobytes.

Global Preferences
Preference settings which affect all newly created files within
an application.

Gradation
A smooth transition between black and white, one color and
another, or color and no-color.

Gradient

Halftone
An image generated for use in printing in which a range of
continuous tones is simulated by an array of dots that create
the illusion of continuous tone when seen at a distance.

Halftone Tint

A fill pattern that goes from dark to light or light to dark, or
from one color or shape to another.

Grain

An area covered with a uniform halftone dot size to produce

an even tone or color. Also called tint or screen tint.

Hanging Indent

Silver salts clumped together in differing amounts in different
types of photographic emulsions. Generally speaking, faster
emulsions have larger grain sizes.

Graininess

Formatting text so that the first line is not indented, and all
subsequent lines within the paragraph are indented. Often
used with bullets.

Hanging punctuation

Visual impression of the irregularly distributed silver grain
clumps in a photographic image, or the ink film in a printed
image.

Gray Balance
The values for the yellow, magenta, and cyan inks that are
needed to produce a neutral gray when printed at a normal
density.

Gray Component Replacement
See GCR

GrayScale
An image containing a series of tones stepped from white to

black that is used for monitoring tone reproduction.

Grayscale
An image composed in grays ranging from black to white,

usually using 256 different shades of gray.

Greeking
1. A software technique by which areas of gray are used to
simulate lines of text below a certain point size. 2. Nonsense
text use to define a layout before copy is available.

Grid
A division of a page by horizontal and vertical guides into
areas into which text or graphics may be placed accurately.

Group
To collect graphic elements together so that an operation may
be applied to all of them simultaneously.

GUI
Acronym for Graphical User Interface, the basis of the
Macintosh and Windows operating systems.

Guides
Lines created in layout application programs to assist in
aligning various design elements.

Punctuation marks such as quotation marks that are set
outside the text block; similar to a hanging indent.

HardCopy
A tangible permanent image such as an original, a proof, or a
printed sheet.

Hard Drive
A rigid disk sealed inside an airtight transport mechanism that
is the basic storage mechanism in a computer. Information
stored may be accessed more rapidly than on floppy disks and
far greater amounts of data may be stored.

Hard Return
A manual line ending (created by pressing the Return or Enter
key) that denotes the end of a paragraph.

Header
A fixed body of copy that appears at the top of each page of a
section of a book. It may contain variable quantities such as
page number, time, date, or file name.

Hide
A command in DTP applications that will render certain
elements on the screen invisible, but will not remove them
from the file.

High Key
A photographic or printed image in which the main interest
area lies in the highlight end of the scale.

High Resolution File
An image file that typically contains four pixels for every dot
in the printed reproduction. High-resolution files are often
linked to a page layout file, but not actually embedded in it,
due to their large size.

Highlights
The lightest areas in a photograph or illustration.

HLS

Gutter
The white space between two facing pages. Sometimes used
interchangeably with Alley to describe the space between
columns on a page.
GLOSSARY
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Color model based on three coordinates: hue, lightness (or
luminance), and saturation.

HSV
A color model based on three coordinates: hue, saturation and
value (or luminance).

Intensity
Synonym fo r degree of color saturation.

International Paper Sizes

HTML (HyPerText Markup Language)

The International Standards Organization (ISO) system of
paper sizes is based on a series of three sizes A, B and C. Series
A is used for general printing and stationery, Series B for
posters, and Series C for envelopes. Each size has the same
proportion of length to width as the others. The nearest ISO
paper size to conventional 8-1/2 x 11 paper is A4.

The language, written in plain (ASCII) text using simple tags,
that is used to create Web pages, and which Web browsers are
designed to read and display. HTML focuses more on the
logical structure of a page than its appearance.

Hue
The wavelength of light of a color in its purest state (without
adding white or black).

HyPerlink
An HTML tag that directs the computer to a different Anchor
or URL (Uniform Resource Locator). The linked data may be
on the same page, or on a computer anywhere in the world.

HyPhenation Zone
The space at the end of a line of text in which the hyphenation
function will examine the word to determine whether or not it
should be hyphenated and wrapped to the next line.

Icon
A small graphic symbol used on the screen to indicate files or
folders, activated by clicking with the mouse or pointing device.

Illustrator
A vector editing application owned by Adobe Systems, Inc.

Imagesetter
A raster-based laser device used to output a computer pagelayout file or composition at high resolution onto photographic paper o r fUm, from which to make printing plates.

Import
To bring a file generated within one application into another
applicatio n.

Imposition
The arrangement of pages on a printed sheet, which, when the
sheet is finally printed, folded and trimmed, will place the
pages in their correct order.

Indent
A typographical technique that lines up the beginnings or
ends oflines at a position other than the preset margin.

Indexing
In DTP, marking certain words within a document with
hidden codes so that an index may be automatically generated.

Indexed Color Image
An image which uses a limited, predetermined number of
colors; often used in Web images. See also GIF.

Initial Caps
Text in which the first letter of each word (except articles, etc.)
is capitalized.

Inline Graphic
A graphic that is inserted within a body of text, and may be
formatted using normal text commands for justification and
leading; inline graphics will move with the body of text in
which they are placed.

ISO
The International Standards Organization.

Italics
A version of a typeface designed with letters slanted to the
right.

Jaggies
Visible steps in the curved edge of a graphic or text character
that results from enlarging a bitmapped image.

JPGorJPEG
A compression algorithm that reduces the file size of
bit mapped images, named for the Joint Photographic Experts
Group, an industry organization that created the standard;
JPEG is a "lossy" compression method, and image quality will
be reduced in direct proportion to the amount of compressio n.

Justification
The alignment of text along a margin o r both margins..

Kelvin (K)
Unit of temperature measurement based on Celsius degrees,
starting from absolute zero, which is equivalent to -273 Celsius
(centigrade); used to indicate the color temperature of a light
source.

Kerning
Moving a pair of letters closer together or farther apart, to
achieve a better fit or appearance.

Key (Black Plate)
In early fou r-color printing, the black plate was printed first
and the other three colors were aligned (or registered) to it.
Thus, the black plate was the "key" to the result.

Kilobyte (K, KB)
1,024 ( 210 ) bytes, the nearest binary equivalent to decimal
1,000 bytes. Abbreviated and referred to as K.

Knockout
A shape or object printed by elim inating (knocking out) all
background colors. See Overprinting.

L*a*b
The lightness, red-green attribute, and yellow-blue attribute in
the CIE Color Space, a three-dimensional color mapping
system.

Landscape
Printing from the left to right across the wider side of the
page. A landscape o rientation treats a page as 11 inches wide
and 8.5 inches long.
GLOSSARY
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Laser printer
A high quality image printing system using a laser beam to
produce an image on a photosensitive drum. The image is
transferred to paper by a conventional xerographic printing
process. Current laser printers used for desktop publishing
have a resolution of 600 dpi. Imagesetters are also laser
printers, but with higher resolution and tight mechanical
controls to produce final film separations for commercial
printing.

Layer
A function of graphics applications in which elements may be
isolated from each other, so that a group of elements may be
hidden from view, locked, reordered or otherwise manipulated
as a unit, without affecting other elements on the page.

Layout

Linking
An association through software of a graphic or text file on
disk with its location in a document. That location may be
represented by a "placeholder" rectangle, or a low-resolution
copy of the graphic.

Linotype
A typecasting machine (now obsolete) that injected hot metal
into a line of molds to produce lines of type. After printing,
the type was melted and used again.

Linotype-Hell
The manufacturer of imagesetters such as the Linotronic that
process PostScript data through an external Raster Image
Processor (RIP) to produce high resolution film for printing.

Lithography
A mechanical printing process used for centuries based on the
principle of the natural aversion of water (in this case, ink) to
grease. In modern offset lithography, the image on a photosensitive plate is first transferred to the blanket of a rotating
drum, and then to the paper.

The arrangement of text and graphics on a page, usually
produced in the preliminary design stage.

Leading ("ledding,)
Space added between lines of type. Usually measured in points
or fractions of points. Named after the strips of lead which
used to be inserted between lines of metal type. In specifying
type, lines of 12-pt. type separated by a 14-pt. space is
abbreviated " 12/14," or "twelve over fourteen."

Leaders
A line of periods or other symbols connecting the end of a
group of words with another element separated by some
space. For example, a table of contents may consist of a series
of phrases on separate lines, each associated with a page
number. Promotes readability in long lists of tabular text.

Letterspacing

Logo
A graphic element normally used as a design to represent a
company or product.

Lossy
A data compression method characterized by the loss of some
data.

Loupe
A small free-standing magnifier used to see fine detail on a
page. See Linen Tester.

Lowercase

The insertion or addition of white space between the letters of
words.

The uncapitalized letters of the alphabet; so named when type
was composed by hand, and the small letters were in the lower
part of the type case.

Library
In the computer world, a collection of files having a similar
purpose or function.

Ligature
Letters that are joined together as a single unit of type such as
oe and fi.

Lightness
The property that distinguishes white from gray or black, and
light from dark color tones on a surface.

Line Art
A drawing or piece of black and white artwork, with no
screens. Line art can be represented by a graphic file having
only one-bit resolution.

Line Screen
The number of lines per inch used when converting a
photograph to a halftone. Typical values range from 85 for
newspaper work to 150 or higher for high-quality reproduction on smooth or coated paper.

Linen Tester
A magnifying glass designed for checking the dot image of a
halftone. See Loupe.
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LPI
Lines per inch. See Line Screen.

Luminosity
The amount of light, or brightness, in an image. Part of the
HLS color model.

LZW
The acronym for the Lempel-Ziv-Welch lossless data- and
image-compression algorithm.

M, MB (Megabyte)
One million (1,048,576) bytes (220 ) o r 1,024 Kilobytes.

Macro
A set of keystrokes that is saved as a named computer file.
When accessed, the keystrokes will be performed. Macros are
used to perform repetitive tasks.

Manuscript (MS or Mss)
The original written or typewritten work of an author
submitted for publication.

Margins
The non-printing areas of page, or the line at which text starts
or stops.

Markup
To prepare copy for a compositor, setting out in detail all the
typesetting instructions, or to denote corrections on a printed
proof.

Mask
To conform the shape of a photograph or illustration to
another shape such as a circle or polygon.

Masking
A digital technique that blocks an area of an image from
reproduction by superimposin g an opaque object of any
shape.

Master Page
A page that holds repeating elements of a layout, such as
guides or graphics.

Match Print
A color proofing system used for the fin al quality check.

Mechanical
A pasted-up page of camera-ready art that is to be photographed to produce a plate for the press.

Mechanical Dot Gain
See Dot Gain

Medium
A physical carrier of data such as a CD-ROM, video cassette,
or floppy disk, or a carrier of electronic data such as fiber
optic cable or electric wires.

Megabyte (MB)
A unit of measure of stored data equaling 1,024 kilobytes, or
1,048,576 bytes (10 20 ) .

Megahertz
An analog signal frequency of one million cycles per second,
or a data rate of one million bits per second. Used in specifying computer CPU speed.

Menu
A list of choices of functions, or of items such as fonts. In
contemporary software design, there is often a fixed menu of
basic functions at the top of the page that have pull-down
menus associated with each of the fixed choices.

Menu-driven
Programs which allow the user to request functions by
choosing from a list of options.

Metafile
A class of graphics that combines the characteristics of raster
and vector graphics formats; not recommended for highquality output.

Metallic Ink
Printing inks which produce an effect of gold, silver, bronze, or
metallic colors.

Midtones or Middletones
The tonal range between highlights and shadows.

Mock-up

Modem
An electronic device for converting digital data into analog
audio signals and back again (MOdulator-DEModulator.)
Primarily used for transmitting data between computers over
analog (audio frequency) telephone lines.

Moire
An interference pattern caused by the out-of-register overlap
of two or more regular patterns such as dots or lines. In
process-color printing, screen angles are selected to minimize
this pattern.

Monochrome
An image or computer monitor in which all information is
represented in black and white, or with a range of grays.

Monospace
A font in which all characters occupy the same amount of
horizontal width regardless of the character. See also Propor-

tional Spacing.

Montage
A single image formed by assembling or compositing several
images.

Mottle
Uneven color or tone.

Mss
See Manuscript

Multimedia
The combination of sound, video images, and text to create a
"moving" presentation.

Network
Two or more computers that are linked to exchange data or
share resources. The Internet is a network of networks.

Neutral
Any color that has no hue, such as white, gray, or black.

Neutral Density
A term that describes images or filters that are gray with no
apparent hue.

Noise
Unwanted signals or data that may reduce the quality of the
output.

Non-breaking Space
A typographic command that connects two words with a
space, but prevents the words from being broken apart if the
space occurs within the hypenation zone. See Hyphenation

Zone.

Nonreproducible Colors
Colors in an original scene or photograph that are impossible
to reproduce using process inks. Also called out-of-gamut
colors.

Normal Key
A description of an image in which the main interest area is in
the middle range of the tone scale or distributed throughout
the entire tonal range.

The rough concept or layout of a publication or design.
GLOSSARY 11

,\!orion l 't ifit ic:; - Pcr:;pcd il'c
Norton Utilities
A software product that provides programs for maintaining a
computer's hardware or software; for example, locating and
restoring a file that was accidentally "erased."

Nudge
To move a graphic or text element in small, preset increments,
usually with the arrow keys.

Oblique
A slanted character (sometimes backwards, or to the left),
often used when referring to italic versions of sans-serif
typefaces.

OCR (Optical Character Recognition)
A special kind of scanner software that provides a means of
reading printed characters on documents and converting them
into digital codes that can be read into a computer as actual
editable text rather than pure images.

Offset
In graphics manipulation, to move a copy or clone of an
image slightly to the side and/or back; used for a drop-shadow
effect.

Offset Lithography
A printing method whereby the image is transferred from a
plate onto a rubber-covered cylinder from which the printing
takes place (see Lithography).

OLE
Object Linking and Embedding, a software technique that
permits linking an object in a document to its original file and
enabling automatic updating. OLE applications may be OLE
containers (able to accept OLE documents) or OLE servers
(able to create OLE documents), or both.

Opacity
I. The degree to which paper will show print through it. 2.
Settings in certain graphics applications that allow images or
text below the object whose opacity has been adjusted, to show
through.

OPI
Open Prepress Interface, a software device that is an extension
to PostScript that replaces low-resolution placeholder images
in a document with their high-resolution sources for printing.

Optical Disks
Video disks that store large amounts of data used primarily for
reference works such as dictionaries and encyclopedias.

Orphan
The last line of a paragraph that appears alone at the top of a
column or page.

Outline
A typeface in which the letters have outlines only and no fill.

Overlay
A transparent sheet used in the preparation of multicolor
mechanical artwork showing the color breakdown.

Overprint Color
A color made by overprinting any two or more of the primary
yellow, magenta, and cyan process colors.
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Overprinting
Allowing an element to print over the top of underlying
elements, rather than knocking them out (see Knockout).
Often used with black type.

Page Description Language (PDL)
A special form of programming language that describes both
text and graphics (object or bit-image) in mathematical form.
The main benefit of a POL is that makes the application
software independent of the physical printing device.
PostScript is a PDL, for example.

Page Layout Software
Desktop publishing software such as PageMaker or
QuarkXpress used to combine various source documents and
images into a high quality publication.

Page Proofs
Proofs of the actual pages of a document, usually produced
just before printing, for a final quality check.

PageMaker
A popular page-layout application produced by Adobe
Systems.

Palette
1. As derived from the term in the traditional art world, a
collection of selectable colors. 2. Another name for a dialog
box or menu of choices.

Panose
A typeface matching system for font substitution based on a
numeric classification of fonts according to visual characteristics.

Pantone Matching System
A system for specifying colors by number for both coated and
uncoated paper; used by print services and in color desktop
publishing to assure uniform color matching.

Pasteboard
In a page layout program, the desktop area outside of the
printing page area, on which elements can be placed for later
positioning on any page.

PCX
Bitmap image format produced by paint programs.

PDF (Portable Document Format)
Developed by Adobe Systems, Inc. (and read by Adobe
Acrobat Reader), this format has become a de facto standard
for document transfer across platforms.

PDL
See Page Description Language

Perfect binding
A common method of binding paperback books in which the
pages are glued directly to the binding.

Perspective
The effect of distance in an image achieved by aligning the
edges of elements with imaginary lines directed toward one to
three "vanishing points" on the horizon.

Photoshop

PostScript

The Adobe Systems image editing program commonly used
for color correction and special effects on both the Macintosh
and PC platforms.

A page description language developed by Adobe Systems, Inc.
that describes type and/or images and their positional
relationships upon the page; the resulting file is processed by a
RIP (see Raster Image Processor) into a format a laser printer
or imagesetter can understand.

Pi Fonts
A collection of special characters such as timetable symbols
and mathematical signs. Examples are Zapf Dingbats and
Symbol. See also Dingbats.

PPD
Acronym for PostScript Printer Definition file, the information that ensures that output remains within the capabilities of
the selected output device.

Pica
A traditional typographic measurement of 12 points, or
approximately 1/6 of an inch. Most DTP applications specify a
pica as exactly 1/6 of an inch.

PICT/PICT2
A common format for defining bitmapped images on the
Macintosh. The more recent PICT2 format supports 24-bit
color.

Pixel
A picture element - the smallest dot or unit on a computer
monitor or in a bitmapped image.

Plate
Paper, polyester, or metal sheet used in a printing press to
transfer an image onto paper.

PMS
See Pantone Matching System

PMT
Photo Mechanical Transfer- positive prints of text or images
used for paste-up to mechanicals.

Point
A unit of measurement used to specify type size and rule
weight, equal to (approximately, in traditional typesetting)
1172 inch.

Polygon
A geometric figure consisting of three or more straight lines
enclosing an area. The triangle, square, rectangle, and star are
all polygons.

Portrait
Printing from left to right across the narrow side of the page.
Portrait orientation on a letter-size page uses a standard 8.5inch width and 11-inch length.

Positive
A true photographic image of the original made on paper or
film.

Posterize, Posterization
The deliberate constraint of a gradient or image into visible
steps as a special effect; or the unintentional creation of steps
in an image due to a high LPI value used with a low printer
DPI.

Postprocessing Applications
Applications, such as trapping programs or imposition
software, that perform their functions after the image has been
printed to a file, rather than in the originating application.

PPI
Pixels per inch; used to denote the resolution of an image.

Prepress
All work done between writing and printing, such as typesetting, scanning, layout, and imposition.

Preferences
A set of defaults for an application program that may be
modified.

Prepress Proof
A color proof made directly from electronic data or film
images.

Primary Colors
Colors that can be used to generate secondary colors. For the
additive system (i.e., a computer monitor), these colors are
red, green, and blue. For the subtractive system (i.e., the
printing process), these colors are yellow, magenta, and cyan.

Printer Command Language
PCL - a language, that has graphics capability, developed by
Hewlett Packard for use with its own range of printers.

Printer fonts
The image outlines for type in PostScript that are sent to the
printer.

Printers Spreads
Pages arranged so that, when printed as spreads and assembled, the pages appear in the proper order. For example,
the front and back covers are printed on a spread, the inside
front and inside back covers are printed on another spread,
etc.

Process Colors
The four colors (cyan, magenta, yellow, and black) that are
combined to print a wide range of colors. When blended, they
can reproduce many, but not all of the colors found in nature.
See also CMYK.

Profile
A file containing data representing the color reproduction
characteristics of a device determined by a calibration of some
sort.

Proof
A representation of the printed job that is made from plates

(press proof), film, or electronic data (prepress proofs).It is
generally used for customer inspection and approval before
mass production begins.
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Proportional Spacing
A method of spacing whereby each character is spaced to
accommodate the varying widths of letters or figures, thus
increasing readability. Books and magazines are set proportionally spaced, and most fonts in desktop publishing are
proportional. With proportionally spaced fonts, each character
is given a horizontal space proportional to its size. For
example, a proportionally spaced "m" is wider than an "i."

Reference Marks
Symbols such as the asterisk (*), dagger, double dagger, section
mark(§), and paragraph mark(~) used in text to direct the
reader to a footnote.

Reflective Art
Artwork that is opaque, as opposed to transparent, that can be
scanned for input to a computer.

Registration

Pt.

Aligning plates on a multicolor printing press so that the
images will superimpose properly to produce the required
composite output.

Abbreviation for point.

Pull Quote
A phrase extracted from the copy and used as a graphic to
break up a quantity of text visually, and to call attention to an
important point.

Registration Color
A default color selection that can be applied to design
elements so that they will print on every separation from a
PostScript printer. " Registration" is often used to print
identification text that will appear outside the page area on a
set of separations.

QuarkXPress
A popular page-layout application.

Queue
A set of files input to the printer, printed in the order received
unless otherwise instructed.

Registration Marks
Small crosshairs on fUm used to align the individual layers of
film separations.

QuickDraw
Graphic routines in the Macintosh used for outputting text
and images to printers not compatible with PostScript.

Resolution
The number of dots or pixels per inch of a monitor or output
device.

Ragged Left
See Flush Right

Retouching
Making selective manual or electronic corrections to images.

Ragged Right
See Flush Left

Reverse Out
To reproduce an object as white, or paper, within a solid
background, such as white letters in a black rectangle.

RAM
Random Access Memory, the "working" memory of a
computer that holds files in process. Files in RAM are lost
when the computer is turned off, whereas files stored on the
hard drive or floppy disks remain available.

Raster

RGB
Red, Green, Blue, the additive primary colors used to create
images on a computer monitor or television screen.

Rich Black

A bit mapped representation of graphic data.

A process color consisting of sold black with one or more
layers of cyan, magenta, or yellow.

Raster Graphics
A class of graphics created and organized in a rectangular
array using bitmaps. Often created by paint software, fax
machines, or scanners.

Raster Image Processor (RIP)

Right Reading
A positive or negative image that is readable from top to
bottom and from left to right.

Right-Click

That part of an imagesetter that converts the page information
from the Page Description Language into the bitmap pattern
that is applied to the film or paper output.

Rasterize
Converting mathematical and digital information into a series
of dots by an imagesetter for the production of negative or
positive film or paper output

Ray Tracing
A software technique for rendering the surface of a reflecting
object realistically by tracing the light rays from the source of
illumination to the eye of the viewer.

Reader's Spreads
A two-page spread as seen by the reader after printing and
collation; thus, the two pages may have been printed in
separate locations on the signature.
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Clicking the right mouse button on a Windows system, usually
to reveal a pop-up menu. A Macintosh mouse has only one
button.

RIP
See Raster Image Processor

River
An accidental and undesirable pattern of white space between
words in text that appears to flow from one corner to another.

ROM
Read Only Memory, a semiconductor chip in the computer
that retains startup information for use the next time the
computer is turned on.

Roman Type
The primary serif typeface of a family.
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Rosette
The pattern created when color halftone screens are printed at
traditional screen angles.

Rotation
Turning an object at some angle to its original axis.

RTF
Rich Text Format, a text format that retains formatting
information lost in pure ASCII text.

Rubylith
A two-layer acetate film having a red or amber emulsion on a
clear base used in non-computer stripping and separation
operations.

Ruler
Rulers displayed at two sides of the working space on a
monitor that show measurements in units that can be selected
in the set-up process.

Running Head
A line of type at the top of a page that repeats the same
information. Also called header.

SIS (Same Size)
An instruction to the printer to reproduce at the same size as
the original.

Sans Serif
Sans Serif fonts are fonts that do not have the tiny lines that
appear at the top of and bottom of letters.

Saturation
The intensity or purity of a particular color; a color with no
saturation is gray.

Scaling
The means within a program to reduce or enlarge the amount
of space an image will occupy by multiplying the data by a
scale factor. Scaling can be proportional, or in one dimension
only.

Scanner
A device that electronically digitizes images point by point
through circuits that can correct color, manipulate tones, and
enhance detail. Color scanners will usually produce a
minimum of 24 bits for each pixel, with 8 bits each for red,
green, and blue.

Screen
To create a halftone of a continuous tone image (See Halftone).

Screen Angle
The angle at which the rulings of a halftone screen are set
when making screened images for halftone process-color
printing. The equivalent effect can be obtained electronically
through selection of the desired angle from a menu.

Screen Frequency
The number of lines per inch in a halftone screen, which may
vary from 85 to 300.

Screen Printing
A technique for printing on practically any surface using a fine
mesh (originally of silk) on which the image has been placed
photographically. Preparation of art for screen printing
requires consideration of the resolution of the screen printing
process.

Screen Shot
A printed output or saved file that represents data from a
computer monitor.

Screen Tint
A halftone screen pattern of all the same dot size that creates
an even tone at some percentage of solid color.

Script
A typeface designed to imitate handwriting.

SCSI
Small Computer Systems Interface, a standard software
protocol for connecting peripheral devices to a computer for
fast data transfer.

Selection
The act of placing the cursor on an object and clicking the
mouse button to make the object active.

Self-Cover
A cover for a document in which the cover is of the same
paper stock as the rest of the piece.

Serif
A line or curve projecting from the end of a letter form.
Typefaces designed with such projections are called serif faces.

Service Bureau
A business that specializes in producing film for printing on a
high- resolution imagesetter.

Set Solid
Type set with no extra spacing between the lines; for example,
12-pt. type with 12-pt.leading, or 12/12.

SGML
Standard Generalized Markup Language, a set of semantics
and syntax that describes the structure of a document (the
nature, content, or function of the data) as opposed to visual
appearance. HTML is a subset of SGML (see HTML).

Sharpness
The subjective impression of the density difference between
two tones at their boundary, interpreted as fineness of detail.

Sheet Fed
A printing press that prints single sheets of paper rather than
from a continuous roll.

Shortcut
1. A quick method for accessing a menu item or command,
usually through a series of keystrokes. 2. The icon that can be
created in Windows95 to open an application without having
to penetrate layers of various folders. The equivalent in the
Macintosh is the "alias."
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Show
The opposite of"Hide:' a toggle command. For example, the
tabs and paragraph marks in a text document can either be
shown or hidden by clicking on an icon in the toolbar.

Sidebar
Supplementary text positioned at the side of a page.

Signature
A group of pages ganged together on a large, single sheet for
printing, usually comprising an individual section of a
publication.

Silhouette
To remove part of the background of a photograph or
illustration, leaving only the desired portion.

Skew
A transformation command that slants an object at an angle
to the side from its initial fixed base.

Small caps
A type style in which lowercase letters are replaced by
uppercase letters set in a smaller point size.

Smart Quotes
The curly quotation marks used by typographers, as opposed
to the straight marks on the typewriter. Use of smart quotes is
usually a setup option in a word processing program or page
layout application.

Snap-to (guides or rulers)
An optional feature in page layout programs that drives
objects to line up with guides or margins if they are within a
pixel range that can be set. This eliminates the need for very
precise, manual placement of an object with the mouse.

Soft Font
See Downloadable Font

Soft or Discretionary Hyphen
A hyphen that is coded for display and printing only when
formatting of the text puts the hyphenated word at the end of
aline.

Soft Return
A return command that ends a line but does not apply a
paragraph mark that would end the continuity of the style for
that paragraph.

Spectrophotometer
An instrument for measuring the relative intensity of
radiation reflected or transmitted by a sample over the
spectrum.

Specular Highlight
The lightest highlight area that does not carry any detail, such
as reflections from glass or polished metal. Normally, these
areas are reproduced as unprinted white paper.

Spine
The binding edge at the back of a book that contains title
information and joins the front and back covers.
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Spot Color
A color not created by CMYK separations, usually specified by
a Pantone swatch number. A spot color is printed by mixing
given proportions of various inks in accordance with the
percentages given by the Pantone number.

Spread
Two facing pages that can be worked on as a unit, and will be
viewed side by side in the final publication.

Stacking Order
The order of the elements on a page, wherein the topmost
item will obscure the items beneath it.

Standard Viewing Conditions
A prescribed set of conditions under which the viewing of
originals and reproductions are to take place, defining both
the geometry of the illumination and the spectral power
distribution of the light source.

Standing Cap
A large capital letter sharing baseline with the adjoining text
but rising above it. See Drop Cap.

Standoff
The distance between a graphic and the text that wraps
around it. See Wrap.

Stat
Photostat copy.

Stet
Used in proof correction work to cancel a previous correction.
From the Latin; "let it stand."

Stipple
Black and white line art where shading is accomplished by the
placement of pinpoint dots.

Stochastic Screening
A method of creating halftones in which the size of the dots
remains constant but their density is varied; also known as
frequency-modulated (or FM) screening.

Stripping
The preparation and assembling of film prior to platemaking.

Stroke, Stroking
Manipulating the width or color of a line.

Stuffit
A file compression utility used in the Macintosh environment.

Style
A set of formatting instructions for font, paragraphing, tabs,
and other properties of text.

Style Sheet
A file containing all of the tags and instructions for formatting
all parts of a document; style sheets create consistency
between similar documents.

Subhead
A second-level heading used to organize body text by topic.

Subscript

Text Type

Small-size characters set below the normal letters or figures,
usually to convey technical information.

Typefaces used for the main text of written material. Generally
no larger than 14 point in size, and variable with the type of
publication.

Substitution
Using an existing font to simulate one that is not available to
the printer.

Substrate
The paper or any other generally flat material upon which an
image is printed.

Subtractive Color
Color which is observed when light strikes pigments or dyes,
which absorb certain wavelengths of light; the light that is
reflected back is perceived as a color. See CMYK and Process
Color.

Superscript
Small characters set above the normal letters or figures, such
as numbers referring to footnotes.

Swash Letters

Text wrap
See Wrap

Text
The characters and words that form the main body of a
publication.

Texture
1. A property of the surface of the substrate, such as the
smoothness of paper. 2. Graphically, variation in tonal values
to form image detail. 3. A class of fills in a graphics application
that give various appearances, such as bricks, grass, etc.

Thin Space
A fixed space, equal to half an en space or the width of a
period in most fonts.

Thumbnails

Letters with extra flourishes usually used in logos, headlines,
or as initial caps.

Swatch
A sample of a set of papers, inks, etc. that may be provided in
physical form, or appear as a menu in a word processing or
illustration application program.

Syntax
The rules that govern the structure of statements in a
computer language, or in a language in general.

1. The preliminary sketches of a design. 2. Small images used
to indicate the content of a computer file.

Tick Mark
A small mark at right angles to the axis of a graph that
indicates the location of a certain measurement; such as tick
marks indicating the numbers 1, 2, 3, etc.

TIFF
See Tagged Image File Format

Tight

System Folder

A characteristic of text in which the characters are set very
close together.

The location of the operating system files on a Macintosh.

Tabloid
A paper size 11 inches wide and 17 inches long.

Tabular
Text set in columns or tables.

Tagged Image File Format (TIFF)
A common format used for scanned or computer-generated
bitmapped images.

Tags
The various formats in a style sheet that indicate paragraph
settings, margins and columns, page layouts, hyphenation and
justification, widow and orphan control and other parameters.

Template
A document file containing layout and styles by which a series
of documents can maintain the same look and feel.

Text Attribute
A characteristic applied directly to a letter or letters in text,
such as bold, italic, or underline.

Text Block
A set of characters that may be manipulated as a group.

Text File
A file containing text in ASCII format that does not contain
style formatting.

Tile
1. A type of repeating fill pattern. 2. Reproduce a number of
pages of a document on one sheet. 3. Printing a large
document overlapping on several smaller sheets of paper.

Tint
1. A halftone area that contains dots of uniform size; that is,
no modeling or texture. 2. The mixture of a color with white.

Tip In
The separate insertion of a single page into a book either
during or after binding by pasting one edge.

Toggle
A command that switches between either of two states at each
application. Switching between Hide and Show is a toggle.

Tone
Any variation in lightness or saturation while hue remains
constant.

Toolbox
An on-screen mouse-operated palette that allows the user to
choose from a selection of tools available in computer
application programs.

Tracking
Adjusting the spacing of letters in a line of text to achieve
proper justification or general appearance.
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Transfer Curve
A curve depicting the adjustment to be made to a particular
printing plate when an image is printed.

Transparency
A full color photographically produced image on transparent
film.

Transparent Ink
An ink that allows light to be transmitted through it.

Trapping
Compensating for potential gaps between two adjoining
colors because of misregistration.

Trim
After printing, mechanically cutting the publication to the
correct final dimensions. The trim size is normally indicated
by marks on the printing plate outside the page area.

TrueType
An outline font format used in both Macintosh and Windows
systems that can be used both on the screen and on a printer.

Type 1 Fonts
PostScript fo nts based on Bezier curves encrypted for
compactness that are compatible with Adobe Type Manager.

Type Family
A set of typefaces created from the same basic design but in
different weights, such as bold, light, italic, book, and heavy.

Typesetting
The arrangement of individual characters of text into words,
sentences, and paragraphs.

~
An abbreviation for typographical error. A keystroke error in
the typeset copy.

Typographer
A specialist in the design of printed matter and generally an
expert in type and letterforms.

Typography
The design and planning of printed matter using type.

U&lc
An abbreviation for UPPER and lower case. Also the name of
a popular design publication.

UCR (undercolor removal)
A technique for reducing the amount of magenta, cyan, and
yellow inks in neutral or shadow areas and replacing them
with black.

Undertone
Color of ink printed in a thin film.

Unsharp Masking
A digital technique (based on a traditional photographic
technique) performed after scanning that locates the edge
between sections of differing lightness and alters the values of
the adjoining pixels to exaggerate the difference across the
edge, thereby increasing edge contrast.
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Uppercase
The capital letters of a typeface as opposed to the lowercase, or
smaU, letters. So called because when type was hand
composited, the capital letters resided in the upper part of the
type case.

Utility
S:>ftware that performs ancillary tasks such as counting words,
defragmenting a hard drive, or restoring a deleted file.

Varnish Plate
The plate on a printing press that applies varnish after the
other colors have been applied.

Varnishing
A finishing process whereby a transparent varnish is applied
over the printed sheet to produce a glossy or protective
coating, either on the entire sheet or on selected areas.

Vector Graphics
Graphics defined using coordinate points, and mathematicaUy
drawn lines and curves, which may be freely scaled and rotated
without image degradation. Two commonly used vector
drawing programs are Illustrator and FreeHand.
A class of graphics created usi ng mathematically described
geometric shapes that overcomes the limitations ofbitmapped
graph ics.

Vel ox
Strictly, a Kodak chloride printing paper, but used to describe
a high-quality black & white print of a halftone or line
drawing.

Vertical Justification
The ability to automaticaUy adjust the interline spacing
(leading) to make columns and pages end at the same point
on a page.

Vignette
An illustration in which the background gradually fades into
the paper; that is, without a definite edge o r border.

Visible Spectrum
The wavelengths of light between about 380 nm (violet) and
700 nm (red) that are visible to the human eye.

Watermark
An impression incorporated in paper during manufacturing
showing the name of the paper and/or the company logo. A
"watermark" can be applied digitally to printed output as a
very light screened image.

Web Press
An offset printing press that prints from a roll of paper rather
than single sheets.

Weight
I. The thickness of the strokes of a typeface. The weight of a
typeface is usually denoted in the name of the font; for
example, light, book, or ultra (thin, medium, and thick
strokes, respectively). 2. The thickness of a line or rule.

White Space
Areas on the page which contain no images or type. Proper
use of white space is critical to a well-balanced design.
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White Light
Light containing all wavelengths of the visible spectrum.

Widow
First line of a paragraph that appears alone at the bottom of a
column or page.

Window Shade
A type of text block used in certain applications, such as
PageMaker. Windowshades have handles at the top and
bottom which, when dragged with the mouse, will reveal or
conceal text.

1. To compress a file on a Windows-based system using a
popular compression utility. 2. A removable disk made by
Iomega (a Zip disk) or the device that reads and writes such
disks (a Zip drive).

Zooming
The process of electronically enlarging an image on a monitor
to facilitate detailed design or editing.

Wizard
A utility attached to an application or operating system that
aids you in setting up a piece of hardware, software, or
document.

Word Break
The division of a word at the end of a line in accordance with
hyphenation principles.

Word Processor
A desktop publishing application program designed for
creating and formatting text, but not for page layout.

Word Space
The space inserted between words in a desktop publishing
application. The optimal value is built into the typeface, and
may usually be modified within an application.

Word Wrap
In word processing, the automatic adjustment of the number
of words on a line of text to match the margin and hyphenation settings, resulting in shifting a word to the next line as
required.

Wrap
Type set on the page so that it wraps around the shape of
another element.

WYSIWYG (pronounced "wizzywig,)
An acronym for "What You See Is What You Get," meaning
that what you see on your computer screen bears a strong
resemblance to what the job will look like when it is printed.

X-height
The height of the letter "x" in a given typeface, which
represents the basic size of the bodies of all of the lowercase
letters (excluding ascenders and descenders).

Xerography
A photocopying/printing process in which the image is
formed using the electrostatic charge principle. The toner
replaces ink and can be dry or liquid. Once formed, the image
is sealed by heat. Most page printers currently use this method
of printing.

Zero Point
The mathematical "origin" of the coordinates of the twodimensional page. The zero point may be moved to any
location on the page, and the ruler dimensions change
accordingly.
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Reviewer Quotes

T~xt Highlights
- Accompanying CD indudes all graphic files needed for practice exercises
- Learning objectives provided at the beginning of each chapter
- Icons in sidebars help identify key portions of the materials

ADOB[ ILLUSTRATOR 7.0: An Introduction to Digital Illustration
ADOB[ ILLUSTRATOR 7.0: Advanced Digital Illustration
ADOB[ PHOTOSHOP 4.0: An Introduction to Digital Images
ADOB[ PHOTOSHOP 4.0: Advan(ed Digitallmages
fRHHAND 7.0: An Introduction to Digital Illustration
rRITHAND 7.0: Advanced Digital ntustration
ADOB[ PAG[MAK[R 6.5: Introduction to Hectroni< Mechanicals
ADOB[ PAGOOJ([R 6.5: Advanced Ue<troni< Mechanicals
MACINTOSH: Basic Operations
WINDOWS: Basic Operations
QUARKXPR[SS 4.0: An Introduction to Ilectroni< MedJanicals
QUARKXPR[SS 4.0: Advanced Hectroni< Mechanicals
PR[fLIGHT: An Introduction to file Analysis clll_d Repair
fll[ PR[llARATION: The Responsible ~lectroni< Paqe
TRAPWJS[: Trapping
PR[SSWIS[: Imposition . ·:

"The ACJainst The Oock materials fit in
beoutifully with our diqital prfPrm and
iJna9inCJ rurrirulum. With their materials,
wt'rf able to ofter our students hands-on
instruction for the most rumnt vmions of
popular softwarf applications. Step-bystep projects, excellmt structure, and
mensivf sidfbar mmmfnts provide our
students with thf tools they needto mntinue
explorinCJ the concepts on tht~ir own- even
aftfr thry'w attendfd our dasses."
(Ron Btrtolina, Prfprm Instruction

TtdmoiQ9ist. 6An)

"Ihm bem plmt'd with thf proC)mSion
of thf books. Lfadinq smoothly from one
subjm to anothtr within one book as wl'll
as the smooth transition bftwl'l'n murses."
(And!'frn Hull, Dmronic lmaqinq
Trainrr, HanltY Graphi( Products (o.)

"Thl' mntl'nt is VffY appropriatl' for novice
Ieamm. The projects arf also appropriatf
...my qood mnnection and l'XCl'llfnt
rfinformnmt"
(Dr. Hitdltll Hmb, Bmidji Stat•

Uniwnity)

"...if IWfrf to havf to sit down and writf a
book to tl'adt this stuff, tht'St' arf thl' books
that Iwould haw writtfn!"
(Lynnr fountain, Tripp T«hnoloqy
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